Oracle Utilities Analytics
Installation Guide
Release 2.7.0
E83219-01

March 2017
(Updated May 2019)
## Preface
- Audience .............................................................................................................................................................................. i-ii
- Pre-requisite Knowledge ......................................................................................................................................................... i-ii
- Related Documents ............................................................................................................................................................... i-ii
- Conventions ............................................................................................................................................................................ i-iii
- Abbreviations .......................................................................................................................................................................... i-iii
- Documentation Accessibility .................................................................................................................................................... i-iv
- Documentation Roadmap ......................................................................................................................................................... i-iv

## Chapter 1
### Introduction
- Installation Components .......................................................................................................................................................... 1-1
- Installation Types ................................................................................................................................................................. 1-2
  - Initial Installation .......................................................................................................................................................... 1-2
  - Upgrade .......................................................................................................................................................................... 1-3
  - Demo Installation ......................................................................................................................................................... 1-3
- Media Pack Components ...................................................................................................................................................... 1-4

## Chapter 2
### Supported Platforms and Hardware Requirements
- Operating Systems and Application Servers ...................................................................................................................... 2-1
- Additional Notes on Supported Platforms ........................................................................................................................... 2-2
- Support for Software Patches and Upgrades ..................................................................................................................... 2-3

## Chapter 3
### Planning the Installation
- Pre-requisite Software .......................................................................................................................................................... 3-1
  - Pre-requisite Software for Oracle Utilities Analytics Database .................................................................................. 3-2
  - Pre-requisite Software for Oracle Utilities Analytics Installer ................................................................................ 3-2
  - Pre-requisite Software for Oracle Data Integrator Based ELT Component ................................................................ 3-2
  - Pre-requisite Software for Oracle Utilities Analytics Administration ..................................................................... 3-3
  - Pre-requisite Software for Oracle Utilities Analytics Dashboards ............................................................................... 3-3
- Supported Source Application Versions .............................................................................................................................. 3-3
- Deployment .......................................................................................................................................................................... 3-4
- Installation Checklist .......................................................................................................................................................... 3-4

## Chapter 4
### Installing Oracle Utilities Analytics - Initial Installation
- Before You Install ................................................................................................................................................................. 4-1
- Installing Oracle Utilities Analytics Database ...................................................................................................................... 4-2
  - Installing Prerequisite Software .................................................................................................................................. 4-2
  - Copying and Decompressing Install Media .................................................................................................................. 4-2
  - Creating the Database .................................................................................................................................................... 4-2
  - Creating Users and Tablespaces ....................................................................................................................................... 4-3
  - Installing RELADM Schema ........................................................................................................................................... 4-3
  - Installing MDADM Schema .............................................................................................................................................. 4-5
  - Installing DWADM Schema .............................................................................................................................................. 4-6
Chapter 5
Installing Oracle Utilities Analytics v2.7.0.0.x Patchset Directly ................................................................. 5-1
Pre-requisite Software ................................................................. 5-2
Prerequisite Software for Oracle Utilities Analytics Database ................................................................. 5-2
Prerequisite Software for Oracle Utilities Analytics Installer ................................................................. 5-2
Prerequisite Software for Oracle Data Integrator Based ELT Component ......................................................... 5-2
Prerequisite Software for Oracle Utilities Analytics Administration ............................................................. 5-3
Prerequisite Software for Oracle Utilities Analytics Dashboards ................................................................. 5-3
Before You Install ...................................................................... 5-3
Installing Oracle Utilities Analytics Database ................................................................................................. 5-3
Installing Prerequisite Software ................................................................. 5-3
Copying and Decompressing Install Media ................................................................................................. 5-4
Creating the Database ................................................................................................................................. 5-4
Creating Users and Tablespaces ....................................................................................................................... 5-4
Installing RELADM Schema .......................................................................................................................... 5-5
Installing MDADM Schema ............................................................................................................................ 5-6
Installing DWADM Schema ............................................................................................................................ 5-7
Configuring Spatial Data ............................................................................................................................... 5-8
Installing Oracle Data Integrator Based ELT Component .................................................................................. 5-8
Installing Pre-requisite Software ...................................................................................................................... 5-9
Setting up Oracle GoldenGate ........................................................................................................................ 5-9
Copying and Decompressing Install Media ........................................................................................................ 5-17
Starting the Installer ................................................................................................................................. 5-17
Installation Steps ............................................................................................................................................... 5-18
Creating a Database Directory .......................................................................................................................... 5-22
Configuring Oracle Data Integrator Repository Creation Utility (RCU) ............................................................ 5-22
Creating WebLogic Domain for Oracle Data Integrator Agent ........................................................................ 5-23
Starting the WebLogic Admin Server ............................................................................................................... 5-25
Starting the Managed Server (ODI_server1) ...................................................................................................... 5-25
Installing Oracle Utilities Analytics Administration Component ........................................................................ 5-26
Installing Oracle Utilities Analytics Dashboards Component ............................................................................ 4-37
Creating and Configuring an OBIEE Domain ..................................................................................................... 4-37
Copying and Decompressing Install Media ...................................................................................................... 4-38
Starting the Installer ....................................................................................................................................... 4-38
Installation Steps ............................................................................................................................................... 4-39
Deploying Web Catalog ................................................................................................................................... 4-41
Deploying the Repository (RPD) File .................................................................................................................... 4-42
Configuring and Deploying the MapViewer .................................................................................................... 4-45
Updating MapViewer Configuration ................................................................................................................. 4-47
Enabling WriteBack ....................................................................................................................................... 4-47
Enabling Auto Complete Feature in OBIEE ........................................................................................................ 4-47

Contents - ii
Oracle Utilities Analytics Installation Guide
Chapter 6
Upgrading Oracle Utilities Analytics from v2.6.0.0.2 ................................................................. 6-1
  Pre-requisites ......................................................................................................................... 6-2
Upgrading Oracle Utilities Analytics Database Component ............................................... 6-8
  Copying and Decompressing the Install Media ................................................................. 6-9
  Creating Users and Tablespaces ....................................................................................... 6-9
Upgrading Oracle Utilities Analytics Administration Tool Component .............................. 6-10
  Installing RELADM Schema .............................................................................................. 6-10
  Installing MDADM Schema .............................................................................................. 6-11
  Installing DWADM Schema .............................................................................................. 6-12
Upgrading Oracle Data Integrator Based ELT Component .................................................. 6-14
  Prerequisites for Running Oracle Utilities Analytics Installer .................................... 6-14
  Configuring Oracle Data Integrator Repository Creation Utility (RCU) ......................... 6-15
  Upgrade ODI Repository ................................................................................................... 6-15
  Setting up Oracle GoldenGate ......................................................................................... 6-16
  Copying and Decompressing Install Media ....................................................................... 6-23
  Creating WebLogic Domain for Oracle Data Integrator Agent ....................................... 6-28
Upgrading Oracle Utilities Analytics Based ELT Component ............................................ 6-44
  Starting the Managed Server (ODI_server1) ................................................................. 6-28
  Starting the WebLogic Admin Server .............................................................................. 6-30
  Configuring Source Applications ...................................................................................... 6-31
Upgrading Oracle Data Integrator Based ELT Component .................................................. 6-33
  Upgrading Oracle Utilities Analytics Database Component ........................................... 6-37
  Prerequisites ......................................................................................................................... 6-44
  Copying and Decompressing Install Media ....................................................................... 6-47
  Starting the Installer .......................................................................................................... 6-47
  Upgrade Steps ....................................................................................................................... 6-47
  Deploying Web Catalog ..................................................................................................... 6-49
  Deploying Repository (RPD) File ..................................................................................... 6-50
  Configuring and Deploying the MapViewer ...................................................................... 6-53
  Enabling WriteBack .......................................................................................................... 6-56
  Enabling Auto Complete Feature in OBIEE ........................................................................ 6-56

Chapter 7
Upgrading Oracle Utilities Analytics from v2.5.0.0.5 ................................................................. 7-1
Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics ........................... 7-37
  Upgrading Oracle Utilities Analytics Database Component ........................................... 7-5
  Upgrading Oracle Utilities Analytics Based ELT Component ......................................... 7-11
  Upgrading Source Applications to be Compatible with v2.7.0 .......................................... 7-29
Upgrading Oracle Utilities Analytics Administration Tool Component ........................... 7-62
  Upgrading Oracle Utilities Analytics Based ELT Component ......................................... 7-44
Upgrading Oracle Utilities Analytics Dashboards Component ......................................... 7-62
Chapter 8
Installing Demo Database ................................................................................................................................................. 8-1
   Installing Oracle Utilities Analytics Demo Database Component ..................................................................................... 8-1
   Copying and Decompressing Install Media .................................................................................................................. 8-1
   Creating Database and Importing the Dump File ....................................................................................................... 8-2
   Configuring Security ......................................................................................................................................................... 8-5
   Configuring Spatial Data ............................................................................................................................................... 8-6
Installing Oracle Utilities Analytics Dashboards Component ............................................................................................ 8-6
   Creating and Configuring an OBIEE Domain .................................................................................................................. 8-7
   Copying and Decompressing Install Media .................................................................................................................. 8-8
   Starting the Installer ...................................................................................................................................................... 8-8
   Installation Steps ........................................................................................................................................................... 8-8
   Deploying Web Catalog .................................................................................................................................................. 8-10
   Deploying the Repository (RPD) File .......................................................................................................................... 8-11
   Configuring and Deploying the MapViewer .................................................................................................................. 8-14
   Updating MapViewer Configuration .................................................................................................................................. 8-16
   Enabling WriteBack ...................................................................................................................................................... 8-16
   Enabling Auto Complete Feature in OBIEE .................................................................................................................. 8-17

Chapter 9
Configuring Spatial Data ................................................................................................................................................... 9-1
   Acquiring the Spatial Data ............................................................................................................................................ 9-1
   Installing Spatial Data .................................................................................................................................................... 9-1
   Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables ............................................................................ 9-2
      Importing Theme Related Spatial Data into Oracle Utilities Analytics .............................................................................. 9-3
      Improving Performance by Prefetching the Map Tiles .................................................................................................... 9-6
   Loading the Oracle Utilities Specific Themes ............................................................................................................. 9-7
   Additional Setup for Oracle Utilities Outage Analytics ................................................................................................... 9-7

Chapter 10
Installing NMS BI Publisher Reports ..................................................................................................................................... 10-1
Welcome to Oracle Utilities Analytics Installation Guide.

This guide provides information for those installing and configuring Oracle Utilities Analytics on Windows, Linux, and Solaris systems.

The preface includes the following:

- Audience
- Pre-requisite Knowledge
- Related Documents
- Conventions
- Abbreviations
- Documentation Accessibility
- Documentation Roadmap
Audience

This guide is intended for use by anyone who is responsible for installing or upgrading Oracle Utilities Analytics.

Pre-requisite Knowledge

Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards make use of several technologies. It is assumed that you have a working knowledge of the following to configure and administer Oracle Utilities Analytics:

- Oracle Data Warehouse
  https://docs.oracle.com/database/121/DWHSG/toc.htm
- Oracle Data Integrator
  https://docs.oracle.com/middleware/1221/cross/getstartedtasks.htm
- Oracle GoldenGate
  http://docs.oracle.com/goldengate/c1221/gg-winux/index.html
- Oracle GoldenGate Monitor
  https://docs.oracle.com/goldengate/m12212/gg-monitor/index.html
- Oracle WebLogic Server
  http://docs.oracle.com/middleware/1221/wls/index.html
- Oracle Business Intelligence Enterprise Edition
  http://docs.oracle.com/middleware/12211/bisuite/docs.htm

Related Documents

The following documentation is included with this release.

Installation, Administration, and Release Notes

- Oracle Utilities Analytics Release Notes
- Oracle Utilities Analytics Getting Started Guide
- Oracle Utilities Analytics License Information User Manual
- Oracle Utilities Analytics Installation Guide
- Oracle Utilities Analytics Quick Install Guide
- Oracle Utilities Analytics Administration Guide
- Oracle Utilities Analytics Developer's Guide

Metric Reference Guides

- Oracle Utilities Analytics Dashboards for Oracle Utilities Meter Data Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Customer Analytics, Revenue Analytics and Credit & Collections Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Exception Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Mobile Workforce Analytics Metric Reference Guide
Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>

Abbreviations

The following table lists the commonly used acronyms and terms in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>APEX</td>
<td>Oracle Application Express</td>
</tr>
<tr>
<td>CDC</td>
<td>Changed Data Capture</td>
</tr>
<tr>
<td>ELT</td>
<td>Extraction, Loading and Transformation</td>
</tr>
<tr>
<td>ETL</td>
<td>Extraction, Transformation, and Loading</td>
</tr>
<tr>
<td>OBIEE</td>
<td>Oracle Business Intelligence Enterprise Edition</td>
</tr>
<tr>
<td>BI</td>
<td>Business Intelligence</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about configuring and using accessibility features for Oracle Utilities Analytics, see the documentation at http://docs.oracle.com/cd/E23943_01/bi.1111/e10544/appaccess.htm#BIEUG2756.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/us/corporate/accessibility/index.html.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For more information, visit: http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Documentation Roadmap

This guide is organized based on the typical flow you need to follow to install and configure Oracle Utilities Analytics. Use the following documentation roadmap to find the information that you need to install Oracle Utilities Analytics.

1. Introduction

   This chapter includes a general description about Oracle Utilities Analytics and provides information about the installation types and components required to install or upgrade Oracle Utilities Analytics.

2. Supported Platforms and Hardware Requirements

   This chapter shows each of the operating system/server combinations that Oracle Utilities Analytics is certified for.

3. Planning the Installation

   This chapter describes the setup steps or pre-installation tasks that you must complete before you begin an Oracle Utilities Analytics installation or upgrade.

4. Installing Oracle Utilities Analytics - Initial Installation

   This chapter provides the steps for a new Oracle Utilities Analytics installation. It includes procedures to install various components for Oracle Utilities Analytics to be functional.
5. Installing Oracle Utilities Analytics v2.7.0.0.x Patchset Directly
   This chapter includes instructions that are applicable only while directly installing Oracle Utilities Analytics v2.7.0.0 Patchset 11 or higher.

6. Upgrading Oracle Utilities Analytics from v2.6.0.0.2
   This chapter includes the steps to upgrade Oracle Utilities Analytics from v2.6.0.0.2 to v2.7.0.

7. Upgrading Oracle Utilities Analytics from v2.5.0.0.5
   This chapter provides the instructions to upgrade Oracle Utilities Analytics from v2.5.0.0.5 to v2.7.0.

8. Installing Demo Database
   This chapter provides instructions for installing the demonstration database.

9. Configuring Spatial Data
   This chapter provides information about spatial data setup for the Oracle Business Intelligence Enterprise Edition dashboards in Oracle Utilities Analytics and how to set up the spatial data. It explains the steps to acquire, install import, and load the spatial data.

10. Installing NMS BI Publisher Reports
    This chapter describes the steps to install the NMS IEEE outage reports in Oracle Utilities Analytics.
This chapter provides an overview of the Oracle Utilities Analytics v2.7.0.0 installation. It is a complete installation and does not need to install any of the previous versions.

**Note:** For information about configuring and administering Oracle Utilities Analytics (Oracle Utilities Analytics Dashboards and Oracle Utilities Extractors and Schema), refer to the *Oracle Utilities Analytics Administration Guide*.

A typical Oracle Utilities Analytics installation involves installing various components across different installation types. This chapter focuses on these details:

- Installation Components
- Installation Types
- Media Pack Components
Installation Components

The Oracle Utilities Analytics installation includes installing the following components. For a successful installation, it is required to install ALL of these components:

- Oracle Utilities Analytics Database - Contains star schemas and product metadata.
- Oracle Utilities Analytics ELT - Based on Oracle Data Integrator (ODI), it includes pre-built ODI objects necessary for ELT processes.
  
  **Note:** Oracle GoldenGate (OGG) is used to capture the data and is required for ODI-based ELT.
- Oracle Utilities Analytics Administration - An Oracle Application Express (APEX) application used to maintain several Oracle Utilities Analytics configuration parameters.
- Oracle Utilities Analytics Dashboard - Includes the pre-built OBIEE Web Catalog, RPD file, and answers, based on OBIEE.
  
  **Note:** Install this component on the server where OBIEE is installed. It also includes a demo database with pre-populated data used for training or demonstration purposes. Refer to the Installing Demo Database chapter for more information.

Refer to **Prerequisite Software** in the **Planning the Installation** chapter for information about the prerequisite software required to install each of the components.

Installation Types

The first step in the installation procedure is to determine the installation type that meets your business requirements. The possible installation types are as follows:

- **Initial Installation** - A base installation, typically used for a production environment.
- **Upgrade** - An upgrade installation from version 2.5.0.0.5 or 2.6.0.0.2 to version 2.7.0.
- **Demo Installation** - A base installation with pre-populated demo data, typically used for demonstration or training purposes.

The following sections describe these installation types in detail.

Initial Installation

This type is applicable for a new Oracle Utilities Analytics installation. For an initial installation, you must install all of the following components:

- Oracle Utilities Analytics Database
- Oracle Utilities Analytics ELT
- Oracle Utilities Analytics Administration
- Oracle Utilities Analytics Dashboard

Following is a high-level workflow of the installation process:

- **Step 1:** Install the database components in the order below:
  
  - Oracle Database 12.1.0.2.0
  - WebLogic 12.2.1.0.0
  - Oracle Data Integrator 12.2.1.0.0 with JavaEE
  - Oracle Utilities Analytics Database
  - Oracle Utilities Analytics Administration
Installation Types

Introduction

1-3

Oracle Utilities Analytics Installation Guide

• Oracle Utilities Analytics ODI-Based ELT
• Oracle Utilities Analytics ODI-Based ELT

Step 2: Install the dashboard components as below:
• Oracle Client 12.1.0.2.0
• OBIEE 12.2.1.0.0
• Oracle Utilities Analytics Dashboard

Refer to the Planning the Installation chapter for information about the prerequisite software required to install each of the components. Refer to the Installing Oracle Utilities Analytics - Initial Installation chapter for the respective component installation steps.

Upgrade

This installation type is applicable while upgrading Oracle Utilities Analytics from the following versions:
• 2.5.0.0.5 to 2.7.0
• 2.6.0.0.2 to 2.7.0

For an upgrade, you must upgrade all of the following components:
• Oracle Utilities Analytics Database
• Oracle Utilities Analytics ELT
• Oracle Utilities Analytics Administration
• Oracle Utilities Analytics Dashboard

Following is a high-level workflow of the upgrade process:
• Step 1: Upgrade the database components in the order below:
  • Oracle Database 12.1.0.2.0
  • Oracle Utilities Analytics Database
  • Oracle Utilities Analytics Administration
  • Oracle Utilities Analytics ODI-Based ELT
• Step 2: Install/upgrade the dashboard components as below:
  • Oracle Client 12.1.0.2.0
  • OBIEE 12.2.1.0.0
  • Oracle Utilities Analytics Dashboard

Refer to the Planning the Installation chapter for information about the prerequisite software required to install each of the components.

If you are upgrading the product from version 2.6.0.0.2, refer to chapter Upgrading Oracle Utilities Analytics from v2.6.0.0.2 for the steps involved in upgrading each of the required components.

If you are upgrading the product from version 2.5.0.0.5, refer to chapter Upgrading Oracle Utilities Analytics from v2.5.0.0.5 for the steps involved in upgrading each of the required components.

Demo Installation

This installation type is applicable when installing a database component for Oracle Utilities Analytics Dashboards for demonstration or training purposes. For a demo installation, install the following components:
Media Pack Components

The Oracle Utilities Analytics Media Pack consists of the following packages:

**Documentation Package**

- Oracle Utilities Analytics Release Notes
- Oracle Utilities Analytics Quick Install Guide
- Oracle Utilities Analytics Installation Guide
- Oracle Utilities Analytics Administration Guide
- Oracle Utilities Analytics Developer's Guide
- Oracle Utilities Analytics License Information User Manual
- Oracle Utilities Analytics Dashboards for Customer Analytics, Revenue Analytics, and Credit & Collections Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Exception Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Mobile Workforce Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Distribution Analytics and Outage Analytics
- Oracle Utilities Analytics Dashboards for Work and Asset Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Operational Device Analytics Metric Reference Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping Guide

Introduction 1-4
Oracle Utilities Analytics Installation Guide
Media Pack Components

• Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping Guide

Installation Package

• Oracle Utilities Analytics v2.7.0 Dashboard Component Multiplatform

• Oracle Utilities Analytics v2.7.0 ELT Component Based on ODI Multiplatform

• Oracle Utilities Analytics v2.7.0 Oracle Database Multiplatform

• Oracle Utilities Analytics v2.7.0 Demo Data
This chapter provides an overview of the operating system/server combinations that Oracle Utilities Analytics is certified for. It includes:

- Operating Systems and Application Servers
- Additional Notes on Supported Platforms
- Support for Software Patches and Upgrades
Operating Systems and Application Servers

An Oracle Utilities Analytics installation is tested and supported on a wide variety of operating system, application server, and database server combinations. The following table provides the details of the minimum versions supported.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Operating System (Client)</th>
<th>Operating System (Server)</th>
<th>Chipset</th>
<th>Application Server</th>
<th>Oracle Business Intelligence Enterprise Edition (OBIEE)</th>
<th>Oracle Data Integrator (ODI)</th>
<th>JDK</th>
<th>Oracle Golden Gate</th>
<th>Oracle REST Data Service</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>IE 11.x</td>
<td>Oracle Linux 6.5 (64-bit)</td>
<td>x86_64</td>
<td>WebLogic 12.2.1</td>
<td>12.2.1.0.0</td>
<td>12.2.1.0.0</td>
<td>1.8.0(77)+</td>
<td>12.2.0.1</td>
<td>3.0.6</td>
<td>Oracle 12.1.0.2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.x (64-bit)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AIX 7.2 (64-bit)</td>
<td>POWER (64-bit)</td>
<td>WebLogic 12.2.1</td>
<td>12.2.1.0.0</td>
<td>12.2.1.0.0</td>
<td>1.8.0(77)+</td>
<td>12.2.0.1</td>
<td>3.0.6</td>
<td>Oracle 12.1.0.2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Oracle Solaris 11 (64-bit)</td>
<td>SPARC</td>
<td>WebLogic 12.2.1</td>
<td>12.2.1.0.0</td>
<td>12.2.1.0.0</td>
<td>1.8.0(77)+</td>
<td>12.2.0.1</td>
<td>3.0.6</td>
<td>Oracle 12.1.0.2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012 R2 (64-bit)</td>
<td>x86_64</td>
<td>WebLogic 12.2.1</td>
<td>12.2.1.0.0</td>
<td>12.2.1.0.0</td>
<td>1.8.0(77)+</td>
<td>12.2.0.1</td>
<td>3.0.6</td>
<td>Oracle 12.1.0.2.0</td>
<td></td>
</tr>
</tbody>
</table>

**Important:** For the latest system requirements and supported platforms details, refer to the knowledge article “System Requirements and Supported Platforms for Oracle Utilities Analytics” available on My Oracle Support (https://support.oracle.com/).

Apply **patch 23629220** after installing ODI 12.2.1.0.0. This patch installation is a prerequisite to ODI based ELT component installation.

Note that it is possible to install multiple Fusion Middleware products (ODI, OBIEE, etc.) in the same Home. In this scenario, Fusion Middleware Infrastructure is installed only once, and the Home is reused while installing other Fusion Middleware products.

**Additional Notes on Supported Platforms**

**Oracle Unbreakable Enterprise Kernel** - This version of Oracle Utilities Analytics is supported on Oracle Unbreakable Enterprise Kernel.

**Oracle VM Support** - This version of Oracle Utilities Analytics is supported on Oracle VM Server for x86 3.3 for the supported releases of Oracle Linux and Microsoft Windows operating systems.

**Oracle Support Policy on VMWare** - Refer to My Oracle Support knowledge base article 249212.1 for Oracle’s support policy on VMWare (https://support.oracle.com).
Support for Software Patches and Upgrades

Due to the ongoing nature of software improvement, vendors periodically issue patches and service packs for the operating systems, application servers, and database servers on top of specific versions that Oracle products have already been tested against.

If it is necessary to apply an upgrade, it is recommended to do so in a test environment that is running on the same platform as your production environment prior to updating the production environment itself.

Always contact Oracle Support prior to applying vendor updates that do not guarantee backward compatibility.
This chapter provides information to plan an Oracle Utilities Analytics installation, including:

- Pre-requisite Software
- Supported Source Application Versions
- Deployment
- Installation Checklist
Pre-requisite Software

Before you install Oracle Utilities Analytics, you are required to install the prerequisite software. Refer to the respective installation documentation of the software for download and installation instructions.

Note: Ensure that the same operating system user is used to install all software prerequisites and Oracle Utilities Analytics components.

The list of prerequisite software required to install Oracle Utilities Analytics is as below:

- Pre-requisite Software for Oracle Utilities Analytics Database
- Pre-requisite Software for Oracle Utilities Analytics Installer
- Pre-requisite Software for Oracle Data Integrator Based ELT Component
- Pre-requisite Software for Oracle Utilities Analytics Administration
- Pre-requisite Software for Oracle Utilities Analytics Dashboards

Pre-requisite Software for Oracle Utilities Analytics Database

The prerequisite software for the Oracle Utilities Analytics database component is as follows:

Oracle Database Server Enterprise Edition 12.1.0.2.0 - This Oracle Utilities Analytics release is supported on Oracle Database Server Standard Edition 12.1.0.1.0 when using ODI-based ELT component.

Pre-requisite Software for Oracle Utilities Analytics Installer

The prerequisite software for Oracle Utilities Analytics Installer is JDK 1.8.0(77)+.

Pre-requisite Software for Oracle Data Integrator Based ELT Component

The prerequisite software for ODI-based ELT component of Oracle Utilities Analytics is as follows:

- JDK 1.8.0 (77)+
- Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard Edition 12.1.0.1.0
- Oracle Fusion Middleware Infrastructure and Oracle Data Integrator 12.2.1.0.0.

Note: These components can be downloaded separately.

- Apply patch 23629220 after installing ODI 12.2.1.0.0.
- Oracle GoldenGate 12.2.0.1

Install Oracle GoldenGate on both source application as well target database servers. Download the latest version from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

Oracle GoldenGate Monitor 12.2.1.0.0 on both source application as well as target database servers. Download the latest version from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

- Oracle Utilities Analytics Administration
Pre-requisite Software for Oracle Utilities Analytics Administration

The prerequisite software for Oracle Utilities Analytics Administration component is as follows:

- Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard Edition 12.1.0.1.0
- Oracle Apex 5.0.4
- Oracle WebLogic 12.2.1.0.0

Pre-requisite Software for Oracle Utilities Analytics Dashboards

The prerequisite software for Oracle Utilities Analytics dashboard component is as follows:

- Oracle Fusion Middleware Infrastructure and Oracle Business Intelligence Enterprise Edition 12.2.1.0.0.

  Note: Download Oracle Fusion Middleware Infrastructure and Oracle Business Intelligence Enterprise Edition 12.2.1.0.0 separately.

  Install the Oracle 12.1.0.2.0 client if OBIEE is not installed on the database server. If it is installed, then there is no need to install Oracle client. For installation instructions see the Installing Oracle Utilities Analytics Dashboards Component section in chapter 4.

After installing OBIEE, save a snapshot of the last page of OBIEE installation that shows the details of BI Oracle Home, Instance Home, etc. These values are used during the Oracle Utilities Analytics installation.

Supported Source Application Versions

The following source application versions are supported in this Oracle Utilities Analytics release:

<table>
<thead>
<tr>
<th>Source Application</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Utilities Customer Care and Billing</td>
<td>2.4.0.1+</td>
</tr>
<tr>
<td></td>
<td>2.5.0.+</td>
</tr>
<tr>
<td></td>
<td>2.6.0.0</td>
</tr>
<tr>
<td></td>
<td>2.7.0.0</td>
</tr>
<tr>
<td>Oracle Utilities Customer To Meter</td>
<td>2.7.0.0</td>
</tr>
<tr>
<td>Oracle Utilities Network Management System</td>
<td>2.3.0.0</td>
</tr>
<tr>
<td>Oracle Utilities Work and Asset Management</td>
<td>2.1.1.0+</td>
</tr>
<tr>
<td></td>
<td>2.2.0.0</td>
</tr>
<tr>
<td></td>
<td>2.2.0.2</td>
</tr>
<tr>
<td>Oracle Utilities Meter Data Management</td>
<td>2.1.0.3+</td>
</tr>
<tr>
<td></td>
<td>2.2.0.0+</td>
</tr>
<tr>
<td></td>
<td>2.2.0.1</td>
</tr>
<tr>
<td></td>
<td>2.2.0.2</td>
</tr>
<tr>
<td></td>
<td>2.2.0.3</td>
</tr>
<tr>
<td>Oracle Utilities Mobile Workforce Management</td>
<td>2.2.0.3+</td>
</tr>
<tr>
<td></td>
<td>2.3.0+</td>
</tr>
<tr>
<td>Oracle Real-Time Scheduler</td>
<td>2.2.0.3+</td>
</tr>
<tr>
<td></td>
<td>2.3.0+</td>
</tr>
</tbody>
</table>
Deployment

A standard Oracle Utilities Analytics deployment consists of a database and an application server. ODI, OBIEE, and WebLogic installation for Oracle Utilities Analytics Administration are performed on the application server. Oracle GoldenGate is installed on both source, as well as target database servers.

The following figure shows a standard Oracle Utilities Analytics deployment.

### Installation Checklist

The following checklist guides you through the Oracle Utilities Analytics installation process. The details for each step are provided in respective subsequent chapters.
1. Confirm that the recommended hardware is ready. Refer to Supported Platforms and Hardware Requirements for details.

2. Install prerequisite software. Refer to the Pre-requisite Software for more details.

3. Determine the installation type. Refer to Installation Types to determine the installation type for your scenario.

4. Ensure that you have downloaded the Oracle Utilities Analytics v2.7.0 components.

5. Perform the installation steps as applicable to the installation type.
   - Initial Installation - For initial installation, follow the instructions mentioned in the Installing Oracle Utilities Analytics - Initial Installation chapter.
   - Upgrade - To upgrade to v2.7.0, follow the instructions in Upgrading Oracle Utilities Analytics from v2.6.0.0.2 and Upgrading Oracle Utilities Analytics from v2.5.0.0.5 chapters for the respective version you are upgrading from.
   - Demo Installation - For instructions to proceed with demo installation, refer to the Installing Demo Database chapter.

This chapter provides instructions for a new Oracle Utilities Analytics installation. It includes:

- Before You Install
- Installing Oracle Utilities Analytics Database
- Installing Oracle Data Integrator Based ELT Component
- Installing Oracle Utilities Analytics Administration Component
- Installing Oracle Utilities Analytics Dashboards Component
Before You Install

Refer to My Oracle Support for up-to-date additional information about this Oracle Utilities Analytics release.

Installing Oracle Utilities Analytics Database

This section describes the steps to install Oracle Utilities Analytics Database on the database server, including:

- Installing Prerequisite Software
- Copying and Decompressing Install Media
- Creating the Database
- Creating Users and Tablespaces
- Installing RELADM Schema
- Installing MDADM Schema
- Installing DWADM Schema
- Configuring Spatial Data

Installing Prerequisite Software

The prerequisite software has to be installed before you begin the component installation. Refer to Pre-requisite Software for Oracle Utilities Analytics Database for details.

Copying and Decompressing Install Media

To copy and decompress install media, follow these steps:

1. Download Oracle Utilities Analytics v2.7.0 Oracle Database from the Oracle Utilities Analytics v2.7.0 Oracle Database Multiplatform.zip file.
   Download the zip from Oracle Software Delivery Cloud (https://edelivery.oracle.com).
2. Create a temporary directory.
   - For example: c:\OUA\temp for a Windows machine or /OUA/temp for a Linux machine.
   - This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. After successful installation, all files in this directory that are part of the installation can be deleted.
3. Unzip Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.
4. Unzip <TEMPDIR>/OUA-V2.7.0-Database-Multiplatform.zip using any zip utility.

The installation media is decompressed successfully. Proceed with creating the database.

Creating the Database

In an initial installation, it is recommended to use the Database Configuration Assistant (DBCA) utility to create the database.

Note: Refer to Oracle database documentation to know more about Database Configuration Assistant (DBCA).
Create the database with the following:
- Same character set as the source database character set
- Open cursor limit to 3000
- Processes to 1000

Creating Users and Tablespaces

To create the required users and tablespaces:
1. Create users in the database with the below names (without giving specific roles):
   - DWADM - Contains star schema objects (such as facts and dimensions) containing the data of the data warehouse.
   - DWUSER - User with read/write access to objects in DWADM schema.
   - DWREAD - User with read only access to objects in DWADM schema.
   - MDADM - A metadata schema consisting of database objects used for storing the Oracle Utilities Analytics metadata.
   - RELADM - A metadata schema consisting of database objects used to store the product version and component installation information.
   - OUA_MASTER - ODI Master repository schema
   - OUA_WORK - ODI Work repository schema
   - DWSTAGE - The staging schema of data warehouse.
2. Create roles with the following names:
   - DW_USER - Assigned to DWUSER. It contains all grants for read/write access to objects in the DWADM schema.
   - DW_READ - Assigned to DWREAD. It contains all grants for read only access to objects in the DWADM schema.
   - DW_PRIVS_ROLE - Assigned to MDADM. It contains the privileges necessary for the proper functioning of Oracle Utilities Analytics.
   - DW_REPLICATE - Assigned to various replication users that get created automatically during the source configuration. The privileges necessary for this role are automatically assigned by Oracle Utilities Analytics.
3. Connect to the database as sys user.

   Execute Usersgrants.sql in <TEMPDIR>/BI270/Scripts/Usersgrants.sql. This SQL provides required grants to the users created in step 1.

The required users and tablespaces are created.

Installing RELADM Schema

The RELADM schema is a metadata schema consisting of database objects used to store the product version and component installation information.

This section describes initial installation of the RELADM schema, including:
- Reviewing Storage.xml File
- Installation Procedure
- Generating Database Statistics
Reviewing Storage.xml File

The storage.xml file (included in the package and is in `<TEMPDIR>/BI270/RELADM/Install-Upgrade`) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

Note: If the database does not have CISTS_01 tablespace or RELADM user does not have quota on CISTS_01 tablespace, edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

Installation Procedure

To install the RELADM schema:

Note: This procedure prompts you for the password of RELADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows:

1. Add Java 8 to the path variable. For example:
   ```
   set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH= <TEMPDIR>/BI270/RELADM/Jarfiles/*
   ```
3. Navigate to `<TEMPDIR>/BI270/RELADM/Install-Upgrade` folder.
4. Execute OraDBI.jar.
   ```
   ```

In Unix:

1. Add Java 8 to the path variable. For example:
   ```
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH= <TEMPDIR>/BI270/RELADM/Jarfiles/*
   ```
3. Navigate to `<TEMPDIR>/BI270/RELADM/Install-Upgrade` folder.
4. Execute OraDBI.jar.
   ```
   ```

The utility creates the RELADM schema and system data definitions. If an error occurs while executing a SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.
Installing Oracle Utilities Analytics Database

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect to the database as **sys user** and execute the following command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
```

Installing MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing the Oracle Utilities Analytics metadata.

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including:
- **Reviewing Storage.xml**
- **Installation Procedure**
- **Generating Database Statistics**

**Reviewing Storage.xml**
The storage.xml file (included in the package located at `<TEMPDIR>/BI270/MDADM/Install-Upgrade`) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note**: If the database does not have CISTS_01 tablespace or MDADM user does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the correct tablespace name on which MDADM has quota.

**Installation Procedure**
To install the MDADM schema, follow these steps for Unix and Windows respectively:

**Note**: This procedure prompts you for the password of MDADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows:
1. Add Java 8 to the path variable. For example:
   ```
   set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI270\MDADM\Jarfiles\*
   ```
3. Navigate to the `<TEMPDIR>\BI270\MDADM\Install-Upgrade` folder.
4. Execute OraDBI.jar.
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/ <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,,MDADM -j <JDK Home> -f <TEMPDIR>\BI270\MDADM\Jarfiles -v 1 -e true
   ```
In Unix:
1. Add Java 8 to the path variable. For example:
   
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   
   export CLASSPATH=<TEMPDIR>/BI270/MDADM/Jarfiles/*

3. Navigate to the <TEMPDIR>/BI270/MDADM/Install-Upgrade folder.
4. Execute OraDBI.jar.

   java com.oracle.ouaf.oem.install.OraDBI \
   -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE NAME>,\ 
   MDADM,<Password of MDADM user>,,,,,MDADM \ 
   -j <JDK Home> -f <TEMPDIR>/BI270/MDADM/Jarfiles -v 1 -e true

The utility creates the MDADM schema and system data definitions. If an error occurs while executing a SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the database as sys user and execute the following command:

   execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Installing DWADM Schema
The DWADM schema contains star schema objects (such as facts and dimensions) that contain the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:
- Reviewing Storage.xml
- Installation Procedure
- Generating Database Statistics

Reviewing Storage.xml
The storage.xml file (included in the package located at <TEMPDIR>/BI270/DWADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

   Note: If the database does not have CISTS_01 tablespace or DWADM user does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the correct tablespace name on which DWADM has quota.

Installation Procedure
To install the DWADM schema, follow these steps in Unix and Windows respectively:

   Note: This procedure prompts you for the password of DWADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 8.0.
Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows:
1. Add Java 8 to the path variable. For example:
   ```
   set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI270\DWADM\Jarfiles\*
   ```
3. Navigate to the `<TEMPDIR>\BI270\DWADM\Install-Upgrade` folder.
4. Execute OraDBI.jar.
   ```
   <ORACLE SERVICE NAME>, DWADM, <Password of DWADM user>, DWUSER, DWREAD, DW_USER, DW_READ, DWADM -j
   <JDK Home> -f <TEMPDIR>\BI270\DWADM\Jarfiles -v 1 -e true
   ```

In Unix:
1. Add Java 8 to the path variable. For example:
   ```
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI270/DWADM/Jarfiles/*
   ```
3. Navigate to the `<TEMPDIR>/BI270/DWADM/Install-Upgrade` folder.
4. Run OraDBI.jar.
   ```
   java com.oracle.ouaf.oem.install.OraDBI \
   -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME> ,
   DWADM, <Password of DWADM user>, DWUSER, DWREAD, DW_USER, DW_READ, DWADM \
   -j <JDK Home> -f <TEMPDIR>/BI270/DWADM/Jarfiles -v 1 -e true
   ```

The utility creates the DWADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the data as **sys user** and execute the following command:
```
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

**Configuring Spatial Data**
Refer to Chapter 9: Configuring Spatial Data for details about spatial configuration.
Installing Oracle Data Integrator Based ELT Component

This section describes the installation procedure of Oracle Data Integrator based ELT component. It includes:

• Installing Prerequisite Software
• Setting up Oracle GoldenGate
• Copying and Decompressing Install Media
• Starting the Installer
• Installation Steps
• Creating a Database Directory
• Creating WebLogic Domain for Oracle Data Integrator Agent
• Starting the WebLogic Admin Server
• Starting the Managed Server (ODI_server1)

Installing Prerequisite Software

The Oracle Data Integrator based ELT component is installed on the Oracle Utilities Analytics application server. Refer to Deployment for information about deploying Oracle Utilities Analytics.

To proceed with installing the ELT component, ensure the following are taken care:

• The operating system user that is used to install all the related software is used to install the ELT component also.
• Set up the source applications with required configurations before proceeding with the ELT component installation. This enables to successfully extract data from them into Oracle Utilities Analytics.
• Verify that the prerequisite software mentioned in Pre-requisite Software for Oracle Data Integrator Based ELT Component are installed.
• While installing Oracle Data Integrator 12.2.1, select Enterprise Installation as the installation type.
• While running RCU for Oracle Data Integrator 12.2.1, on the Select Components page, uncheck the Oracle Data Integrator check box.

Setting up Oracle GoldenGate

This section describes setting up Oracle GoldenGate to work with Oracle Utilities Analytics.

• Setting up Oracle GoldenGate on Source Database Server
• Setting up Oracle GoldenGate on Target Database Server
• Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers
• Recommended Oracle GoldenGate Parameter Settings

Setting up Oracle GoldenGate on Source Database Server

To set up each source instance, follow these steps:

1. Create a directory on the source database server and install Oracle GoldenGate there. It will be Oracle GoldenGate home (OGG_Home) on the source database server.

For example: <path>/GoldenGate Home
2. Install Oracle GoldenGate.

   Download Oracle GoldenGate 12.2.0.1.0 from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

   For installation instructions, refer to the respective installation documentation at http://docs.oracle.com/goldengate/c1221/gg-winux/index.html.

3. Provide the Oracle GoldenGate Home location as the directory location created in step 1.

4. Open a command terminal/window and set the source ORACLE_SID and ORACLE_HOME variables.

5. Set LD_LIBRARY_PATH as follows:
   In Unix:
   ```bash
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```
   In Windows:
   ```bash
   set LD_LIBRARY_PATH=%ORACLE_HOME%\lib;%LD_LIBRARY_PATH%
   ```

6. In the Command window, change the directory to Oracle GoldenGate Home directory, and then execute the command below:
   In Unix:
   ```bash
   ./ggsci
   ```
   In Windows:
   ```bash
   ggsci
   ```
   The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order they are listed:
   - create SUBDIRS
   - start mgr

   This command starts the Oracle GoldenGate manager process.

   - info all

   This command verifies if the manager process is running.

   - exit

   This command exits Oracle GoldenGate.

8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as the sys user and execute the statements shown below:
   ```sql
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.
11. Open the **GLOBALS** file in the directory and add the following command:

   EnableMonitoring

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

13. Connect to the database as **sys user** using SQL*Plus.

   Ensure OGG_Home to be the current directory while invoking SQL*Plus.

14. Create a new user.

   For example: ODM01SRC

   This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is
   not assigned to any other user.

   **Note**: Ensure to note down the GoldenGate Owner Username; it will be used
   in the Oracle Utilities Analytics installation.

15. Connect to the source database with **sys user**.

16. Execute the following commands:

   **Note**: Ensure to modify the GoldenGate owner placeholder with actual name
   of the database user created in step 14.

   grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate
   Owner>;
   grant unlimited tablespace to <GoldenGate owner> with admin
   option;
   EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate
   Owner>','capture');
   grant unlimited tablespace to <GoldenGate Owner> with admin
   option;
   Revoke dba from <GoldenGate Owner>;
   grant create any view to <GoldenGate Owner>;
   grant select any dictionary to <GoldenGate Owner>;
   GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
   GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;

17. Connect to the <source application>ADM schema (such as CISADM). Execute the
    following commands:

    **For Oracle Utilities Customer Care and Billing** source database, execute the following
    grants:

    Grant select on F1_MST_CONFIG to <GoldenGate owner user created in
    step 16>
    Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in
    step 16>
    Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in
    step 16>
    Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created in
    step 16>

    **For Oracle Utilities Operational Device Management** source database, execute the
    following grants:

    Grant select on F1_MST_CONFIG to <GoldenGate owner user created in
    step 16>
    Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in
    step 16>
For **Oracle Utilities Meter Data Management** source database, execute the following grants:

Grant select on `<application ADM Schema>`. F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on `<application ADM Schema>`. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;

For **Oracle Utilities Work and Asset Management** source database, execute the following grants:

Grant select on `<application ADM Schema>`. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
Grant select on `<application ADM Schema>`. F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on `<application ADM Schema>`. F1_BKT_CONFIG to <GoldenGate Owner>;
Grant select on `<application ADM Schema>`. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

**Note**: While executing SQL commands in steps 15, 16, and 17, provide the GoldenGate owner user (if prompted for).

All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the database as **sys user**.

18. Execute the following commands in the order listed below:
   - @marker_setup.sql
   - @ddl_setup.sql
   - @role_setup.sql


20. In the Command window, create a directory “diroby” in the OGG_Home directory.

21. Change directory to the Oracle GoldenGate Home directory, and execute the following:
   b. Steps in Generating Shared Secret Password.

   **Note**: Execute these steps before running the Oracle Utilities Analytics installer. See [http://docs.oracle.com/goldengate/c1221/gg-winux/index.html](http://docs.oracle.com/goldengate/c1221/gg-winux/index.html) for more details.

### Configuring Encrypting Data Using ENCKEYS Method

To configure for encrypting data with the ENCKEYS method, do the following:

1. Execute the following command:
   ```
   cd <OGG_HOME>
   keygen <encryption key length (in bits)> [number of keys to generate]
   ```
   The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

3. Repeat the step above for each key values generated.
4. Save the file with name ‘ENCKEYS’ (upper case only) without any extension.

   Example:
   
   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035DD6893205A7BD6773FA8E670

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

6. Input the Logical name, space and key value generated.

   Sample content of the ENCKEYS file:
   
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

7. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

   Note: It is recommended to provide a logical key name after <context_code>KEY.

   For example: If context code is CCB1, it is recommended to name it as CCB1KEY.

Generating Shared Secret Password

   To generate the shared secret password, follow these steps:

   1. Execute the following command:

      cd <OGG_HOME>
      ggsci
      ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>

      Example:
      cd $OGG_HOME
      ./ggsci
      GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
      Encrypted password:
      AADAAAAAAAAAAIAVGNHBFGLGFCHBTCVBFJFHUEJGNCFACOAFE0FBALELISFOEIFWGRB
      ZHCCMCYGBD2H
      Algorithm used: AES128

   2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and the generated encrypted password.

Setting up Oracle GoldenGate on Target Database Server

   To set up Oracle GoldenGate on the target database server, follow these steps:

   1. Create a directory on the target database server.

      For example:../GoldenGateHome

      Oracle GoldenGate should be installed in this directory. It is Oracle GoldenGate home (OGG_Home) on the target Oracle Utilities Analytics database server.

      Note: Ensure to note down the directory location; it will be used in the Oracle Utilities Analytics installation.
2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.
   Set LD_LIBRARY_PATH using the following commands:
   In Unix:
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```
   For Windows:
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
   ```

4. In the Command window, change the directory to **GoldenGate Home** and execute the following command:
   For Unix:
   ```
   ./ggsci
   ```
   For Windows:
   ```
   ggsci
   ```
   The Oracle GoldenGate prompt is shown.

5. At the prompt, execute the following commands:
   ```
   create SUBDIRS
   start mgr
   info all
   exit
   ```

6. Create a directory “diroby” in the OGG_Home directory.

7. Connect to the target database as **sys user** and execute the command below:
   ```
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

8. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.

9. Edit the GLOBALS file in the `<GG home>` directory and add the following command:
   ```
   EnableMonitoring
   ```

10. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. If the ENCKEYS file does not exist, follow these steps:
   a. Create and open a new ASCII ENCKEYS file.
   b. Add the key value/values that are generated on the sources to the ENCKEYS file in target OGG home. This is done for the context codes for which source is configured.
   A sample ENCKEYS file in target OGG home is as below:
   ```
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ```

### Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

Set up Oracle GoldenGate Monitor (OGG) JAgent on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers. The OGG Monitor JAgent is used to automatically copy the generated OGG scripts to both source and target GoldenGate Home directories, and to start the extract and replicate processes on source and target.
To setup OGG Monitor JAgent on both target and source database servers, follow these steps:

1. Ensure Oracle GoldenGate is installed and Manager is running.

2. Start the rmiregistry services using the following command:
   
   rmiregistry 5559 &

   Ensure to note down the port on which RMI server is started. The port number specified here is 5559. If it is not specified, the default port 1099 will be used.

3. Install Fusion Middleware Infrastructure.

4. Run the OGG Monitor 12.2.1 installer.
   
   a. Set Oracle Home to the location where Fusion Middleware Infrastructure was installed in step 2.
   
   b. Choose installation type as OGG Monitor Agent.

5. Edit the Config.properties file in the <OGG Monitor home>/oggmon/ogg_agent/\cfg_templates and add/modify the below parameters.

   <ACTUAL>   : jagent.host=localhost  
   <CHANGE TO> : jagent.host=<<actual hostname on which OGG is installed>>

   <ACTUAL>   : monitor.jmx.username=cmroot
   <CHANGE TO> : monitor.jmx.username=jmx_src

   <ACTUAL>   : jagent.username=root
   <CHANGE TO> : jagent.username=<<OGG software installed OS user>>

   <ACTUAL>   : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started

   <ACTUAL>   : agent.type.enabled=OGGMON
   <CHANGE TO> : agent.type.enabled=OEM

   <ACTUAL>   : jagent.backward.compatibility=true
   <CHANGE TO> : jagent.backward.compatibility=false

6. Add the following parameter:

   jagent.ssl=false

7. Navigate to <OGG Monitor home>/oggmon/ogg_agent directory and run the below command:

   In Unix:

   export JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.sh

   In Windows:

   set JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.bat

   a. You will be prompted to enter:

   • Oracle GoldenGate home directory
   • Path to be used for Oracle GoldenGate Monitor Agent instance.
It is recommended to provide a path (such as `<OGG Monitor home>/Agents/OGGMonitorInstance`).

- A unique name to replace the timestamp in the name of the file used to start GG Monitor agent instance.

  Provide a unique name to be used for this Oracle GoldenGate Monitor instance.

b. Execute the command below from `<path used for Oracle GoldenGate Monitor instance provided in the step above>/bin`.

  Example location: `<OGG Monitor home>/Agents/OGGMonitorInstance/bin`

  In Unix:
  ```
  export JAVA_HOME=<JDK home>
  ./pw_agent_util.sh -jagentonly
  ```

  In Windows:
  ```
  set JAVA_HOME=<JDK home>
  pw_agent_util.bat -jagentonly
  ```

8. Enter the Oracle wallet password.

   This password has to be entered as the password for the JAGENT while running the installer (for target gg), and while running the source configuration (for source gg).

   Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is required in subsequent installation.

9. Create a folder with the Context_code name in `<GG Home>/dirdat`.

   For example: If WAM2 is created for the WAM source, then create a folder with name “WAM2” within the `<GG Home>/dirdat/` folder.

10. Create a folder with name `<GG Home>/diroby`.


    Replace COMMAND java with COMMAND `<JDK Home>/bin/java`.

    This ensures that the correct version of java (1.8) is used while starting JAgent.

12. Navigate to OGG_Home directory and go to the GoldenGate prompt:

    `ggsci`

13. Start the JAgent process using the following command:

    `start jagent`

   The logs for JAgent are created at the following (example) location.

   `<OGG Monitor home>/Agents/OGGMonitorInstance/logs`

---

**Recommended Oracle GoldenGate Parameter Settings**

The recommended Oracle GoldenGate parameter settings are as follows:

1. Update the source `<Source GG Home>/dirprm/mgr.prm` file as follows:

   ```
   AUTORESTART EXTRACT <Context Code>*. RETRIES 5, WAITMINUTES 2, RESETMINUTES 60
   ```
2. Update the Target <Target GG Home>/dirprm/mgr.prm file with the following:
   AUTORESTART REPLICAT <Context Code>*; RETRIES 5, WAITMINUTES 2, 
   RESETMINUTES 60
   PURGEOLDEXTRACTS dirdat/<Context Code>/*; USECHECKPOINTS, 
   MINKEEPHOURS 4
   DOWNCRITICAL

3. Restart the mgr process after the changes mentioned above are complete.

The following parameters are optional and depend on the level of alerts required for the
environment.

For Oracle Utilities Network Management System sources:
- DOWNREPORTMINUTES 2 - Report any downtime more that 2 minutes
- LAGCRITICALMINUTES 2 - Report any lag > 2 minutes as critical
- LAGINFOSECONDS 30 - Report any lag > 30 seconds as warning
- LAGREPORTMINUTES 1 - Log lag information every minute

For other sources:
- DOWNREPORTMINUTES 10 - Report any downtime more that 10 minutes
- LAGCRITICALMINUTES 10 - Report any lag > 10 minutes as critical
- LAGINFOMINUTES 5 - Report any lag > 5 seconds as warning
- LAGREPORTMINUTES 5 - Log lag information every 5 minutes

Copying and Decompressing Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.7.0 Multiplatform part (Oracle Utilities 
   Analytics V2.7.0 Multiplatform.zip) from Oracle Software Delivery Cloud (https://
   edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
   <TEMPDIR> below). This directory must be located outside any current working Oracle 
   Utilities application environment. All files that are placed in this directory as a part of the 
   installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Multiplatform.zip to <TEMPDIR>.

Starting the Installer

For an AIX Operating System, set the following environment variable before starting the Oracle 
Utilities Analytics installation:

export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m - 
XX:MaxPermSize=3200m

To start the Oracle Data Integrator Based ELT component, follow these steps:

1. Go to the temporary folder containing the installer.
2. Run the following command from this folder:

   java -jar <TEMPDIR>/OUA_2.7.0.0.0_generic.jar -logLevel finest

   **Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

   The **Welcome** page appears.

3. Review this information before you begin the installation. Click **Next** to continue with the installation.

4. Complete the tasks on the navigation pane.

   Each item in the navigation pane represents a specific installer screen that prompts you for information required to install the software.

   - If you select **Oracle Data Integrator Based ETL** as an **Installation Type**, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - Oracle Data Integrator Home and Schema Details
     - Oracle Data Integrator Agent and Repository Details
     - Target GoldenGate Details
     - Target JAgent Details
   - If you select **Dashboard** as an **Installation Type**, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - OBIEE Home Details
   - If you select both **Oracle Data Integrator Based ETL** and **Dashboard** as an **Installation Type**, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - Oracle Data Integrator Home and Schema Details
     - Oracle Data Integrator Agent and Repository Details
     - Target GoldenGate Details
     - Target JAgent Details
     - OBIEE Home Details

### Installation Steps

To install Oracle Data Integrator Based ETL, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The **Welcome** page appears.

2. Review the information before you begin the installation. Click **Next** to continue with the installation.

   The **Installation Location** page appears.
3. Define the **Installation Location** and click **Next**.
   
   **Note**: The specified Oracle home directory must be an empty directory.

   The **Select Installation Type** page appears.

4. In the **Select Installation Type** page, select **ODI Based ETL** and click **Next**.
   
   **Note**: Based on the selected installation type, the options on the left navigation panel change.

5. Select **Oracle Data Integrator Based ETL** as an **Installation Type**. Define the following:
   - Database and Java Home Details
   - Target Database Connection Details
   - Oracle Data Integrator Home and Schema Details
   - Oracle Data Integrator Agent and Repository Details
   - Target GoldenGate Details

6. On the **Database and Java Home Details** page, enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>Database client home location</td>
<td>Example: /u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>JDK home location</td>
<td>Provide location of JDK 1.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.8.0_77</td>
</tr>
</tbody>
</table>

7. On the **Target Database Connection Details** page, enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Host name of the server where the database resides</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>Database port number on the database server used for connecting to the database</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>Service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>Password for the target schema (DWADM)</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm password for the target schema (DWADM)</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>Password for the metadata schema (MDADM)</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm password for the metadata (MDADM) schema</td>
<td></td>
</tr>
</tbody>
</table>
8. On **ODI Home and Schema Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home Directory</td>
<td>Directory where Oracle Data Integrator (ODI) is installed</td>
<td>Example: /u01/Middleware/Oracle_ODI1</td>
</tr>
<tr>
<td>Supervisor User Name</td>
<td>Name of the Oracle Data Integrator Supervisor</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>Password of the Oracle Data Integrator Supervisor</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm password of the Supervisor</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>Password of the master repository schema</td>
<td>OUA_MASTER user’s password</td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm password of the Oracle Data Integrator master repository schema</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>Work repository schema password</td>
<td>OUA_WORK user’s password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm password of Oracle Data Integrator work repository schema</td>
<td></td>
</tr>
</tbody>
</table>

9. On the **ODI Agent and Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Agent Host</td>
<td>Host where Oracle Data Integrator WebLogic Domain is created</td>
<td>Oracle Data Integrator Server host name.</td>
</tr>
<tr>
<td>ODI Agent Port</td>
<td>Port on which Oracle Data Integrator WebLogic agent is configured to run.</td>
<td>Provide available port and ensure to use the same port while creating Oracle Data Integrator managed server.</td>
</tr>
<tr>
<td></td>
<td>This is the Oracle Data Integrator WebLogic Managed Server port.</td>
<td></td>
</tr>
</tbody>
</table>
10. On the **Target GoldenGate Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>Oracle GoldenGate Manager host</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>Location where Oracle GoldenGate is installed</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
<tr>
<td>Target Database Home</td>
<td>Location where database home is installed on the target database server.</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the GoldenGate host</td>
<td>The default value is 7830.</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>The algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>The Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>Shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT Provide the result of above command as the value.</td>
</tr>
</tbody>
</table>

11. On the **Target JAgent Details** page, enter the target server JAgent details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Host</td>
<td>Oracle GoldenGate Monitor JAgent host</td>
<td></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>Oracle GoldenGate installed location where GoldenGate Monitor JAgent is running</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
</tbody>
</table>
Installing Oracle Data Integrator Based ELT Component

12. On the **Installation Summary** page, verify the installation options selected.

13. Click **Install** to begin the installation.

   To change any configurations before starting the installation, use the navigation pane and select the topic to edit.

   The **Installation Progress** page appears displaying the progress of the installation.
   Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The detailed logs of the installation are also available in the logs/system directory under the installation location.

   To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

14. On the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

**Note:** To configure source, refer to the Chapter 5: Configuring Oracle Utilities Analytics in *Oracle Utilities Analytics Administration Guide*.

### Creating a Database Directory

Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each source database. This directory is used for logging the export import task used during the initial ELT load.

The following is a sample SQL that creates the database directory pointing to the file system path /scratch/file_data:

```
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
```

### Configuring Oracle Data Integrator Repository Creation Utility (RCU)

To configure the Oracle Data Integrator Repository Creation Utility, follow these steps:

1. Ensure RCU for ODI is run and the required schemas are created in the target database.

   ODI_ORACLE_HOME is an Oracle Home path used as Oracle Home while installing FMW Infrastructure and Oracle Data Integrator (ODI).

2. Set or export JAVA_HOME variable to the 1.8.0_77+ installed directory.

3. Go to $ODI_ORACLE_HOME/oracle_common/bin.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Port</td>
<td>Use the JAgent RMI port (5557) defined in the config properties file</td>
<td></td>
</tr>
<tr>
<td>JAgent User</td>
<td>OS user used to configure JAgent</td>
<td></td>
</tr>
<tr>
<td>JAgent Wallet Password</td>
<td>JAgent Wallet password</td>
<td></td>
</tr>
<tr>
<td>Confirm JAgent Wallet Password</td>
<td>Re enter JAgent Wallet password to confirm</td>
<td></td>
</tr>
</tbody>
</table>
4. Execute the RCU utility.

For example:

```bash
export JAVA_HOME=/scratch/bi_oradata_01/jdk1.8.0_77
cd /scratch/bi_oradata_01/Middleware_ODI_12.2.1_EE/Oracle_Home/oracle_common/bin
./rcu
```

5. In the Repository Creation Utility, select **Create Repository > System Load and Product Load** option.

6. On the page, provide the database connection details.

7. On the **Select Components** page, the options are shown as below. De-select the Oracle Data Integrator component.

8. In the next page, make a note of or remember the password given. It will be required while creating the Oracle Data Integrator domain.

Note that a new script to create the ODI domain is described in the **Creating WebLogic Domain for Oracle Data Integrator Agent** section. This utility assumes that the same password is used for all RCU schemas. The assumption was made to keep the inputs to the domain creation script simple.

It is not required to create the Oracle Data Integrator domain at this stage. It should be done after running the Oracle Utilities Analytics installer and before running source configuration tool.

**Creating WebLogic Domain for Oracle Data Integrator Agent**

Create the WebLogic Domain to bring up the WebLogic Agent (ODI Agent) to complete the steps. In this product release, ODI Domain creation is automated, and creation of both clustered and non-clustered domain is supported.

- **Creating a Non-Clustered Domain**
- **Creating a Clustered Domain**

Note: The following procedures assume that the pre-requisite Java 8/bin is in the PATH variable.
Creating a Non-Clustered Domain

To create a non-clustered domain, follow these steps:

**Note:** The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the `<OUA Environment>/etc` directory and provide the following properties in the ODI_CONFIG.properties file.

   **Property** | **Description**
   --- | ---
   Mandatory fields
   DOMAIN_PATH | In Windows environment, replace “\” with “/” in the domain path.
   For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5
   RCUPREFIX | Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.
   RCUSCHEMAPWD | Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.
   WEBLOGIC_USERNAME | WebLogic user name for ODI domain
   WEBLOGIC_PASSWORD | WebLogic password for ODI domain
   ODI_DBSERVER | ODI database server name (target database server)
   ODI_DBPORT | ODI database port (target database port)
   ODI_DBNAME | ODI database name (target database name)
   ADMIN_PORT | ODI domain admin port
   ODI_DOMAIN_HOSTNAME | Host name on which the ODI domain is created

   Optional fields
   NONSSL_PORT | If not specified, default port 7001 will be assigned.
   MANAGED_SERVER_PORT | If not specified, default port 15101 will be assigned.

2. Navigate to the `<OUA Environment>/bin` directory and invoke the `createDomain.sh`/`cmd` script.

Refer to the sections Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) to start the Admin server and Managed server.

Creating a Clustered Domain

To create a clustered domain, follow the steps below:
Note: The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN_PATH</td>
<td>In Windows environment, replace “\” with “/” in the domain path. For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI_DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td>ODI_DOMAIN_HOSTNAME</td>
<td>Host name on which the ODI domain is created</td>
</tr>
<tr>
<td>CLUSTER_NAME</td>
<td>Additional mandatory field for clustered domain</td>
</tr>
</tbody>
</table>

2. Navigate to the <OUA Environment>/bin directory and invoke the `createDomain.sh` script.

   This creates an ODI domain with an Admin server and a Managed server (as ‘ODI_server1’) and assigned to the cluster.

   Refer to the Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) sections to start the Admin server and Managed server.

To create another managed server and add it to the cluster, follow these steps:

1. Bring up the Admin server.
2. Navigate to the <OUA Environment>/etc directory and provide the following mandatory properties in the ODI_CONFIG.properties file:
   - MANAGED_SERVER_NAME
   - MANAGED_SERVER_PORT
3. Provide the following optional properties in the ODI_CONFIG.properties file:
   - MACHINE_NAME
   - MACHINE_PORT
   A new managed server is created with the specified name and assigned to the cluster.
   Refer to the sections Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) to start the Admin server and Managed server.

### Starting the WebLogic Admin Server

To start the WebLogic Admin server, perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home.
   
   `<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin`
2. Execute the `startweblogic` command:
   
   In Unix:
   ```sh
   nohup ./startWebLogic.sh > startWebLogic.log &
   ```
   In Windows:
   ```cmd
   startWebLogic.cmd
   ```

### Starting the Managed Server (ODI_server1)

To start the odi_server1 managed server, follow these steps:

2. Create boot.properties file. Enter the username and password in the respective fields in the file. Save the file.

   Below is an example of the boot.properties file:
   ```properties
   username=<weblogic username>
   password=<weblogic password>
   ```
3. Change the directory to WLS Home to start odi_server1:
   
   In Unix:
   ```sh
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
   ```
   In Windows:
   ```cmd
   StartManagedWeblogic.cmd odi_server1
   ```
4. In the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent.
5. Right-click OracleDIAgent and click Test to test the connectivity of the configured Oracle Data Integrator Java EE agent.
Installing Oracle Utilities Analytics Administration Component

Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based configuration tool used to configure Oracle Utilities Analytics.

This section describes how to install the tool to configure Oracle Utilities Analytics and change the default password of the Admin user.

- Installation Steps
- Changing Default Password of the Admin User

**Note:** Install Oracle Utilities Analytics Administration component on the Oracle Utilities Analytics database server.

### Installation Steps

To install the Oracle Utilities Analytics Administration Tool, follow these steps:

1. Download Apex 5.0.4 to the database server under the /temp directory. Then unzip the file.
   ```
   cd /temp/apex
   ```

2. Connect to the Oracle Utilities Analytics database as the **sys user** and execute the following commands:
   ```
   @apxremov.sql
   @apxrtins <Tablespace name> <Tablespace name> <Temp Tablespace name> /i/
   ```
   For example, `@apxrtins CISTS_01 CISTS_01 TEMP /i/`

   ```
   @apxchpwd.sql
   ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
   ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
   @apex_rest_config.sql
   ```
   **Note:** Ensure to note down the passwords for APEX_Listener user and APEX_REST_PUBLIC_USER.

3. Import the tool to configure Oracle Data Integrator:
   a. Unzip the **Oracle Utilities Analytics V2.7.0 Multiplatform.zip** file. The file includes the AdminTool folder.
   b. Create the ../AdminTool directory on the database server and copy the contents of the AdminTool directory (from the zip file) to this directory.
   c. Navigate to the ../AdminTool directory. (cd ../AdminTool).
   d. Connect as the **sys user** and execute the following scripts:
      - To create workspace and configure the users:
        `@CreateAppWorkspace.sql`
      - To import application:
        `@DeployAdminApp.sql`
      - To deploy supporting objects:
        `@DeploySupportingObjects.sql`

4. Download Apex 5.0.4 to the server where you want to set up the tool (under /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory).
   **Note:** Create /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory if it does not exist.
5. Download Oracle Rest Data service 3.0.6 to the server where you want to set up the Administration Tool (under /scratch/bi_oradata_01/Softwares/apex_listener directory).

   **Note:** Create /scratch/bi_oradata_01/Softwares/apex_listener directory if it does not exist.

6. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listener directory and unzip the ords.zip file.

   ```
   cd /scratch/bi_oradata_01/Softwares/apex_listener
   ```

7. Navigate to the /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory and unzip the apex_5.0.4_en.zip file.

   ```
   cd /scratch/bi_oradata_01/Softwares/apex_5.0.4
   ```

8. Create a directory on the server to configure Apex.

   For example: mkdir /scratch/bi_oradata_01/apex_configuration

9. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listener directory:

   ```
   cd /scratch/bi_oradata_01/Softwares/apex_listener
   ```

10. Execute the following command:

    ```
    java -jar ords.war install advanced
    ```

    **Note:** Use JDK1.8 to execute the command.

    Provide the necessary inputs as shown below:

    ![Command input image]

11. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listener directory:

    ```
    cd /scratch/bi_oradata_01/Softwares/apex_listener
    ```
12. Execute the following command:

```java
java -jar ords.war static /scratch/bi_oradata_01/Softwares/apex_5.0.4/apex/images
```

**Note:** The command creates i.war file.

13. Create the WebLogic domain.
   a. Navigate to `<Middleware Home>/Weblogic_12.2.1_Home/oracle_common/common/bin`.
      
      ```
cd <Middleware Home>/Weblogic_12.2.1_Home/oracle_common/common/bin
      ```
   b. Execute the following command:
      
      ```
      ./config.sh
      ```

      The **Fusion Middleware Configuration Wizard** window appears.
   a. Select **Create a new WebLogic domain** and click **Next**.
   ![Fusion Middleware Configuration Wizard](image.png)
b. Provide the domain name.

![Image of Fusion Middleware Configuration Wizard]

Ensure you do not change the domain location.

Click Next.

c. Provide the WebLogic User Password. Ensure you make a note of the password.

![Image of Fusion Middleware Configuration Wizard]

Click Next.

d. Select jdk1.8 and click Next.
e. Select the **Administration Server, Managed Servers, Clusters and Machines** options. Then, click **Next**.

f. Provide the **Listen Port** as available port. Click **Next**.
g. Click **Add** and provide values as shown below:

Click **Next**.
Installing Oracle Utilities Analytics Administration Component

1. On the Configure Machines page, click **Next**.

2. On the Configuration Summary page, click **Next**.

3. Create the `boot.properties` file.

4. Start the Admin and Managed server.
16. Login to WebLogic console and click **Lock & Edit**.

![Lock & Edit](image1)

17. Click **Install**.

18. Enter the following path and then select the *ords.war* file.

```
/scratch/bi_oradata_01/Softwares/apex_listener
```

![Oracle WebLogic Server Administration Console](image2)

Click **Next**.
19. Select the **apex server** check box and click **Next**.

20. Select the options as shown below:
21. Select the options as shown below:

![Image of the Application Assistant with deployment options](image)

22. Click **Activate Changes**.

![Image of the View changes and restarts screen](image)

23. Repeat the steps 13 to 20 to deploy the i.war file.

24. Login to the WebLogic console and navigate to **Deployment > Monitoring**.

25. Select i and ords. Then, click **Start > Servicing All Requests**.

![Image of the WebLogic console monitoring screen](image)
26. Click Yes.

27. Restart the Admin and Managed servers.

28. Go to the following URL to access the Administration Tool:

   http://<hostname>:<managed server port no>/ords/?p=104

   The credentials to access the tool are:

   User ID: Admin
   Password: Admin_123

**Changing Default Password of the Admin User**

This section describes the APEX API used to change the password of the admin user. The script should be run after connecting to the database as user SYSTEM.

Replace the string 'New password' with the new password for the admin account before running the script.

```
begin
  wvv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_application_install.get_workspace_id,2090606133849294));
end;
/

begin
  apex_util.edit_user(
    p_user_id => '2090514487849294',
    p_user_name => 'ADMIN',
    p_web_password => 'New password',
    p_new_password => 'New password'
  );
end;
/

commit;
/

Note: It is strongly recommended to change the default password after logging in.
```
Installing Oracle Utilities Analytics Dashboards Component

**Note:** Ensure that the same Operating System (OS) user to install the prerequisite software is used to install the Oracle Utilities Analytics Dashboards component as well.

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics application server. This section describes how to install the dashboards component of Oracle Utilities Analytics.

- Creating and Configuring an OBIEE Domain
- Copying and Decompressing Install Media
- Starting the Installer
- Installation Steps
- Deploying the Repository (RPD) File
- Deploying Web Catalog
- Configuring and Deploying the MapViewer
- Updating MapViewer Configuration
- Enabling WriteBack
- Enabling Auto Complete Feature in OBIEE

### Creating and Configuring an OBIEE Domain

To create and configure an OBIEE domain, follow the steps below. This is a prerequisite to install the Oracle Utilities Analytics Dashboards component.

1. Run RCU to create the necessary schemas.
   a. Navigate to `<FMW infrastructure home>/oracle_common/bin`. Example location:

   ```
   cd /u01/12.2.1.9_Infrastructure/oracle_common/bin
   ```

   b. Run below command and follow the instructions in the wizard:

   ```
   ./rcu
   ```

   **Note:** Select AS Common Schemas and Oracle Business Intelligence components in the **Select Components** panel.

2. Run the OBIEE configuration assistant to create an OBIEE domain.
   a. Navigate to `<FMW infrastructure home>/bi/bin`

   Example location:

   ```
   cd /u01/12.2.1_Infrastructure/bi/bin
   ```

   b. Run below command and follow the instructions in the wizard:

   In Unix:

   ```
   ./config.sh
   ```

   In Windows:

   ```
   ./config.cmd
   ```

   c. On the **Database Details** panel, choose “Use existing schemas” and provide connection details (prefix of the RCU run in step 1).
d. On the **Initial Application** panel, select “Oracle sample application (SampleAppLite).

**Note:** Ensure the BI domain path, WebLogic user name and password are noted down. They should be provided as inputs when the Oracle Utilities Analytics Dashboards component installer is run.

3. After the successful creation of OBIEE domain, start the OBIEE Admin server.

4. Login into the Admin console.
   a. On the **Environment** tab, navigate to the coherence clusters.
   b. Click **defaultCoherenceCluster** and then select the **Configuration** tab.

   Ensure the port mentioned in the **Cluster Listen Port** field is not in use. If needed, change it to another port that is not in use.
   c. Click **Save** to save the port changes (if any).
   d. Start the OBIEE Managed server.

5. After starting the OBIEE domain services successfully, navigate to the `<OBIEE domain>/config/fmwconfig` directory.
   a. Open `jps-config.xml`.
   b. Under the `<serviceInstance name="idstore.ldap" provider="idstore.ldap.provider">` element, add the property element as below:

   ```
   <property
     name="oracle.security.jps.ldap.policystore.refresh.interval"
     value="6000000"/>
   ```

   The OBIEE domain is successfully created and configured.

### Copying and Decompressing Install Media

To download and decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0 ([Oracle Utilities Analytics V2.7.0 Multiplatform.zip](https://edelivery.oracle.com)) from the Oracle Software Delivery Cloud ([https://edelivery.oracle.com](https://edelivery.oracle.com)).

2. Create a temporary directory, such as `c:\OUA\temp` or `/OUA/temp` (referred to as `<TEMPDIR>` below).

   This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip **Oracle Utilities Analytics V2.7.0 Multiplatform.zip** to `<TEMPDIR>`.

### Starting the Installer

For an AIX Operating System, set the following environment variable before starting the Oracle Utilities Analytics installation:

```bash
export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m -XX:MaxPermSize=3200m
```

To start the installer, do the following:

1. Navigate to the temporary folder where you downloaded the install. Run the following command from the folder:

   ```bash
   java -jar <TEMPDIR>/OUA_2.7.0.0.0_generic.jar -logLevel finest
   ```
Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

2. On the Welcome page, review the information before you begin the installation.
3. Click Next to continue with the installation.
4. Complete the installation by following the tasks on the navigation pane.

Each item in the navigation pane represents a specific installer screen that prompts you for the information required to install the software.

### Installation Steps

To install the Dashboards component, follow these steps:

1. Run the Oracle Utilities Analytics Installer.
2. On the Welcome page, review the available information before you begin the installation.
3. Click Next to continue with the installation. The Installation Location page appears.
4. Define the Installation Location here and click Next. The Select Installation Type page appears.

   Note: The specified Oracle home directory must be an empty directory or a directory where the OUA ODI ETL 2.7.0.0.0 component was installed successfully.

5. In the Select Installation Type page, select Dashboards and click Next.

   Note: Based on the selected installation type, the options on the left navigation panel change. When you select Dashboard as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details and OBIEE Home Details.

   The Database and Java Home Details page appears.

6. Enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>Database client home location</td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>/u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>JDK home location</td>
<td>JDK 1.8 location</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>/u01/jdk_1.8.0.77</td>
</tr>
</tbody>
</table>

   The Target Database Connection Details page appears.

7. Enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
</tbody>
</table>
The OBIEE Home Details page appears.

8. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Home</td>
<td>The location on the disk where OBIEE is installed.</td>
<td>Example: /u01/Middleware/Oracle_BI1</td>
</tr>
<tr>
<td>BI Domain Home</td>
<td>The domain Home location under the directory where OBIEE is installed.</td>
<td>Example: /u01/Middleware/user_projects/domains/bifoundation_domain</td>
</tr>
<tr>
<td>Weblogic Host</td>
<td>The hostname on which WebLogic server for OBIEE is running.</td>
<td></td>
</tr>
<tr>
<td>Weblogic Port Number</td>
<td>A unique port number within the system that is assigned to the HTTP port.</td>
<td>Example: 7001</td>
</tr>
</tbody>
</table>

**Note:** You will be prompted for the Weblogic user's password after installation.

The Installation Summary page appears.

9. Verify the installation options and click **Install** to begin the installation.
For any changes to the configuration before starting the installation, use the navigation pane and select the topic to edit.

10. The **Installation Progress** page appears allowing you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.

To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and it needs to be deleted manually.

11. On the **Installation Completed** page, click **Finish** to close the installer.

The Dashboards component is now installed successfully.

**Deploying Web Catalog**

Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the location of the catalog.

To deploy the web catalog, follow these steps:

1. Go to the `<DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/root/shared` directory.

2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities Analytics in the previous release.

   Ensure any custom catalog related files in this directory are backed up in a separate location before running deployBar.sh/cmd.

   If Oracle Utilities Network Management System BI Publisher reports were deployed they should be retained.

3. Follow the steps as below for UNIX and Windows respectively:

   - **In Unix**:
     a. Navigate to `<Install_Dir>/bin` directory.
        
        `cd <Install_Dir>/bin`
     b. Add Java 8 to the path variable as shown in example below:
        
        `export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH`
     c. Run `ksh ./deployBAR.sh`.

   - **In Windows**:
     a. Navigate to `<Install_Dir>/bin` directory.
        
        `cd <Install_Dir>/bin`
     b. Add Java 8 to the path variable as shown in example below:
        
        `set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%`
     c. Run `deployBAR.cmd`.

   The web catalog is successfully deployed.
For an AIX operating system, after the deployBAR.sh/deployBAR.cmd is completed successfully, execute the following command:

```
cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/service_instances/ssi/metadata/content/msgdb/l_en/customMessages
```

### Deploying the Repository (RPD) File

If no changes are made to the deployed RPD, then take the RPD file from the following location, where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory:

```
<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd
```

If it was merged, then take the merged RPD and make the required database changes. Copy this RPD file to the Windows machine on which OBIEE 12.2.1 is installed.

To deploy the RPD file, follow these steps:

1. Ensure OBIEE 12.2.1 is installed on the Windows machine before proceeding.
2. Click **Start > Programs > Oracle Business Intelligence > Administration.**
3. Click **File > Open > Offline...** to open the RPD in offline mode.
4. Provide the RPD password. The default password is “oracle123”.
5. Double-click the **Connection Pools** to edit them.

![Diagram of Connection Pools](image)

- In the **Init Block Connection Pool** group, enter the following:
  - Datasource name = BI Database name
  - User name = DWREAD
  - Password = DWREAD User password
- In the **Init Block Pool - MDM** group, provide the following (only for Oracle Utilities Meter Data Management):
  - Datasource name = MDM database name
  - User name = CISUSER
  - Password = CISUSER User password
• In the **Init Block Pool - NMS Replication** group, provide the following (only for Oracle Utilities Network Management System):

  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

  **Note:** The schema name is NMS1REP by default. Rename it if the replication schema name is different.

• In the **Materialized Views Connection** group, enter the following:

  Datasource name = BI Database name  
  User name = DWREAD  
  Password = DWREAD User password

• In the **MDM Database Connection** group, provide the following (only for Oracle Utilities Meter Data Management):

  Datasource name = MDM database name  
  User name = CISUSER  
  Password = CISUSER User password

• In the **NMS Replication Tables** group, provide the following (only for Oracle Utilities Network Management System):

  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

  **Note:** The default schema name is NMS1REP. If the replication schema name is different, then rename.

• In the **ODIDEV Connection Pool** group, provide the following:

  Datasource name = BI database name  
  User name = DWUSER  
  Password = DWUSER User password

• In the **OUBI Database Connection** group, provide the following:

  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password
6. Click **Save**.

   **Note:** Click **Yes** when you see the prompt 'Do you wish to check global consistency?' and ignore any warnings that appear after consistency check is complete.

7. Copy the modified RPD back to the `<install dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd` where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory.

8. Login to the server where OBIEE Enterprise Manager is installed.


10. Run the following command to deploy the RPD:

    In Windows:

    ```
    data-model-cmd.cmd uploadrpd -I <OUA home>/Reports/rpd/UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -P <Weblogic password of OBIEE domain> -SI ssi
    ```

    In Unix:

    ```
    data-model-cmd.sh uploadrpd -I <OUA home>/Reports/rpd/UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -P <Weblogic password of OBIEE domain> -SI ssi
    ```

11. Run the following commands from `<OBIEE DOMAIN>/bitools/bin` directory to stop and start the OBIEE domain services respectively.

    ```
    stop.sh/cmd
    start.sh/cmd
    ```
Configuring and Deploying the MapViewer

Configuring and deploying the MapViewer involves the following tasks:

- Configuring the MapViewer
- Modifying instanceconfig.xml
- Updating MapViewer Configuration

Configuring the MapViewer

To configure the MapViewer, follow these steps:

1. Login to the WebLogic console.
2. Create the 'MAP_DS' datasource.
3. Lock and edit it.
4. Navigate to **Services > Data Sources**.
5. Select **New > Generic Data Source** and provide the following:
   - Name = MAP_DS
   - JNDI Name = MAP_DS
   - Database Type = oracle
6. Click **Next**.
7. Enter the following:
   - Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions:Any
8. Click **Next**.
9. On the next page, do not change any values. Click **Next**.
10. Enter the following connection properties:
    - Database Name: BI Database Name
    - Host Name: Database host
    - Port: Database port
    - Database User Name: dwadm
    - Password: dwadm password
11. Click **Next**.
12. On the next page, click **Test Configuration**. After the successful test, click **Next** again.
13. On the **Select Target** page, select AdminServer under **Servers** and bi_cluster under **Clusters**. Click **Finish**.
14. Click **Activate Changes**.
15. Update the mapViewerConfig file with the tags mentioned below:
   - File location: <Install Dir> /user_projects/domains/<obiee_domain>/config/fmwconfig/mapviewer/conf
   - File: mapViewerConfig.xml
16. If there is a proxy used, insert the list of host names for all the third-party service providers in the security_config node.
   - <proxy_enabled_hosts>
     - elocation.oracle.com
   - </proxy_enabled_hosts>
17. Add the following `ns_data_provider` node:

```xml
<ns_data_provider id="obieeNsdp"
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />
```

18. Add the current `map_tile_server` with the following `map_tile_server` node:

```xml
<map_tile_server>
<tile_storage default_root_path="/mytilecache"/>
</map_tile_server>
```

**Modifying instanceconfig.xml**

Ensure you take a backup before updating the `instanceconfig.xml` file. Run the following commands in UNIX and Windows respectively to go to the directory containing the `instanceconfig.xml` file.

In Unix:

```bash
<OBIEE_INSTALL_DIR>/user_projects/domains/<obiee_domain>/config/fmwconfig/biconfig/OBIPS
```

In Windows:

```bash
<OBIEE_INSTALL_DIR>user_projects\domains\<obiee_domain>\config\fmwconfig\biconfig\OBIPS
```

Perform the following changes to the `instanceconfig.xml` file:

1. Update the security node with the following values. If the security node is not present, add the following code before `</Serverinstance>`:

```xml
<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath/></CookiePath>
</Security>
```

2. Update the following `<ServerInstance>` element:

```xml
<LightWriteback>true</LightWriteback>
```

3. Add the following code between the `<ServerInstance>` `</ServerInstance>` tags.

```xml
<Prompts>
<MaxDropDownValues>256</MaxDropDownValues>
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
<AutoCompletePromptDropDowns>
<SupportAutoComplete>true</SupportAutoComplete>
<CaseInsensitive>true</CaseInsensitive>
<MatchingLevel>MatchAll</MatchingLevel>
<ResultsLimit>50</ResultsLimit>
</AutoCompletePromptDropDowns>
</Prompts>
<SpatialMaps>
<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>
</SpatialMaps>
```
Updating MapViewer Configuration

To update the MapViewer configuration, follow these steps:

1. Login to MapViewer.

   http://<Server>:<port>/mapviewer

2. To update the MapViewer configuration, navigate to MapViewer > Administration > Configuration. Login to the Mapviewer at this location:

   http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the below code in the mapViewerConfig.xml with the appropriate values:

   <map_data_source name="mapconn"
   jdbc_host="<DB server name>"
   jdbc_sid="/<DB Service name>"
   jdbc_port="1521"
   jdbc_user="DWADM"
   jdbc_password="!<DWADM user password>"
   jdbc_mode="thin"
   number_of_mappers="32"
   allow_jdbc_theme_based_foi="true"
   />

4. Click Save, and then restart.

Enabling WriteBack

To enable the Write Back, perform the following steps:

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack > Write Back to Database.

2. Click Denied:Authenticated User and select the Granted permission.

Enabling Auto Complete Feature in OBIEE

To enable the auto complete feature on OBIEE, perform the following steps:

1. Restart the OBIEE Admin server, Managed server, and opmn services.

   Note: Refer to OBIEE documentation for detailed instructions on how to start and stop admin server, managed server, and opmn services.

2. Login to Analytics.

   http://<Server>:<port>/analytics

3. Click WebLogic User (top-most-right section of the page).

4. From the drop-down menu, select My Account.

5. On the Preferences tab, set Prompt Auto Complete to ON.

6. Click OK.
Chapter 5

Installing Oracle Utilities Analytics v2.7.0.0.x Patchset Directly

This chapter provides instructions to install Oracle Utilities Analytics v2.7.0.0.x patchset directly on a Linux machine. It includes:

• Pre-requisite Software
• Before You Install
• Installing Oracle Utilities Analytics Database
• Installing Oracle Data Integrator Based ELT Component
• Installing Oracle Utilities Analytics Administration Component
• Installing Oracle Utilities Analytics Dashboards Component

Download the Oracle Utilities Analytics v2.7.0.0.x patchset package from My Oracle Support.

**Note:** The instructions in this chapter are applicable only while directly installing Oracle Utilities Analytics v2.7.0.0 Patchset 11 or higher. The assumption is that you have NOT installed v2.7.0 or any other patchset (earlier versions) in your environment. In case you have installed v2.7.0 or any 2.7.0.0.x patch set already, please refer to the **ReadMe** bundled along with the media pack for instructions on how to install the patchset.
Pre-requisite Software

Before you install Oracle Utilities Analytics, you are required to install the prerequisite software. Refer to the respective installation documentation of the software for download and installation instructions.

Note: Ensure that the same operating system user is used to install all software prerequisites and Oracle Utilities Analytics components.

Following is the list of prerequisite software required to install Oracle Utilities Analytics:

• Prerequisite Software for Oracle Utilities Analytics Database
• Prerequisite Software for Oracle Utilities Analytics Installer
• Prerequisite Software for Oracle Data Integrator Based ELT Component
• Prerequisite Software for Oracle Utilities Analytics Administration
• Prerequisite Software for Oracle Utilities Analytics Dashboards

Prerequisite Software for Oracle Utilities Analytics Database

The prerequisite software for the Oracle Utilities Analytics database component is as follows:

Oracle Database Server Enterprise Edition 12.1.0.2.0 - This Oracle Utilities Analytics release is supported on Oracle Database Server Standard Edition 12.1.0.1.0 when using ODI-based ELT component.

Prerequisite Software for Oracle Utilities Analytics Installer

The prerequisite software for Oracle Utilities Analytics Installer is JDK 1.8.0(77)+.

Prerequisite Software for Oracle Data Integrator Based ELT Component

Below is the prerequisite software for ODI-based ELT component of Oracle Utilities Analytics:

• JDK 1.8.0 (77)+
• Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard Edition 12.1.0.1.0
• Oracle Fusion Middleware Infrastructure and Oracle Data Integrator 12.2.1.3.0.

Note: These components can be downloaded separately.

• Oracle GoldenGate 12.2.0.1

Install Oracle GoldenGate on both source application as well target database servers. Download the latest version from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

Oracle GoldenGate Monitor 12.2.1.0.0 on both source application as well as target database servers. Download the latest version from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

• Oracle Utilities Analytics Administration

Prerequisite Software for Oracle Utilities Analytics Administration

The prerequisite software for Oracle Utilities Analytics Administration component is:

• Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard Edition 12.1.0.1.0
Prerequisite Software for Oracle Utilities Analytics Dashboards

The prerequisite software for Oracle Utilities Analytics dashboard component is:

- Oracle Fusion Middleware Infrastructure and Oracle Business Intelligence Enterprise Edition 12.2.1.4.0

Note: Download Oracle Fusion Middleware Infrastructure and Oracle Business Intelligence Enterprise Edition 12.2.1.4.0 separately.

Install the Oracle 12.1.0.2.0 client if OBIEE is not installed on the database server. If it is installed, then there is no need to install Oracle client. For installation instructions, refer to the Installing Oracle Utilities Analytics Dashboards Component section in Chapter 5: Installing Oracle Utilities Analytics - Initial Installation.

After installing OBIEE, save a snapshot of the last page of OBIEE installation that shows the details of BI Oracle Home, Instance Home, etc. These values are used during the Oracle Utilities Analytics installation.

Before You Install

Refer to My Oracle Support for up-to-date additional information about this Oracle Utilities Analytics release.

Installing Oracle Utilities Analytics Database

This section describes the steps to install Oracle Utilities Analytics Database on the database server, including:

- Installing Prerequisite Software
- Copying and Decompressing Install Media
- Creating the Database
- Creating Users and Tablespaces
- Installing RELADM Schema
- Installing MDADM Schema
- Installing DWADM Schema
- Configuring Spatial Data

Installing Prerequisite Software

The prerequisite software has to be installed before you begin the component installation. Refer to Pre-requisite Software for Oracle Utilities Analytics Database for details.

Copying and Decompressing Install Media

To copy and decompress install media:

1. Download Oracle Utilities Analytics v2.7.0.0 Patchset 12 from My Oracle Support.
2. Create a temporary directory.
For example: /OUA/temp for a Linux machine

This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. After successful installation, all files in this directory that are part of the installation can be deleted.

3. Unzip the Oracle Utilities Analytics patchset package to <TEMPDIR> using any zip utility.

Creating the Database

In an initial installation, it is recommended to use the Database Configuration Assistant (DBCA) utility to create the database.

**Note:** Refer to Oracle database documentation to know more about Database Configuration Assistant (DBCA).

Create the database with the following:

- Same character set as the source database character set
- Open cursor limit to 3000
- Processes to 1000

Creating Users and Tablespaces

To create the required users and tablespaces:

1. Create users in the database with the below names (without giving specific roles):
   - DWADM - Contains star schema objects (such as facts and dimensions) containing the data of the data warehouse.
   - DWUSER - User with read/write access to objects in DWADM schema.
   - DWREAD - User with read only access to objects in DWADM schema.
   - MDADM - A metadata schema consisting of database objects used for storing the Oracle Utilities Analytics metadata.
   - RELADM - A metadata schema consisting of database objects used to store the product version and component installation information.
   - OUA_MASTER - ODI Master repository schema
   - OUA_WORK - ODI Work repository schema
   - DWSTAGE - The staging schema of data warehouse.

2. Create roles with the following names:
   - DW_USER - Assigned to DWUSER. It contains all grants for read/write access to objects in the DWADM schema.
   - DW_READ - Assigned to DWREAD. It contains all grants for read only access to objects in the DWADM schema.
   - DW_PRIVS_ROLE - Assigned to MDADM. It contains the privileges necessary for the proper functioning of Oracle Utilities Analytics.
   - DW_REPLICATE - Assigned to various replication users that get created automatically during the source configuration. The privileges necessary for this role are automatically assigned by Oracle Utilities Analytics.

3. Connect to the database as **sys user**.
Installing Oracle Utilities Analytics Database

Execute Usersgrants.sql in <TEMPDIR>/OUA_2.7.0_Patchset/Application/ Usersgrants.sql. This SQL provides required grants to the users created in step 1.

The required users and tablespaces are created.

Installing RELADM Schema

The RELADM schema is a metadata schema consisting of database objects used to store the product version and component installation information.

This section describes initial installation of the RELADM schema, including:
• Reviewing Storage.xml File
• Installation Procedure
• Generating Database Statistics

Reviewing Storage.xml File

The storage.xml file (included in the package and is in <TEMPDIR>/OUA_2.7.0_Patchset/ Database/RELADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or RELADM user does not have quota on CISTS_01 tablespace, edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

Installation Procedure

To install the RELADM schema:

**Note:** This procedure prompts you for the password of RELADM user.
Ensure that OraDBI.jar (in the step below) is run using JDK Version 8.0.
Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In UNIX:

1. Add Java 8 to the path variable.

   For example:
   ```bash
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.

   ```bash
   export CLASSPATH=<TEMPDIR>/OUA_2.7.0_Patchset/Database/jarfiles/*
   ```

3. Navigate to <TEMPDIR>/OUA_2.7.0_Patchset/Database /RELADM/Install-Upgrade folder.

4. Execute OraDBI.jar.

   ```bash
   java com.oracle.ouaf.oem.install.OraDBI \
   -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE NAME>,
   RELADM, <Password of RELADM user>, , , , , RELADM \
   -j <JDK Home> -f <TEMPDIR>/OUA_2.7.0_Patchset/Database/jarfiles-v1 \
   -e true
   ```
The utility creates the RELADM schema and system data definitions. If an error occurs while executing a SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect to the database as `sys user` and execute the following command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
```

**Installing MDADM Schema**

The MDADM schema is a metadata schema that consists of the database objects used for storing the Oracle Utilities Analytics metadata.

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including:
- Reviewing Storage.xml
- Installation Procedure
- Generating Database Statistics

**Reviewing Storage.xml**
The `storage.xml` file (included in the package located at `<TEMPDIR>/OUA_2.7.0_Patchset/Database/MDADM/Install-Upgrade`) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or MDADM user does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the correct tablespace name on which MDADM has quota.

**Installation Procedure**
To install the MDADM schema:

**Note:** This procedure prompts you for the password of MDADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In UNIX:

1. Add Java 8 to the path variable. For example:

   ```
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.

   ```
   export CLASSPATH=<TEMPDIR>/OUA_2.7.0_Patchset/Database/jarfiles/*
   ```

3. Navigate to the `<TEMPDIR>/OUA_2.7.0_Patchset/Database/MDADM/Install-Upgrade` folder.
4. Execute OraDBI.jar.

    java com.oracle.ouaf.oem.install.OraDBI \
    -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE 
    SERVICE NAME>,\ 
    MDADM,<Password of MDADM user>,,,,,MDADM \ 
    -j <JDK Home> -f <TEMPDIR>/OUA_2.7.0_Patchset/Database/jarfiles -v 
    1 -e true

The utility creates the MDADM schema and system data definitions. If an error occurs while 
executing a SQL or another utility, it logs and displays the error message and allows you to re- 
execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the database as sys user and execute the following command:

    execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Installing DWADM Schema
The DWADM schema contains star schema objects (such as facts and dimensions) that contain 
the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

- Reviewing Storage.xml
- Installation Procedure
- Generating Database Statistics

Reviewing Storage.xml
The storage.xml file (included in the package located at <TEMPDIR>/OUA_2.7.0_Patchset/ 
Database/DWADM/Install-Upgrade) allocates all the base tables and indexes to the default 
tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be 
reflected in the storage.xml file by changing the tablespace name from the default value to a 
custom value.

    Note: If the database does not have CISTS_01 tablespace or DWADM user 
does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the 
correct tablespace name on which DWADM has quota.

Installation Procedure
To install the DWADM schema:

    Note: This procedure prompts you for the password of DWADM user. Ensure 
that OraDBI.jar (in the step below) is run using JDK Version 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special 
characters and extra spaces. If any, delete them and enter the respective 
characters manually. This helps to avoid any errors at run time.

In UNIX:
1. Add Java 8 to the path variable. For example:

    export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   
   ```bash
   export <TEMPDIR>/OUA_2.7.0_Patchset/Database/jarfiles/*
   ```

3. Navigate to the `<TEMPDIR>/OUA_2.7.0_Patchset/Database/DWADM/Install-Upgrade` folder.

4. Run OraDBI.jar.
   
   ```java
   java com.oracle.ouaf.oem.install.OraDBI \
   -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE NAME>,\ 
   DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM \
   -j <JDK Home> -f <TEMPDIR>/OUA_2.7.0_Patchset/Database/jarfiles -v 1 -e true
   ```

   The utility creates the DWADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the data as `sys user` and execute the following command:

```sql
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

**Configuring Spatial Data**

Refer to Chapter 9: Configuring Spatial Data for details about spatial configuration.

**Installing Oracle Data Integrator Based ELT Component**

This section describes the installation procedure of Oracle Data Integrator based ELT component. It includes:

- Installing Pre-requisite Software
- Setting up Oracle GoldenGate
- Copying and Decompressing Install Media
- Starting the Installer
- Installation Steps
- Creating a Database Directory
- Creating WebLogic Domain for Oracle Data Integrator Agent
- Starting the WebLogic Admin Server
- Starting the Managed Server (ODI_server1)
Installing Pre-requisite Software

The Oracle Data Integrator based ELT component is installed on the Oracle Utilities Analytics application server. Refer to Deployment for information about deploying Oracle Utilities Analytics.

To proceed with installing the ELT component, ensure the following are taken care:

- The operating system user that is used to install all the related software is used to install the ELT component also.
- Set up the source applications with required configurations before proceeding with the ELT component installation. This enables to successfully extract data from them into Oracle Utilities Analytics.
- Verify that the prerequisite software mentioned in Pre-requisite Software for Oracle Data Integrator Based ELT Component are installed.
- While installing Oracle Data Integrator 12.2.1.3, select Enterprise Installation as the installation type.
- While running RCU for Oracle Data Integrator 12.2.1.3, on the Select Components page, un-check the Oracle Data Integrator check box.

Note: If the source used is Oracle Utilities Network Management System v2.4.0.0, upgrade Oracle GoldenGate to v12.3 in both source and target applications.

Setting up Oracle GoldenGate

This section describes setting up Oracle GoldenGate to work with Oracle Utilities Analytics.

- Setting up Oracle GoldenGate on Source Database Server
- Setting up Oracle GoldenGate on Target Database Server
- Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers
- Recommended Oracle GoldenGate Parameter Settings

Setting up Oracle GoldenGate on Source Database Server

To set up each source instance, follow these steps:

1. Create a directory on the source database server and install Oracle GoldenGate there. It will be Oracle GoldenGate home (OGG_Home) on the source database server.

   For example: <path>/GoldenGate Home

   Note: Make a note of this directory path; it is used in the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate.

   Download Oracle GoldenGate 12.2.0.1.0 from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

   For installation instructions, refer to the respective installation documentation at http://docs.oracle.com/goldengate/c1221/gg-winux/index.html.

3. Provide the Oracle GoldenGate Home location as the directory location created in step 1.

4. Open a command terminal/window and set the source ORACLE_SID and ORACLE_HOME variables.
5. Set LD_LIBRARY_PATH.
   In Unix:
   ```bash
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

6. In the Command window, change the directory to Oracle GoldenGate Home directory, and then execute the following command.
   In Unix:
   ```bash
   ./ggsci
   ```
   The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order they are listed:
   - `create SUBDIRS`
   - `start mgr`
     This command starts the Oracle GoldenGate manager process.
   - `info all`
     This command verifies if the manager process is running.
   - `exit`
     This command exits Oracle GoldenGate.

8. Ensure that the source database is in the `archivelog` mode.

9. Connect to the source database as the `sys user` and execute the statements shown below:
   ```sql
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.

11. Open the `GLOBALS` file in the directory and add the following command:
    ```bash
    EnableMonitoring
    ```

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

13. Connect to the database as `sys user` using SQL*Plus.
    Ensure OGG_Home to be the current directory while invoking SQL*Plus.

14. Create a new user.
    For example: ODM01SRC
    This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is not assigned to any other user.
    **Note:** Ensure to note down the GoldenGate Owner Username; it will be used in the Oracle Utilities Analytics installation.

15. Connect to the source database with `sys user`.

16. Execute the following commands:
    ```sql
    Note: Ensure to modify the GoldenGate owner placeholder with actual name of the database user created in step 14.
    ```
grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
grant unlimited tablespace to <GoldenGate owner> with admin option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>', 'capture');
grant unlimited tablespace to <GoldenGate Owner> with admin option;
Revoke dba from <GoldenGate Owner>;
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;

17. Connect to the <source application>ADM schema (such as CISADM). Execute the following commands:

For Oracle Utilities Customer Care and Billing source database, execute the following grants:
Grant select on F1_MST_CONFIG to <GoldenGate owner user created in step 16>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in step 16>
Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in step 16>
Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created in step 16>

For Oracle Utilities Operational Device Management source database, execute the following grants:
Grant select on F1_MST_CONFIG to <GoldenGate owner user created in step 16>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in step 16>

For Oracle Utilities Meter Data Management source database, execute the following grants:
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;

For Oracle Utilities Work and Asset Management source database, execute the following grants:
Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

Note: While executing SQL commands in steps 15, 16, and 17, provide the GoldenGate owner user (if prompted for).
All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the database as **sys** user.

18. Execute the following commands in the order listed:
   
   ```
   @marker_setup.sql
   @ddl_setup.sql
   @role_setup.sql
   ```


20. In the Command window, create a directory “diroby” in the OGG_Home directory.

21. Change directory to the Oracle GoldenGate Home directory, and execute the following:
   
   
   b. Steps in Generating Shared Secret Password.

   **Note:** Execute these steps before running the Oracle Utilities Analytics installer. See [http://docs.oracle.com/goldengate/c1221/gg-winux/index.html](http://docs.oracle.com/goldengate/c1221/gg-winux/index.html) for more details.

### Configuring Encrypting Data Using ENCKEYS Method

To configure for encrypting data with the ENCKEYS method:

1. Execute the following command:

   ```
   cd <OGG_HOME>
   keygen <encryption key length (in bits) > [number of keys to generate]
   ```

   The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

3. Repeat the step above for each key values generated.

4. Save the file with name ‘ENCKEYS’ (upper case only) without any extension.

   **Example:**
   
   ```
   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035DD6893205A7BD6773FA8E670
   ```

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

6. Input the Logical name, space and key value generated.

   **Sample content of the ENCKEYS file:**
   
   ```
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ```

7. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

   **Note:** It is recommended to provide a logical key name after `<context_code>KEY`.

   For example: If context code is CCB1, it is recommended to name it as CCB1KEY.
Generating Shared Secret Password

To generate the shared secret password:

1. Execute the following command:
   
   `cd <OGG_HOME>
   ggsci
   ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>`

   Example:
   
   `cd $OGG_HOME
   ./ggsci
   GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
   Encrypted password:
   AADAAAAAAAAAAAIAVGNHBFGLGFCHBTVBFHUEJGNCFAOAFEOFBALELISFOIFWGRB
   ZHCCMCYGYBDA2H
   Algorithm used: AES128`

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and the generated encrypted password.

Setting up Oracle GoldenGate on Target Database Server

To set up Oracle GoldenGate on the target database server:

1. Create a directory on the target database server.

   For example: `../GoldenGateHome`

   Oracle GoldenGate should be installed in this directory. It is **Oracle GoldenGate Home (OGG_Home)** on the target Oracle Utilities Analytics database server.

   **Note:** Ensure to note down the directory location; it will be used in the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables. Set LD_LIBRARY_PATH.

   In UNIX:
   
   `export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH`

4. In the Command window, change the directory to **GoldenGate Home** and execute the following command:

   In UNIX:
   
   `./ggsci`

   The Oracle GoldenGate prompt is shown.

5. At the prompt, execute the following commands:

   `create SUBDIRS
   start mgr
   info all
   exit`

6. Create a directory “diroby” in the OGG_Home directory.
7. Connect to the target database as **sys user** and execute the following command:
   ```
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```
8. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.
9. Edit the GLOBALS file in the `<GG home>` directory and add the following command:
   ```
   EnableMonitoring
   ```
10. Navigate to the Oracle GoldenGate home (OGG_Home) directory.
11. If the ENCKEYS file does not exist, follow these steps:
    a. Create and open a new ASCII ENCKEYS file.
    b. Add the key value/values that are generated on the sources to the ENCKEYS file in target OGG home. This is done for the context codes for which source is configured.
       A sample ENCKEYS file in target OGG home is as below:
       ```
       CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
       ```

### Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

Set up Oracle GoldenGate Monitor (OGG) JAgent on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers. The OGG Monitor JAgent is used to automatically copy the generated OGG scripts to both source and target GoldenGate Home directories, and to start the extract and replicate processes on source and target.

To setup OGG Monitor JAgent on both target and source database servers:

1. Ensure Oracle GoldenGate is installed and Manager is running.
2. Start the rmiregistry services.
   ```
   rmiregistry 5559 &
   ```
   Ensure to note down the port on which RMI server is started. The port number specified here is 5559. If it is not specified, the default port 1099 will be used.
3. Install Fusion Middleware Infrastructure.
4. Run the OGG Monitor 12.2.1 installer.
   a. Set Oracle Home to the location where Fusion Middleware Infrastructure was installed in step 2.
   b. Choose installation type as OGG Monitor Agent.
5. Edit the Config.properties file in the `<OGG Monitor home>/oggmon/ogg_agent/ cfg_templates` and add/modify the below parameters.
   ```
   <ACTUAL>   : jagent.host=localhost
   <CHANGE TO> : jagent.host=<<actual hostname on which OGG is installed>>
   
   <ACTUAL>   : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started
   ```
6. Add the following parameter:

```
jagent.ssl=false
```

7. Navigate to `<OGG Monitor home>/oggmon/ogg_agent` directory and run the following command:

In UNIX:

```
export JAVA_HOME=<JDK home>
./createMonitorAgentInstance.sh
```

a. You will be prompted to enter:

- Oracle GoldenGate home directory.
- Path to be used for Oracle GoldenGate Monitor Agent instance.

   It is recommended to provide a path (such as `<OGG Monitor home>/Agents/OGGMonitorInstance`).

- A unique name to replace the timestamp in the name of the file used to start GG Monitor agent instance.

   Provide a unique name to be used for this Oracle GoldenGate Monitor instance.

b. Execute the command below from `<path used for Oracle GoldenGate Monitor instance provided in the step above>/bin`.

   Example location: `<OGG Monitor home>/Agents/OGGMonitorInstance/bin`

In UNIX:

```
export JAVA_HOME=<JDK home>
./pw_agent_util.sh -jagentonly
```

8. Enter the Oracle wallet password.

This password has to be entered as the password for the JAGENT while running the installer (for target gg), and while running the source configuration (for source gg).

Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is required in subsequent installation.

9. Create a folder with the Context_code name in `<GG Home>/dirdat`.

   For example: If WAM2 is created for the WAM source, then create a folder with name “WAM2” within the `<GG Home>/dirdat/` folder.

10. Create a folder with name `<GG Home>/diroby`.


   Replace COMMAND java with COMMAND `<JDK Home>/bin/java`.

   This ensures that the correct version of java (1.8) is used while starting JAgent.
12. Navigate to OGG_Home directory and go to the GoldenGate prompt:
   ggsci

13. Start the jAgent process using the following command:
   start jagent

   The logs for JAgent are created at the following (example) location.
   <OGG Monitor home>/Agents/OGGMonitorInstance/logs

**Recommended Oracle GoldenGate Parameter Settings**

The recommended Oracle GoldenGate parameter settings are as follows:

1. Update the source `<Source GG Home>/dirprm/mgr.prm` file.
   ```
   AUTORESTART EXTRACT <Context Code>*, RETRIES 5, WAITMINUTES 2,
   RESETMINUTES 60
   PURGEOLDEXTRACTS dirdat/<Context Code>/*, USECHECKPOINTS,
   MINKEEPHOURS 4
   DOWNCRITICAL
   ```

2. Update the Target `<Target GG Home>/dirprm/mgr.prm` file with the following:
   ```
   AUTORESTART REPLICAT <Context Code>*, RETRIES 5, WAITMINUTES 2,
   RESETMINUTES 60
   PURGEOLDEXTRACTS dirdat/<Context Code>/*, USECHECKPOINTS,
   MINKEEPHOURS 4
   DOWNCRITICAL
   ```

3. Restart the mgr process after the changes mentioned above are complete.

   The following parameters are optional and depend on the level of alerts required for the environment.

   For Oracle Utilities Network Management System sources:
   - DOWNREPORTMINUTES 2 - Report any downtime more than 2 minutes
   - LAGCRITICALMINUTES 2 - Report any lag > 2 minutes as critical
   - LAGINFOSECONDS 30 - Report any lag > 30 seconds as warning
   - LAGREPORTMINUTES 1 - Log lag information every minute

   For other sources:
   - DOWNREPORTMINUTES 10 - Report any downtime more than 10 minutes
   - LAGCRITICALMINUTES 10 - Report any lag > 10 minutes as critical
   - LAGINFORMINUTES 5 - Report any lag > 5 seconds as warning
   - LAGREPORTMINUTES 5 - Log lag information every 5 minutes

**Copying and Decompressing Install Media**

To download and decompress the install media, perform these steps:

2. Create a temporary directory, such as /OUA/temp (referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics Patchset package to <TEMPDIR>.

Starting the Installer

Important! In an AIX operating system, set the following environment variable before starting the Oracle Utilities Analytics installation.

```bash
export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m -XX:MaxPermSize=3200m"
```

To start the Oracle Data Integrator Based ELT component:

1. Go to the temporary folder containing the installer.

2. Run the following command from this folder:

   ```bash
   java -jar <TEMPDIR>/OUA_2.7.0.0.<PS number>_generic.jar -logLevel finest
   ```

   Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

   The Welcome page appears.

3. Review this information before you begin the installation. Click Next to continue with the installation.

4. Complete the tasks on the navigation pane.

   Each item in the navigation pane represents a specific installer screen that prompts you for information required to install the software.

   - If you select Oracle Data Integrator Based ETL as an Installation Type, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - Oracle Data Integrator Home and Schema Details
     - Oracle Data Integrator Agent and Repository Details
     - Target GoldenGate Details
     - Target JAgent Details
   
   - If you select Dashboard as an Installation Type, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - OBIEE Home Details
   
   - If you select both Oracle Data Integrator Based ETL and Dashboard as an Installation Type, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - Oracle Data Integrator Home and Schema Details
Installing Oracle Data Integrator Based ETL Component

• Oracle Data Integrator Agent and Repository Details
• Target GoldenGate Details
• Target JAgent Details
• OBIEE Home Details

Installation Steps

To install Oracle Data Integrator Based ETL:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears.

2. Review the information before you begin the installation. Click Next to continue with the installation.

   The Installation Location page appears.

3. Define the Installation Location and click Next.

   Note: The specified Oracle home directory must be an empty directory.

   The Select Installation Type page appears.

4. In the Select Installation Type page, select ODI Based ETL and click Next.

   Note: Based on the selected installation type, the options on the left navigation panel change.

5. Select Oracle Data Integrator Based ETL as an Installation Type. Define the following:
   • Database and Java Home Details
   • Target Database Connection Details
   • Oracle Data Integrator Home and Schema Details
   • Oracle Data Integrator Agent and Repository Details
   • Target GoldenGate Details

6. On the Database and Java Home Details page, enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>Database client home location</td>
<td>Example: /u01/app/product/12.1.0/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>JDK home location</td>
<td>Provide location of JDK 1.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.8.0_77</td>
</tr>
</tbody>
</table>

7. On the Target Database Connection Details page, enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Host name of the server</td>
<td>Oracle Utilities Analytics</td>
</tr>
<tr>
<td></td>
<td>where the database resides</td>
<td>Database Server</td>
</tr>
</tbody>
</table>
8. On **ODI Home and Schema Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Database port number on the database server used for connecting to the database</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>Password for the target schema (DWADM)</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Confirm Target Schema</td>
<td>Confirm password for the target schema (DWADM)</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>Password for the metadata schema (MDADM)</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Metadata Schema</td>
<td>Confirm password for the metadata (MDADM) schema</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>Directory where Oracle Data Integrator (ODI) is installed</td>
<td>Example: /u01/Middleware/Oracle_ODI1</td>
</tr>
<tr>
<td>Supervisor User</td>
<td>Name of the Oracle Data Integrator Supervisor</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>Password of the Oracle Data Integrator Supervisor</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm password of the Supervisor</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>Password of the master repository schema</td>
<td>OUA_MASTER user's password</td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm password of the Oracle Data Integrator master repository schema</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>Work repository schema password</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm password of Oracle Data Integrator work repository schema</td>
<td></td>
</tr>
</tbody>
</table>
9. On the **ODI Agent and Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Agent Host</td>
<td>Host where Oracle Data Integrator WebLogic Domain is created</td>
<td>Oracle Data Integrator Server host name.</td>
</tr>
<tr>
<td>ODI Agent Port</td>
<td>Port on which Oracle Data Integrator WebLogic agent is configured to run.</td>
<td>Provide available port and ensure to use the same port while creating Oracle Data Integrator managed server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is the Oracle Data Integrator WebLogic Managed Server port.</td>
</tr>
</tbody>
</table>

10. On the **Target GoldenGate Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>Oracle GoldenGate Manager host</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>Location where Oracle GoldenGate is installed</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Target Database Home</td>
<td>Location where database home is installed on the target database server.</td>
<td>If GoldenGate for target is not installed on the Oracle Utilities Analytics database server, provide oracle client home location on the server on which GoldenGate is installed.</td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the GoldenGate host.</td>
<td>The default value is 7830.</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>The algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>The Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
</tbody>
</table>
11. On the **Target JAgent Details** page, enter the target server JAgent details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Shared Secret</td>
<td>Shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: <code>encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT</code> Provide the result of above command as the value.</td>
</tr>
</tbody>
</table>

12. On the **Installation Summary** page, verify the installation options selected.

13. Click **Install** to begin the installation.

To change any configurations before starting the installation, use the navigation pane and select the topic to edit.

The **Installation Progress** page appears displaying the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The detailed logs of the installation are also available in the logs/system directory under the installation location.

To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

14. On the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

**Note:** To configure source, refer to the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.
Creating a Database Directory

Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each source database. This directory is used for logging the export import task used during the initial ELT load.

The following is a sample SQL that creates the database directory pointing to the file system path /scratch/file_data:

```sql
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
```

Configuring Oracle Data Integrator Repository Creation Utility (RCU)

To configure the Oracle Data Integrator Repository Creation Utility, follow these steps:

1. Ensure RCU for ODI is run and the required schemas are created in the target database.
   - ODI_ORACLE_HOME is an Oracle Home path used as Oracle Home while installing FMW Infrastructure and Oracle Data Integrator (ODI).
2. Set or export JAVA_HOME variable to the 1.8.0_77+ installed directory.
3. Go to $ODI_ORACLE_HOME/oracle_common/bin.
4. Execute the RCU utility.
   - For example:
     ```bash
     export JAVA_HOME=/scratch/bi_oradata_01/jdk1.8.0_77
cd /scratch/bi_oradata_01/Middleware_ODI_12.2.1_EE/Oracle_Home/oracle_common/bin
./rcu
     ```
5. In the Repository Creation Utility, select Create Repository > System Load and Product Load option.
6. On the page, provide the database connection details.
7. On the Select Components page, the options are shown as below. De-select the Oracle Data Integrator component.
8. In the next page, make a note of or remember the password given. It will be required while creating the Oracle Data Integrator domain.

   Note that a new script to create the ODI domain is described in the Creating WebLogic Domain for Oracle Data Integrator Agent section. This utility assumes that the same password is used for all RCU schemas. The assumption was made to keep the inputs to the domain creation script simple.

   It is not required to create the Oracle Data Integrator domain at this stage. It should be done after running the Oracle Utilities Analytics installer and before running source configuration tool.

Creating WebLogic Domain for Oracle Data Integrator Agent

Create the WebLogic Domain to bring up the WebLogic Agent (ODI Agent) to complete the steps. In this product release, ODI Domain creation is automated, and creation of both clustered and non-clustered domain is supported.

- Creating a Non-Clustered Domain
- Creating a Clustered Domain

   Note: The following procedures assume that the pre-requisite Java 8/bin is in the PATH variable.

Creating a Non-Clustered Domain

To create a non-clustered domain:

   Note: The password fields’ values (RCUSCHEMAPWD,WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN_PATH</td>
<td>For example: C:/odi12.2.1.3/odi12.2.1.3_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI,DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
</tbody>
</table>
2. Navigate to the `<OUA Environment>/bin` directory and invoke the `createDomain.sh` script.

Refer to the Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) sections to start the Admin server and Managed server.

Creating a Clustered Domain

To create a clustered domain, follow the steps below:

**Note:** The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the `<OUA Environment>/etc` directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td>ODI_DOMAIN_HOSTNAME</td>
<td>Host name on which the ODI domain is created</td>
</tr>
<tr>
<td></td>
<td>Optional fields</td>
</tr>
<tr>
<td>NONSSL_PORT</td>
<td>If not specified, default port 7001 will be assigned.</td>
</tr>
<tr>
<td>MANAGED_SERVER_PORT</td>
<td>If not specified, default port 15101 will be assigned.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROPERTY</td>
<td>For example: C:/odi12.2.1.3/odi12.2.1.3_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI_DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
</tbody>
</table>
2. Navigate to the <OUA Environment>/bin directory and invoke the **createDomain.sh** script.

This creates an ODI domain with an Admin server and a Managed server (as ‘ODI_server1’) and assigned to the cluster.

Refer to the **Starting the WebLogic Admin Server** and **Starting the Managed Server (ODI_server1)** sections to start the Admin server and Managed server.

To create another managed server and add it to the cluster:

1. Bring up the Admin server.
2. Navigate to the <OUA Environment>/etc directory and provide the following mandatory properties in the ODI_CONFIG.properties file:
   - MANAGED_SERVER_NAME
   - MANAGED_SERVER_PORT
3. Provide the following optional properties in the ODI_CONFIG.properties file:
   - MACHINE_NAME
   - MACHINE_PORT

A new managed server is created with the specified name and assigned to the cluster.

Refer to the sections **Starting the WebLogic Admin Server** and **Starting the Managed Server (ODI_server1)** to start the Admin server and Managed server.

### Starting the WebLogic Admin Server

To start the WebLogic Admin server, perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home.

   `<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin`

2. Execute the `startweblogic` command:

   In UNIX:

   ```bash
   nohup ./startWebLogic.sh > startWebLogic.log &
   ```

### Starting the Managed Server (ODI_server1)

To start the odi_server1 managed server:

2. Create `boot.properties` file. Enter the username and password in the respective fields in the file. Save the file.
Below is an example of the boot.properties file:

```
username=<weblogic username>
password=<weblogic password>
```

3. Change the directory to WLS Home to start odi_server1:

In UNIX:

```
<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin
nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
```

4. In the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent.

5. Right-click OracleDIAgent and click Test to test the connectivity of the configured Oracle Data Integrator Java EE agent.

---

**Installing Oracle Utilities Analytics Administration Component**

Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based configuration tool used to configure Oracle Utilities Analytics.

This section describes how to install the tool to configure Oracle Utilities Analytics and change the default password of the Admin user.

- Installation Steps
- Changing Default Password of the Admin User

**Note:** Install Oracle Utilities Analytics Administration component on the Oracle Utilities Analytics database server.

**Installation Steps**

To install the Oracle Utilities Analytics Administration Tool, follow these steps:

1. Download Apex 5.0.4 to the database server under the /temp directory. Then unzip the file.

   ```
cd /temp/apex
```

2. Connect to the Oracle Utilities Analytics database as the `sys user` and execute the following commands:

   ```
   @apxremov.sql
   @apxrtins <Tablespace name> <Tablespace name> <Temp Tablespace name> /i/
   @apxchpwd.sql
   ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
   ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
   @apex_rest_config.sql
   ```

   **Note:** Ensure to note down the passwords for APEX_Listener user and APEX_REST_PUBLIC_USER.

3. Import the tool to configure Oracle Data Integrator:

   a. Unzip the Oracle Utilities Analytics Patchset package zip file. The file includes the AdminTool folder inside Application folder.
b. Create the ./AdminTool directory on the database server and copy the contents of the AdminTool directory (from the zip file) to this directory.

c. Navigate to the ./AdminTool directory. (cd ./AdminTool).

d. Connect as the sys user and execute the following scripts:
   - To create workspace and configure the users:  @CreateAppWorkspace.sql
   - To import application:  @DeployAdminApp.sql
   - To deploy supporting objects:  @DeploySupportingObjects.sql

4. Download Apex 5.0.4 to the server where you want to set up the tool (under /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory).
   **Note:** Create /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory if it does not exist.

5. Download Oracle Rest Data service 3.0.6 to the server where you want to set up the Administration Tool (under /scratch/bi_oradata_01/Softwares/apex_listener directory).
   **Note:** Create /scratch/bi_oradata_01/Softwares/apex_listener directory if it does not exist.

6. Navigate to the scratch/bi_oradata_01/Softwares/apex_listener directory and unzip the ords zip file.
   cd scratch/bi_oradata_01/Softwares/apex_listener

7. Navigate to the cd /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory and unzip the apex_5.0.4_en.zip file.
   cd /scratch/bi_oradata_01/Softwares/apex_5.0.4

8. Create a directory on the server to configure Apex.
   For example: mkdir scratch/bi_oradata_01/apex_configuration

9. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listener directory:
   cd /scratch/bi_oradata_01/Softwares/apex_listener

10. Execute the following command:
    java -jar ords.war install advanced
    **Note:** Use JDK1.8 to execute the command.
Provide the necessary inputs as shown below:

```
11. Navigate to the `/scratch/bi_oradata_01/Softwares/apex_listener` directory:
    `cd /scratch/bi_oradata_01/Softwares/apex_listener`

12. Execute the following command:
    `java -jar ords.war static /scratch/bi_oradata_01/Softwares/apex_5.0.4/apex/images`

    **Note:** The command creates i.war file.

13. Create the WebLogic domain.
   a. Navigate to `<Middleware Home>/Weblogic_12.2.1_Home/oracle_common/common/bin`.
      `cd <Middleware Home>/Weblogic_12.2.1_Home/oracle_common/common/bin`
   b. Execute the following command:
      `./config.sh`

      The **Fusion Middleware Configuration Wizard** window appears.
```
a. Select **Create a new WebLogic domain** and click **Next**.

![Configuration Wizard]

b. Provide the domain name.

![Templates]

Ensure you do not change the domain location.

Click **Next**.
c. Provide the WebLogic User Password. Ensure you make a note of the password.

Click Next.

d. Select jdk1.8 and click Next.
e. Select the **Administration Server, Managed Servers, Clusters and Machines** options. Then, click **Next**.

f. Provide the **Listen Port** as available port. Click **Next**.
g. Click **Add** and provide values as shown below:

![Managed Servers Configuration](image1)

Click **Next**.

![Configure Clusters](image2)
i. On the Configure Machines page, click **Next**.

![Configure Machines](image1)

j. On the Configuration Summary page, click **Next**.

![Configuration Summary](image2)

14. Create the `boot.properties` file.

15. Start the Admin and Managed server.
16. Login to WebLogic console and click **Lock & Edit**.

![Lock & Edit](image1.png)

17. Click **Install**.

18. Enter the following path and then select the *ords.war* file.

   `/scratch/bi_oradata_01/Softwares/apex_listener`

![WebLogic console](image2.png)

Click **Next**.

![Application Assistant](image3.png)
19. Select the **apex server** check box and click **Next**.

![Image of Install Application Assistant with apex server selected]

20. Select the options as shown below:
21. Select the options as shown below:

22. Click **Activate Changes**.

23. Repeat the steps 13 to 20 to deploy the *i.war* file.

24. Login to the WebLogic console and navigate to **Deployment > Monitoring**.

25. Select *i* and *ords*. Then, click **Start > Servicing All Requests**.
26. Click Yes.

![Oracle WebLogic Server Administration Console](image.png)

27. Restart the Admin and Managed servers.

28. Go to the following URL to access the Administration Tool:

   http://<hostname>:<managed server port no>/ords/?p=104

   The credentials to access the tool are:

   User ID: Admin
   Password: Admin_123

### Changing Default Password of the Admin User

This section describes the APEX API used to change the password of the admin user. The script should be run after connecting to the database as user SYSTEM.

Replace the string 'New password' with the new password for the admin account before running the script.

```sql
begin
    wvv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_application_install.get_workspace_id,2090606133849294));
end;
/

begin
    apex_util.edit_user(    p_user_id => '2090514487849294',
    p_user_name => 'ADMIN',
    p_web_password => 'New password',
    p_new_password => 'New password')
end;
/
commit;
/

Note: It is strongly recommended to change the default password after logging in.
Installing Oracle Utilities Analytics Dashboards Component

**Important!** Ensure that the same Operating System (OS) user to install the prerequisite software is used to install the Oracle Utilities Analytics Dashboards component as well.

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics application server. This section describes how to install the dashboards component of Oracle Utilities Analytics.

- Creating and Configuring an OBIEE Domain
- Copying and Decompressing Install Media
- Starting the Installer
- Installation Steps
- Deploying the Repository (RPD) File
- Deploying Web Catalog
- Configuring and Deploying the MapViewer
- Updating MapViewer Configuration
- Enabling WriteBack
- Enabling Auto Complete Feature in OBIEE

## Creating and Configuring an OBIEE Domain

To create and configure an OBIEE domain, follow the steps below. This is a prerequisite to install the Oracle Utilities Analytics Dashboards component.

1. Run RCU to create the necessary schemas.
   a. Navigate to `<FMW infrastructure home>/oracle_common/bin`. Example location:
      ```sh
cd /u01/12.2.1.3_Infrastructure/oracle_common/bin
```
   b. Run below command and follow the instructions in the wizard:
      ```sh
      ./rcu
      ```
      **Note:** Select AS Common Schemas and Oracle Business Intelligence components in the **Select Components** panel.

2. Run the OBIEE configuration assistant to create an OBIEE domain.
   a. Navigate to `<FMW infrastructure home>/bi/bin`
      Example location:
      ```sh
cd /u01/12.2.1.3_Infrastructure/bi/bin
```
   b. Run below command and follow the instructions in the wizard:
      In UNIX:
      ```sh
      ./config.sh
      ```
   c. On the **Database Details** panel, choose “Use existing schemas” and provide connection details (prefix of the RCU run in step 1).
   d. On the **Initial Application** panel, select “Oracle sample application (SampleAppLite).”
      **Note:** Ensure the BI domain path, WebLogic user name and password are noted down. They should be provided as inputs when the Oracle Utilities Analytics Dashboards component installer is run.
3. After the successful creation of OBIEE domain, start the OBIEE Admin server.
4. Login into the Admin console.
   a. On the Environment tab, navigate to the coherence clusters.
   b. Click defaultCoherenceCluster and then select the Configuration tab.
      
      Ensure the port mentioned in the Cluster Listen Port field is not in use. If needed, change it to another port that is not in use.
   c. Click Save to save the port changes (if any).
   d. Start the OBIEE Managed server.
5. After starting the OBIEE domain services successfully, navigate to the <OBIEE domain>/config/fmwconfig directory.
   a. Open jps-config.xml.
   b. Under the <serviceInstance name="idstore.ldap" provider="idstore.ldap.provider"> element, add the property element as below:

   
   <property
   name="oracle.security.jps.ldap.policystore.refresh.interval"
   value="6000000"/>

   The OBIEE domain is successfully created and configured.

**Copying and Decompressing Install Media**

To download and decompress the install media, follow these steps:

2. Create a temporary directory, such as /OUA/temp (referred to <TEMPDIR> below).
3. This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.
4. Unzip Oracle Utilities Analytics Patchset package to <TEMPDIR>.

**Starting the Installer**

**Important!** In an AIX operating system, set the following environment variable before starting the Oracle Utilities Analytics installation.

```
export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m -XX:MaxPermSize=3200m"
```

To start the installer:

1. Navigate to the temporary folder where you downloaded the install. Run the following command from the folder:

   ```
java -jar <TEMPDIR>/OUA_2.7.0.0.<PS number>_generic.jar -logLevel finest
```

   **Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.
2. On the Welcome page, review the information before you begin the installation.
3. Click Next to continue with the installation.
4. Complete the installation by following the tasks on the navigation pane.

Each item in the navigation pane represents a specific installer screen that prompts you for the information required to install the software.

**Installation Steps**

To install the Dashboards component:

1. Run the Oracle Utilities Analytics Installer.
2. On the **Welcome** page, review the available information before you begin the installation.
3. Click **Next** to continue with the installation. The **Installation Location** page appears.
4. Define the **Installation Location** here and click **Next**. The Select Installation Type page appears.

   **Note**: The specified Oracle home directory must be an empty directory or a directory where the OUA ODI ETL 2.7.0 patchset component was installed successfully.

5. In the Select Installation Type page, select **Dashboards** and click **Next**.

   **Note**: Based on the selected installation type, the options on the left navigation panel change. When you select **Dashboard** as an **Installation Type**, you need to define Database and Java Home Details, Target Database Connection Details and OBIEE Home Details.

The **Database and Java Home Details** page appears.

6. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>Database client home location</td>
<td>Example: <code>/u01/app/product/12.1.0/dbhome_1</code></td>
</tr>
<tr>
<td>Java Home</td>
<td>JDK home location</td>
<td>JDK 1.8 location</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: <code>/u01/jdk_1.8.0_77</code></td>
</tr>
</tbody>
</table>

The **Target Database Connection Details** page appears.

7. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
</tbody>
</table>
The OBIEE Home Details page appears.

8. Enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

The OBIEE Home Details page appears.

8. Enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Home</td>
<td>The location on the disk where OBIEE is installed.</td>
<td>Example: /u01/Middleware/Oracle_BI1</td>
</tr>
<tr>
<td>BI Domain Home</td>
<td>The domain Home location under the directory where OBIEE is installed.</td>
<td>Example: /u01/Middleware/user_projects/domains/bifoundation_domain</td>
</tr>
<tr>
<td>Weblogic Host</td>
<td>The hostname on which WebLogic server for OBIEE is running.</td>
<td></td>
</tr>
<tr>
<td>Weblogic Port Number</td>
<td>A unique port number within the system that is assigned to the HTTP port.</td>
<td>Example: 7001</td>
</tr>
<tr>
<td>Weblogic User</td>
<td>WebLogic domain login user name.</td>
<td></td>
</tr>
</tbody>
</table>

Note: You will be prompted for the Weblogic user’s password after installation.

The Installation Summary page appears.

9. Verify the installation options and click Install to begin the installation.

For any changes to the configuration before starting the installation, use the navigation pane and select the topic to edit.

10. The Installation Progress page appears allowing you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.
To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and it needs to be deleted manually.

11. On the **Installation Completed** page, click **Finish** to close the installer.

The Dashboards component is now installed successfully.

**Deploying Web Catalog**

Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the location of the catalog.

To deploy the web catalog:

1. Go to the `<DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/root/shared` directory.

2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities Analytics in the previous release.

   Ensure any custom catalog related files in this directory are backed up in a separate location before running deployBar.sh.

   If Oracle Utilities Network Management System BI Publisher reports were deployed they should be retained.

3. Follow these steps:

   - In UNIX:
     a. Navigate to `<Install_Dir>/bin` directory.
        ```
        cd <Install_Dir>/bin
        ```
     b. Add Java 8 to the path variable as shown in example below:
        ```
        export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
        ```
     c. Run `ksh ./deployBAR.sh`.

   The web catalog is successfully deployed.

For an AIX operating system, after the deployBAR.sh is completed successfully, execute the following command:

```bash
cp -r ../../writeback/wbtemplates/* $DOMAIN_HOME/bidata/service_instances/ssi/metadata/content/msgdb/l_en/customMessages
```

**Deploying the Repository (RPD) File**

If no changes are made to the deployed RPD, then take the RPD file from the following location, where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory:

```
<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd
```

If it was merged, then take the merged RPD and make the required database changes. Copy this RPD file to the Windows machine on which OBIEE 12.2.1.4 is installed.

To deploy the RPD file:

1. Ensure OBIEE 12.2.1.4 is installed on the Windows machine before proceeding.
2. Click **Start > Programs > Oracle Business Intelligence > Administration.**
3. Click File > Open > Offline... to open the RPD in offline mode.
4. Provide the RPD password. The default password is “oracle123”.
5. Double-click the **Connection Pools** to edit them.

![RPD Diagram]

- **In the Init Block Connection Pool** group, enter the following:
  
  - Datasource name = BI Database name
  - User name = DWREAD
  - Password = DWREAD User password

- **In the Init Block Pool - MDM** group, provide the following (only for Oracle Utilities Meter Data Management):
  
  - Datasource name = MDM database name
  - User name = CISUSER
  - Password = CISUSER User password

- **In the Init Block Pool - NMS Replication** group, provide the following (only for Oracle Utilities Network Management System):
  
  - Datasource name = BI database name
  - User name = DWREAD
  - Password = DWREAD User password
  
  **Note:** The schema name is NMS1REP by default. Rename it if the replication schema name is different.

- **In the Materialized Views Connection** group, enter the following:
  
  - Datasource name = BI Database name
  - User name = DWREAD
  - Password = DWREAD User password

- **In the MDM Database Connection** group, provide the following (only for Oracle Utilities Meter Data Management):
  
  - Datasource name = MDM database name
User name = CISUSER
Password = CISUSER User password

- In the **NMS Replication Tables** group, provide the following (only for Oracle Utilities Network Management System):
  - Datasource name = BI database name
  - User name = DWREAD
  - Password = DWREAD User password

  **Note**: The default schema name is NMS1REP. If the replication schema name is different, then rename.

- In the **ODIDEV Connection Pool** group, provide the following:
  - Datasource name = BI database name
  - User name = DWUSER
  - Password = DWUSER User password

- In the **OUBI Database Connection** group, provide the following:
  - Datasource name = BI database name
  - User name = DWREAD
  - Password = DWREAD User password

6. Click **Save**.

  **Note**: Click **Yes** when you see the prompt 'Do you wish to check global consistency?' and ignore any warnings that appear after consistency check is complete.
7. Copy the modified RPD back to the `<install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd` where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory.

8. Login to the server where OBIEE Enterprise Manager is installed.


10. Run the following command to deploy the RPD:

    In Unix:
    ```
    datamodel.sh uploadrdp -I <OUA home>/Reports/rpd/
    UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -
P <Weblogic password of OBIEE domain> -SI ssi
    ```

11. Run the following commands from `<OBIEE DOMAIN>/bitools/bin` directory to stop and start the OBIEE domain services respectively.

    ```
    stop.sh
    start.sh
    ```

### Configuring and Deploying the MapViewer

Configuring and deploying the MapViewer involves the following tasks:

- Configuring the MapViewer
- Modifying instanceconfig.xml
- Updating MapViewer Configuration

#### Configuring the MapViewer

To configure the MapViewer:

1. Login to the WebLogic console.
2. Create the 'MAP_DS' datasource.
3. Lock and edit it.
4. Navigate to Services > Data Sources.
5. Select New > Generic Data Source and provide the following:
   ```
   Name = MAP_DS
   JNDI Name = MAP_DS
   Database Type = oracle
   ```
6. Click Next.
7. Enter the following:
   ```
   Database Driver = Oracle's Driver (Thin) for Service connections; Versions:Any
   ```
8. Click Next.
9. On the next page, do not change any values. Click Next.
10. Enter the following connection properties:
    ```
        Database Name: BI Database Name
        Host Name: Database host
        Port: Database port
    ```
Installing Oracle Utilities Analytics Dashboards Component

- Database User Name: dwadm
- Password: dwadm password

11. Click **Next**.

12. On the next page, click **Test Configuration**. After the successful test, click **Next** again.

13. On the **Select Target** page, select AdminServer under **Servers** and bi_cluster under **Clusters**. Click **Finish**.

14. Click **Activate Changes**.

15. Update the mapViewerConfig file with the tags mentioned below:

   File location: `<Install Dir>/user_projects/domains/<obiee_domain>/config/fmwconfig/mapviewer/conf`

   File: mapViewerConfig.xml

16. If there is a proxy used, insert the list of host names for all the third-party service providers in the security_config node.

   ```xml
   <proxy_enabled_hosts>elocation.oracle.com</proxy_enabled_hosts>
   ```

17. Add the following `ns_data_provider` node:

   ```xml
   <ns_data_provider id="obieeNsdp" class="com.oracle.utilities.birdseye.BirdseyeNSDP" />
   ```

18. Add the current `map_tile_server` with the following `map_tile_server` node:

   ```xml
   <map_tile_server>
   <tile_storage default_root_path="/mytilecache/"/>
   </map_tile_server>
   ```

**Modifying instanceconfig.xml**

Ensure you take a backup before updating the instanceconfig.xml file. Run the following commands to go to the directory containing the instanceconfig.xml file.

In UNIX:

   `<OBIEE_INSTALL_DIR>/user_projects/domains/<obiee_domain>/config/fmwconfig/biconfig/OBIPS`

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add the following code before `</Serverinstance>`:

   ```xml
   <Security>
   <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
   <HttpOnlyCookies>false</HttpOnlyCookies>
   <CookieDomain />
   <CookiePath>/</CookiePath>
   </Security>
   ```

2. Update the following `<ServerInstance>` element:

   ```xml
   <LightWriteback>true</LightWriteback>
   ```

3. Add the following code between the `<ServerInstance> </ServerInstance>` tags.

   ```xml
   <Prompts>
   <MaxDropDownValues>256</MaxDropDownValues>
   <AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
   <AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
   ```
Updating MapViewer Configuration

To update the MapViewer configuration:

1. Login to MapViewer.
   
   http://<Server>:<port>/mapviewer

2. To update the MapViewer configuration, navigate to MapViewer > Administration > Configuration. Login to the Mapviewer at this location:

   http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the below code in the mapViewerConfig.xml with the appropriate values:

   ```
<map_data_source name="mapconn"
    jdbc_host="<DB server name>"
    jdbc_sid="<DB Service name>"
    jdbc_port="1521"
    jdbc_user="DWADM"
    jdbc_password="<DWADM user password>"
    jdbc_mode="thin"
    number_of_mappers="32"
    allow_jdbc_theme_based_foi="true"
/>
```

4. Click Save, and then restart.

Enabling WriteBack

To enable the Write Back:

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack > Write Back to Database.

2. Click Denied:Authenticated User and select the Granted permission.

Enabling Auto Complete Feature in OBIEE

To enable the auto complete feature on OBIEE:

1. Restart the OBIEE Admin server, Managed server, and opmn services.

   Note: Refer to OBIEE documentation for detailed instructions on how to start and stop admin server, managed server, and opmn services.

2. Login to Analytics.

   http://<Server>:<port>/analytics

3. Click WebLogic User (top-most-right section of the page).

4. From the drop-down menu, select My Account.
5. On the Preferences tab, set Prompt Auto Complete to ON.
6. Click OK.
Chapter 6

Upgrading Oracle Utilities Analytics from v2.6.0.0.2

The Oracle Utilities Analytics v2.7.0 release supports the following direct upgrade paths:

- v2.6.0.0.2 to v2.7.0
- v2.5.0.0.5 to v2.7.0

This chapter is applicable only to customers upgrading from Oracle Utilities Analytics v2.6.0.0.2 to v2.7.0.

Note: To upgrade from Oracle Utilities Analytics v2.5.0.0.5, refer to Chapter 7: Upgrading Oracle Utilities Analytics from v2.5.0.0.5 for instructions and details.

To upgrade to Oracle Utilities Analytics v2.7.0, you must first upgrade to Oracle Utilities Analytics v2.6.0.0.2 or v2.5.0.0.5 if on an earlier version. Ensure all pre-requisites (JDK, ODI, and ODI patch 23629220) are met before beginning the upgrade process.

This chapter describes the procedure to upgrade to Oracle Utilities Analytics v2.7.0, including:

- Pre-requisites
- Upgrading Oracle Utilities Analytics Database Component
- Upgrading Oracle Data Integrator Based ELT Component
- Upgrading Oracle Utilities Analytics Administration Tool Component
- Upgrading Oracle Utilities Analytics Dashboards Component
Pre-requisites

Upgrading Oracle Utilities Analytics from v2.6.0.0.2 to v2.7.0 includes upgrading Oracle Data Integrator based source applications (Oracle Utilities Customer Care and Billing, Oracle Utilities Work and Asset Management, Oracle Utilities Network Management System, Oracle Utilities Mobile Workforce Management, and Oracle Utilities Meter Data Management).

This section describes the steps to configure Oracle Data Integrator based source applications.

Ensure the required JDK 1.8.0(77) and Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI) are installed on Oracle Data Integrator server. Also, the target OBIEE applications should be down.

Follow the steps below as part of prerequisites:

1. Before proceeding with source application configuration, perform the following steps:
   a. Connect to the Oracle Utilities Analytics database as sys user and grant the below privilege to the MDADM schema.
      SQL> GRANT CREATE ANY TABLE TO MDADM;
   b. Connect to MDADM schema in the Oracle Utilities Analytics database.
   c. Execute b1_redef_replication in BI270/Scripts/b1_redef_replication.sql.

      This SQL creates the procedure to sync DDL changes from the source to replication schemas.

      For example:
      SQL> @b1_redef_replication.sql
      /
      Procedure created.
      SQL> show errors;
      No errors.
      SQL>

2. Login to Oracle Utilities Analytics ODI server and start the ODI client.
   cd $ODI_HOME/odi/studio
   ./odi.sh

3. Stop BI_RUN_ALL. Follow these steps:
   a. Login to Oracle Database Integrator Studio.
   b. Double-click Global/WLS_AGENT and select Inactive.
   c. Save the changes.
4. On the Studio, navigate to the Topology tab. Right-click OracleDIAgent and select Upgrade Schedule.

5. Execute the following query to check if all jobs are complete.

Note that this is applicable if the source system is Oracle Utilities Customer Care Billing, Oracle Utilities Operational Device Management, or Oracle Utilities Network Management System.

```
SELECT *
FROM mdadm.bl_jobs_vw
WHERE status_flg NOT IN ('D', 'E', 'RP');
```

**Note:** No rows should be returned from the query mentioned above. If any rows are returned, that means jobs are not yet completed. Wait until all the jobs are completed.

6. Stop the Oracle Data Integrator admin and managed servers.

7. Sync all the Oracle GoldenGate processes.
   a. Connect to MDADM schema in the Oracle Utilities Analytics database.
   b. Execute the SQL mentioned below to get all the context codes.
      
      ```
      Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';
      ```
   c. For each context returned by the query, perform the following steps.
      a. Connect to the source database corresponding to the context code as `sys user`.
      b. Execute the following command:
         ```
         alter system switch logfile
         select SEQUENCE# from v$Log where STATUS='CURRENT';
         ```
      c. Note the result of the above query.
      d. Connect to MDADM schema in the Oracle Utilities Analytics database.
Pre-requisites

Upgrading Oracle Utilities Analytics from v2.6.0.0.2

6-4
Oracle Utilities Analytics Installation Guide

e. Execute the SQL mentioned below to get source GoldenGate server and Oracle
GoldenGate Home on source server.

```sql
select DS_HOST, DS_HOME from bl_server_cfg where CONTEXT_CD='"Context_code"'
```

e. Connect to the source GoldenGate server.
g. At the source Oracle GoldenGate prompt, run the following:

```bash
cd <GG_Home>
./ggsci
```
h. Run the following command:

```
info extract <Context_codeXXX>,showch
```

For example: `info extract CCBiAAx,showch`

In the **Recovery Checkpoint** section, sequence should be = or > 1 returned by:

```
select SEQUENCE# from v$Log where STATUS='CURRENT'
```

Repeat the check mentioned in the step b for each extract process.
i. Ensure that the pump processes transfer all the changes to the target server. Lag at the
**Chkpt** and **Time Since Chkpt** should be 0.
j. On the Oracle Utilities Analytics database server, ensure the replicate processes apply all changes for the context code.

- Connect to the MDADM schema in Oracle Utilities Analytics database and execute the query below to get the target server and GoldenGate Home details on the target server.

```
select DS_HOST, DS_HOME, DS_FLAG from bl_server_cfg where CONTEXT_CD='B1';
```

- Connect to the target server and login to the GoldenGate prompt. Execute the following commands:

```bash
cd <GG_Home >
./ggsci
dblogin userid MDADM, password <MDADM user password> Send replicat <Context_codeXX>,status
```

The current status will be at EOF.
k. Check this for each 'replicat' process of the context code.
l. Ensure all extracts and replicates of all sources are in sync.
m. Stop replicate processes in the target server. Go to `<Target_GG_HOMe>/dirprm` directory and modify `<CONTEXT>AA.prm` file with modifications as below.

Existing entry:

```
,EXCLUDE INSTR 'PRIMARY' &
,EXCLUDE INSTR 'UNIQUE' &
```

Modified entry:

```
,EXCLUDE INSTRWORDS 'PRIMARY KEY' &
---,EXCLUDE INSTR 'UNIQUE' &
```

Repeat these steps for all other 'replicat' parameter files.
Upgrading Source Applications to be Compatible with Oracle Utilities Analytics v2.7.0

The source applications’ databases must be in archive log mode during their upgrade. Oracle GoldenGate processes should be up and running on both source and target during the source application(s) upgrade.

**Note:** After a successful upgrade, do not release the source applications to end users. Ensure to stop the source applications, but the source databases should be up and accessible.

1. Login to the Oracle Utilities Analytics GoldenGate server.
2. Go to GoldenGate Home and execute the shell script `restart.sh` from BI270/Scripts/
   
   This shell script starts the replicate processes that are stopped due to DDL changes in source system. Once all the DDL changes are in sync to replication schema, the shell script is automatically terminated.

   Monitor `restart.sh` execution. Proceed with next steps only when the `restart.sh` execution is complete.

3. Validate if all columns are in sync.
4. Connect to the MDADM schema in the Oracle Utilities Analytics database.
5. Execute the below query. It should not return any records.

   ```sql
   select TABLE_NAME, COLUMN_NAME
   from DBA_TAB_COLUMNS@<CONTEXT_CODE>_LINK DTC
   where OWNER = 'SOURCE_APPLICATION_SCHEMA'
   and exists (select 1
               from MDADM.B1_REPLICATION_CFG VW a
               where a.TABLE_NAME = DTC.TABLE_NAME
               and CONTEXT_CD = '<CONTEXT_CODE>'
               and (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
   MINUS
   select TABLE_NAME, COLUMN_NAME
   from DBA_TAB_COLUMNS
   where OWNER = '<CONTEXTCODE>REP'
   and COLUMN_NAME not like 'JRN%';
   ```

   Example: The following is an example query for NMS1 context.

   ```sql
   select TABLE_NAME, COLUMN_NAME
   from DBA_TAB_COLUMNS@NMS1_LINK DTC
   where OWNER = 'CISADM'
   and exists (select 1
               from MDADM.B1_REPLICATION_CFG VW a
               where a.TABLE_NAME = DTC.TABLE_NAME
               and CONTEXT_CD = 'NMS1'
               and (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
   MINUS
   select TABLE_NAME, COLUMN_NAME
   from DBA_TAB_COLUMNS
   where OWNER = 'NMS1REP'
   and COLUMN_NAME not like 'JRN%';
   ```

   Perform the following steps to cleanup the Oracle GoldenGate processes:

1. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the SQL below to get all the context codes.

   ```sql
   select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';
   ```
2. For each context returned by the query, perform the following steps:
   a. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the SQL below to get the source GoldenGate db server, SID and Oracle GoldenGate host, home on source server:

   ```sql
   SELECT DS_HOST, DS_SID, DS_HOME, CONTEXT_CD, DS_FLAG FROM b1_server_cfg WHERE CONTEXT_CD='<Context_code>'
   ```

   b. Connect to the source database corresponding to context code as `sys user` and execute the following command:

   ```sql
   alter system switch logfile
   select SEQUENCE# from v$Log where STATUS='CURRENT';
   ```

   c. Note down the result of the query mentioned above.

   d. Connect to the source GoldenGate server and log into the source Oracle GoldenGate prompt.

   ```bash
   cd <GG_Home>
   ./ggsci
   ```

   e. Execute the following command:

   ```bash
   info extract <Context_codeXXX>,showch
   ```

   For example:

   ```bash
   info extract CCB1AAAX,showch
   ```

   In the Recovery Checkpoint section, the sequence should be = or > 1 returned by the query below:

   ```sql
   select SEQUENCE# from v$Log where STATUS='CURRENT'
   ```

   Repeat the check mentioned in the step e for each extract process.

   f. Ensure that the pump processes transfer all the changes to the target server. Lag at the Chkpt and Time Since Chkpt should be zero.

   g. On the source database server, drop all the GoldenGate processes by following these steps:

   a. Connect to MDADM schema in the Oracle Utilities Analytics database.

   b. Execute the following query to get GoldenGate Owner name in the source database.

   ```sql
   select SCHEMA_NAME FROM MDADM.B1_CONTEXT_CFG_VW WHERE LSCHEMA_NAME = 'Journal' AND CONTEXT_CD = '<Context_code>'
   ```

   c. Login to source GoldenGate prompt.

   ```bash
   cd <GG_Home>
   ./ggsci
   ```

   d. Execute the following commands:

   ```bash
   dblogin userid < GoldenGate Owner >,PASSWORD < GoldenGate Owner password>
   stop <Context_code>*
   ```

   For example:

   ```bash
   stop CCB1*
Pre-requisites

Upgrading Oracle Utilities Analytics from v2.6.0.0.2

6-7

Oracle Utilities Analytics Installation Guide

delete <Context_code>*
delete CCB1*
Stop mgr

Execute the below commands to unregister extracts from database:
unregister extract <Context_code>*X database

For example:
unregister extract CCB1AAX database

Similarly, unregister all model extracts.

Note: Note down the source Oracle GoldenGate context_codes of each source and source Oracle GoldenGate Owner info. They will be used to configure the existing sources with same context during the upgrade.

h. Connect as a sys user to the source database server. Execute the following command:
<GG_Home>/ddl_disable.sql

i. Rename the existing source Oracle GoldenGate Home on the source server.

Note the GoldenGate manager port number and source GoldenGate home before renaming it.

For example: mv <GG_Home> <GG_Home>.bkp

j. On the Oracle Utilities Analytics database server, ensure the replicate processes apply all changes for the context code.

a. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the below query to get the target server and GoldenGate Home details on the target server.

select DS_HOST,DS_HOME,DS_FLAG from b1_server_cfg where CONTEXT_CD='B1';

b. Connect to the target server and login to the GoldenGate prompt. Execute the following commands:

cd <GG_Home>
./ggsci
Dblogin userid MDADM,password <MDADM user password>
Send replicat <Context_codeXX>,status

The current status will be at EOF.

```
GGSCI (slc07heq) 2> SEND REPLICAT CCB1AA ,status
Sending STATUS request to REPLICAT CCB1AA ...  
Current status: At EOF  
Sequence #: 11  
RBA: 14889  
0 records in current transaction
```

c. Check this for each replicate process for the context code and ensure replicate processes completed writing all the changes.

d. After checking the current status and each replicate process for the context code, execute the following commands:
Stop `<Context_code>*`
For example:
```shell
stop CCB1*
```
Delete `<Context_code>*`
For example:
```shell
delete CCB1*
```
3. After all source applications’ changes are in sync in the Oracle Utilities Analytics database, execute the following command after connecting to the target GoldenGate Home prompt.
```bash
./ggsci
Stop mgr
```
4. Rename the existing target GoldenGate Home directory.

Note the GoldenGate manager port number and target GoldenGate Home before renaming it.
5. Upgrade the source application databases.

If the source database version is prior to 11.2.0.4, then upgrade to 11.2.0.4 or a later version.
6. Install new Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI) if not done already.

Apply Oracle Data Integrator patch 23629220 on Oracle Data Integrator server. The patch on 12.2.1.0.0 is available on My Oracle Support (http://support.oracle.com).

To summarize, a successful Oracle Data Integrator installation involves installing/applying the following:
- JDK1.8.0(77)
- Oracle Fusion Middleware Infrastructure 12.2.1
- Oracle Data Integrator 12.2.1
- Oracle Data Integrator patch 23629220

### Installing Oracle Fusion Middleware Infrastructure

Note that the Oracle Home path provided in the Installation Location page is used while installing the Oracle Data Integrator.

The infrastructure installation type is ‘Fusion Middleware Infrastructure’.

During the Oracle Data Integrator 12.2.1 installation, provide the same ‘Oracle Home’ path used as Oracle Home while installing Oracle Fusion Middleware Infrastructure. Select Enterprise Installation on the Installation Type page.

### Upgrading Oracle Utilities Analytics Database Component

This section describes the steps included to upgrade the Oracle Utilities Analytics database component:
- Copying and Decompressing the Install Media
- Creating Users and Tablespaces
- Installing RELADM Schema
- Installing MDADM Schema
Upgrading Oracle Utilities Analytics Database Component

• Installing DWADM Schema

Before proceeding with upgrading the Oracle Utilities Analytics Database component, ensure the following are complete:

• Upgrading Oracle Utilities Analytics database to version 12.1.0.2.0.
• Installing Oracle GoldenGate 12.2.0.1.1 on Oracle Utilities Analytics database server.

Copying and Decompressing the Install Media

To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics v2.7.0 Oracle Database part (Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip) from Oracle Software Delivery Cloud (https://edelivery.oracle.com).
2. Create a temporary directory (such as c:\OUA\temp for a Windows machine or /OUA/ temp for a Linux machine).

   This directory (referred to as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after completing a successful installation.
3. Unzip Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.

Creating Users and Tablespaces

To create users and tablespaces follow these steps:

1. Ensure to create users in the database with the following names without giving specific roles (if these do not exist already):

   DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

2. Connect as sys user and revoke the DBA privilege from the following users (if the DBA privilege has been granted to them):

   DWADM, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

3. Ensure to create roles with the following names (if these do not exist already).

   DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE

4. Connect as sys user and execute the Usersgrants.sql in /Scripts/Usersgrants.sql.

   This SQL provides the required grants to the created users.

5. Copy the DuplicateRecordCheck.sql file from the BI270\DWADM\Pre-Installation directory to the database server under ../<Temp> directory.

6. Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

   Note: If the system displays that no rows are selected, then proceed. If the system displays some data, then contact Oracle Support team and do not proceed with the installation. It is recommended to wait until you get the data fix script.
Installing RELADM Schema

The RELADM schema is a metadata schema that consists of the database objects used for storing the product version and component installation information.

This section describes the RELADM schema initial installation, including:

- Reviewing the Storage.xml file
- Installation Steps
- Generating Database Statistics

Reviewing the Storage.xml file

The Storage.xml file (that comes with the product and is in location <TEMPDIR>/BI270/RELADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.

If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the Storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If database does not have CISTS_01 tablespace or the RELADM user does not have quota on CISTS_01 tablespace, edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

Installation Steps

**Note:** Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows:

1. Add Java 8 to the path variable as shown in the example below:
   
   ```
   set PATH=C:\Java\jdk1.8.0_77\bin;%PATH%
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   
   ```
   set CLASSPATH=<TEMPDIR>/BI270/RELADM/Jarfiles/*
   ```

3. Run OraDBI.jar as shown below:
   
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
db-url:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
<ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,RELADM -j
<JDK Home> -f <TEMPDIR>/BI270/RELADM/Jarfiles -v 1 -e true
   ```

In Unix:

1. Add Java 8 to the path variable as shown in example below:
   
   ```
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   
   ```
   export CLASSPATH=<TEMPDIR>/BI270/RELADM/Jarfiles/*
   ```

3. Run OraDBI.jar as shown below:
   
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   db-url:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
<ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,RELADM
   ```
-j <JDK Home> -f <TEMPDIR>/BI270/RELADM/Jarfiles -v 1 -e true

The utility creates the RELADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect as sys user and execute the following command:

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing the metadata of Oracle Utilities Analytics.

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes the MDADM schema initial installation, including:

• Reviewing Storage.xml File
• Installation Steps
• Generating the Database Statistics

Reviewing Storage.xml File
The storage.xml file (comes with the product and is in location <TEMPDIR>/BI270/MDADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

Note: If the database does not have CISTS_01 tablespace or the MDADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which MDADM has quota.

Installation Steps
To install the MDADM schema, follow these steps:

Note: The process prompts you for the MDADM user password. Ensure to run the OraDBI.jar (in the step below) using JDK 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

• In Windows:

1. Add Java 8 to the path variable as shown in the example below:
   set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   set CLASSPATH=<TEMPDIR>/BI270/MDADM/Jarfiles/*
Upgrading Oracle Utilities Analytics Database Component

3. Run OraDBI.jar as shown below:

    <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,MDADM -j
    <JDK Home> -f <TEMPDIR>
    BI270\MDADM\Jarfiles -v 1 -e true

   • In Unix:

      1. Add Java 8 to the path variable as shown in example below:
         export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH

      2. Set classpath pointing to OraDBI.jar and all dependency jars.
         export CLASSPATH=<TEMPDIR>/BI270/MDADM/Jarfiles/*

      3. Run OraDBI.jar as shown below:
         java com.oracle.ouaf.oem.install.OraDBI
             -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
             <ORACLE SERVICE NAME>,
             MDADM,<Password of MDADM user>,,,,,MDADM
             -j <JDK Home> -f <TEMPDIR>/BI270/MDADM/Jarfiles -v 1 -e true

   The utility creates the MDADM schema and system data definitions.

   If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating the Database Statistics

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect as sys user and execute the following command:

    execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Installing DWADM Schema

The DWADM schema contains star schema objects (such as facts and dimensions) that include entire data in the data warehouse.

This section describes the DWADM schema initial installation, including:

   • Executing Pre-Installation SQL
   • Reviewing Storage.xml File
   • Installation Steps
   • Generating Database Statistics

Executing Pre-Installation SQL

To execute specific SQL scripts before proceeding with the installation, follow these steps:

1. Copy refresh_mvs_where_mv_logs_ouofsync.sql script from BI270/DWADM/ Pre-Installation/ to the database server under ../<Temp> directory. Execute it while connecting to the schema.

2. Copy drop_out_of_sync_mv_logs.sql script from BI270/DWADM/ Pre-Installation/ to the database server under ../<Temp> directory. Execute it while connecting to the schema.
Reviewing Storage.xml File

The storage.xml file (comes with the product and is in location <TEMPDIR>/BI270/DWADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

Note: If the database does not have CISTS_01 tablespace or the DWADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which DWADM has quota.

Installation Steps

To install the DWADM schema, follow these steps:

Note: The process prompts you for the DWADM user password. Ensure to run the OraDBI.jar (in the step below) using JDK 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

• In Windows:
  1. Add Java 8 to the path variable as shown in the example below:
     ```
     set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     set CLASSPATH=<TEMPDIR>\BI270\DWADM\Jarfiles* 
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI –d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM -j <JDK Home> -f <TEMPDIR>\BI270\DWADM\Jarfiles –v 1 –e true
     ```

• In Unix:
  1. Add Java 8 to the path variable as shown in example below:
     ```
     export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     export CLASSPATH=<TEMPDIR>/BI270/DWADM/Jarfiles/*
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI \
     -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE NAME>,\ 
     DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM \ 
     -j <JDK Home> -f <TEMPDIR>/BI270/DWADM/Jarfiles –v 1 –e true
     ```

The utility creates the DWADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.
Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect as sys user and execute the command:

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Post-Installation Steps
Perform these steps to complete the installation:

1. Connect to the Oracle Utilities Analytics database and execute the following:

   .../BI270/DWADM/Post-Upgrade\ControlZoneUpdate.sql

2. Connect to the Oracle Utilities Analytics database with the system user and execute the script mentioned below:

   .../BI270/DWADM/Post-Upgrade\DataCorrection2511.sql

Upgrading Oracle Data Integrator Based ELT Component
This section describes the steps included to upgrade the Oracle Data Integrator based ELT component:

- Prerequisites for Running Oracle Utilities Analytics Installer
- Configuring Oracle Data Integrator Repository Creation Utility (RCU)
- Upgrade ODI Repository
- Setting up Oracle GoldenGate
- Copying and Decompressing Install Media
- Starting the Installer
- Upgrade Steps
- Configuring Source Applications

Before proceeding with upgrading the Oracle Utilities Analytics based ELT component, ensure the following are complete:

- Installing JDK1.8.0(77)
- Installing Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI)
- Applying Oracle Data Integrator patch 23629220

Prerequisites for Running Oracle Utilities Analytics Installer
Before running the Oracle Utilities Analytics installer, perform these steps:

1. Copy B1_UPD_SCEN_FOLDER.sql script to the server from /BI270/Scripts location.
2. Replace <work_repo_schema> entry with the work repository username in the script and execute it by connecting to MDADM schema.
3. Backup the customized views and recreate them manually after upgrading Oracle Utilities Analytics to v2.7.0.
Configuring Oracle Data Integrator Repository Creation Utility (RCU)

To configure the Oracle Data Integrator Repository Creation Utility (RCU), follow these steps:

1. Ensure RCU for ODI is running and the required schemas are created in the target database.

   ODI_ORACLE_HOME is an Oracle Home path used as Oracle Home while installing FMW Infrastructure and Oracle Data Integrator (ODI).

2. Set or export JAVA_HOME variable to the 1.8.0_77 installed directory.
3. Go to $ODI_ORACLE_HOME/oracle_common/bin.
4. Run the RCU utility.

   For example:

   ```bash
   export JAVA_HOME=/scratch/bi_oradata_01/jdk1.8.0_77
cd/scratch/bi_oradata_01/12.2.1_FMW_infrastructure/oracle_common/bin
   ./rcu
   ```

5. On the **Select Components** wizard in RCU, navigate to the **Create Repository** tab and select **System Load and Product Load**. Click Next.
6. On the **Database Connection Details** tab, provide the database connection details. Click Next.
7. On the **Select Components** tab, select the options as shown in the screen below.

Unselect the Oracle Data Integrator component. Click **Next**.

![Select Components Screen]

8. On the **Schema Passwords** tab, note the passwords given as they are required while creating the Oracle Data Integrator domain.

9. Navigate to the **Complete Summary** tab and click **Finish**.

It is not required to create the Oracle Data Integrator domain at this stage. Create it after running the Oracle Utilities Analytics installer and before running the source configuration tool.

### Upgrade ODI Repository

To upgrade the ODI repository, perform the following steps:

1. Backup the ODI 12.1.3 repository.

2. Invoke the Upgrade Assistance Tool from `<ODI_12.2.1_HOME>/oracle_common/upgrade/bin`.

   For example:
   ```
   cd /scratch/bi_oradata_01/12.2.1_FMW_infrastucture/oracle_common/upgrade/bin
   ./ua
   ```

3. Select the ODI 12.1.3 master repository schema to upgrade repository to 12.2.1 version.

   **Note:** Refer to the Oracle documentation for detailed steps to upgrade the ODI repository.

### Setting up Oracle GoldenGate

This section describes the following:

- **Setting up Oracle GoldenGate on Source Database Server**
- **Setting up Oracle GoldenGate on Target Database Server**
- **Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers**
Setting up Oracle GoldenGate on Source Database Server

Before proceeding, start the source database and ensure it is accessible. Bring down the source application server.

To set up each source instance, follow these steps:

1. Create a directory on the source database server. (For example: ../GoldenGate Home) and install Oracle GoldenGate in that directory. It is Oracle GoldenGate home (OGG_Home) on the source database server.

   *Note:* Note this directory location; it is used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate.

   Download Oracle GoldenGate 12.2.0.1.0 from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

   For installation instructions, refer to the respective installation documentation at http://docs.oracle.com/goldengate/1212/gg-winux/index.html.

3. Provide the Oracle GoldenGate Home location as the directory location created in the step 1.

4. Open a command terminal or window, and set the source ORACLE_SID and ORACLE_HOME variables.

5. Set the LD_LIBRARY_PATH as follows:

   In Unix:
   ```bash
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   In Windows:
   ```bash
   set LD_LIBRARY_PATH=%ORACLE_HOME%\lib;%LD_LIBRARY_PATH%
   ```

6. In the Command window, change directory to the Oracle GoldenGate home directory, and execute the following command:

   In Unix:
   ```bash
   ./ggsci
   ```

   In Windows:
   ```bash
   ggsci
   ```

   The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order listed:

   - `create SUBDIRS`
   - `start mgr` - Starts the Oracle GoldenGate manager process.
   - `info all` - Verifies if the manager process is running.
   - `exit` - Exits Oracle GoldenGate.

8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as `sys user` and execute the following statements:

   ```sql
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. In the Command window, navigate to the Oracle GoldenGate home (OGG_Home) directory.
11. Open the GOBALS file in the directory and add the below command:

   EnableMonitoring

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

13. Connect to the database as **sys user** using SQL*Plus.

   Ensure OGG_Home to be the current directory while invoking SQL*Plus.

14. Create a new user.

   For example: ODM01SRC

   This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is not assigned to any other user.

   **Note:** Ensure to note down the Oracle GoldenGate Owner Username. It is used in the Oracle Utilities Analytics installation.

15. Connect to the source database as **sys user**.

16. Execute the following commands:

   **Note:** Ensure to modify the GoldenGate owner placeholder with actual name of the database user created in step 14.

   grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
   grant unlimited tablespace to <GoldenGate owner> with admin option;
   EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>','capture');
   grant unlimited tablespace to <GoldenGate Owner> with admin option;
   Revoke dba from <GoldenGate Owner>;
   grant create any view to <GoldenGate Owner>;
   grant select any dictionary to <GoldenGate Owner>;
   Grant CREATE ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
   GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;

17. Connect to the <source application> ADM schema (such as CISADM). Execute the following commands:

   For **Oracle Utilities Customer Care and Billing** source database, execute the following grants:

   Grant select on F1_MST_CONFIG to <GoldenGate owner user created in step 16>
   Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in step 16>
   Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in step 16>
   Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created in step 16>

   For **Oracle Utilities Operational Device Management** source database, execute the following grants:

   Grant select on F1_MST_CONFIG to <GoldenGate owner user created in step 16>
   Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in step 16>
For **Oracle Utilities Meter Data Management** source database, execute the following grants:

Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;

For **Oracle Utilities Work and Asset Management** source database, execute the following grants:

Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

Note: While executing SQL commands in steps 15, 16, and 17, provide the GoldenGate owner user (if prompted for).

All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the database as sys user.

18. Execute the following commands in the order listed below:
   
   ```
   @marker_setup.sql
   @ddl_setup.sql
   @role_setup.sql
   ```


20. In the Command window, create a directory “diroby” in the OGG_Home directory.

21. Change directory to the Oracle GoldenGate Home directory, and execute the following:
   
   b. Steps in Generating Shared Secret Password.

Note: Execute these steps before running the Oracle Utilities Analytics installer. See [http://docs.oracle.com/goldengate/c1221/gg-winux/index.html](http://docs.oracle.com/goldengate/c1221/gg-winux/index.html) for more details.

### Configuring Encrypting Data Using ENCKEYS Method

To configure for encrypting data using the ENCKEYS method, do the following:

1. Execute the following command:
   ```
   cd <OGG_HOME>
   KEYGEN key_length n
   ```

   The above command generates the key value based on the value specified in the parameter “n”. The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

3. Repeat the step above for each key values generated.
4. Save the file with name ENCKEYS (Upper case only) without any extension.
   For example:
   ```
   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035DD6893205A7BD6773FA8E670
   ```

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

6. Input the Logical name, space and key value generated.
   Sample content of file ENCKEYS:
   ```
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ```

7. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.
   **Note:** It is recommended to name Logical key name after `<context_code>KEY`.
   For example: If context code is CCB1, it is recommended to name it as CCB1KEY.

### Generating Shared Secret Password
To generate the shared secret password:

1. Execute the following command:
   ```
   cd <OGG_HOME>
   ggsci
   ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
   ```
   For example:
   ```
   cd $OGG_HOME
   ./ggsci
   GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
   Encrypted password:
   AADAAAAAABAAAAGNhbflGFHCFBCVBFJFHUEJMCFAOAFEOBFALEGIFSFOEIBGRB
   2HCMMGYBDAZH
   Algorithm used: AES128
   ```

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and the generated encrypted password.

### Setting up Oracle GoldenGate on Target Database Server
To set up Oracle GoldenGate on the target database server:

1. Create a directory on the target database server.
   For example: `../GoldenGateHome`
   Oracle GoldenGate should be installed in this directory. It is **Oracle GoldenGate home (OGG_Home)** on the target Oracle Utilities Analytics database server.
   **Note:** Ensure to note the directory location; it will be used in the Oracle Utilities Analytics installation.
2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.
   Set LD_LIBRARY_PATH using the following commands:
   In Unix:
   ```bash
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```
   For Windows:
   ```bash
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
   ```

4. In the Command window, change the directory to the **GoldenGate home** directory and execute the below command:
   For Unix:
   ```bash
   ./ggsci
   ```
   For Windows:
   ```bash
   ggsci
   ```
   The Oracle GoldenGate prompt is shown.

5. At the prompt, execute the following commands in the order listed below:
   - create SUBDIRS
   - start mgr - Starts the Oracle GoldenGate manager process.
   - info all - Verifies if the manager process is running.
   - exit

6. Create a directory “diroby” in the OGG_Home directory.

7. Connect to the target database as **sys user** and execute the below query:
   ```sql
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

8. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.

9. Edit the GLOBALS file in the `<GG home>` directory and add the following command:
    ```bash
    EnableMonitoring
    ```

10. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. If the ENCKEYS file does not exist:
    a. Create and open a new ASCII ENCKEYS file.
    b. Add the key value/values that are generated on the sources to the ENCKEYS file in target OGG home. This is done for the context codes for which source is configured.
    A sample ENCKEYS file in target OGG home is as below:
    ```plaintext
    CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
    ```
Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

Set up Oracle GoldenGate Monitor (OGG) JAgent on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers. The OGG Monitor JAgent is used to automatically copy the generated OGG scripts to both source and target GoldenGate Home directories, and to start the extract and replicate processes on source and target.

To setup OGG Monitor JAgent on both target and source database servers:

1. Ensure Oracle GoldenGate is installed and manager is running.
2. Start the rmiregistry services using the following command:
   
   \[ \text{rmiregistry} \text{ 5559} \& \]
   
   Ensure to note down the port on which RMI server is started. The port number specified here is 5559. If it is not specified, the default port 1099 will be used.
3. Install Fusion Middleware Infrastructure.
4. Run the OGG Monitor 12.2.1 installer.
   a. Set Oracle Home to the location where Fusion Middleware Infrastructure was installed in step 2.
   b. Choose installation type as OGG Monitor Agent.
5. Edit the Config.properties file in the \(<\text{OGG Monitor home}>/oggmon/ogg_agent/\text{cfg}\_templates\) and add/modify the below parameters.
   
   \(<\text{ACTUAL}>\ : \text{jagent.host}=\text{localhost}\n   <\text{CHANGE TO}>\ : \text{jagent.host}=<<\text{actual}\ \text{hostname}\ \text{on}\ \text{which}\ \text{OGG}\ \text{is}\ \text{installed}}>>\n   
   \(<\text{ACTUAL}>\ : \text{monitor.jmx.username}=\text{cmroot}\n   <\text{CHANGE TO}>\ : \text{monitor.jmx.username}=\text{jmx\_src}\n   
   \(<\text{ACTUAL}>\ : \text{jagent.username}=\text{root}\n   <\text{CHANGE TO}>\ : \text{jagent.username}=<<\text{OGG}\ \text{software}\ \text{installed}\ \text{OS}\ \text{user}}>>\n   
   \(<\text{ACTUAL}>\ : \text{jagent.rmi.port}=\text{5559}\n   <\text{CHANGE TO}>\ : \text{jagent.rmi.port}=\text{5557}\ \text{or}\ \text{any}\ \text{free}\ \text{port}\ \text{other}\ \text{than}\ \text{the}\ \text{one}\ \text{on}\ \text{which}\ \text{the}\ \text{rmiregistry}\ \text{is}\ \text{started}}\n   
   \(<\text{ACTUAL}>\ : \text{agent.type.enabled}=\text{OGGMON}\n   <\text{CHANGE TO}>\ : \text{agent.type.enabled}=\text{OEM}\n   <\text{ACTUAL}>\ : \text{jagent.backward.compatibility}=\text{true}\n   <\text{CHANGE TO}>\ : \text{jagent.backward.compatibility}=\text{false}\n   
6. Add the following parameter:
   
   \[ \text{jagent.ssl=false} \]
7. Navigate to \(<\text{OGG Monitor home}>/oggmon/ogg_agent\) directory and run the below command:
   
   In Unix:
   
   \[ \text{export JAVA_HOME=<<JDK home}>./createMonitorAgentInstance.sh} \]
   
   In Windows:
   
   \[ \text{set JAVA_HOME=<<JDK home}>./createMonitorAgentInstance.bat} \]
a. You will be prompted to enter:
   • Oracle GoldenGate Home directory.
   • Path to be used for Oracle GoldenGate Monitor Agent instance.

   It is recommended to provide a path (such as `<OGG Monitor home>/Agents/OGGMonitorInstance`).
   • A unique name to replace the timestamp in the name of the file used to start GG Monitor agent instance.

   Provide a unique name to be used for this Oracle GoldenGate Monitor instance.

b. Execute the command below from `<path used for OGG Monitor instance provided in the step above>/bin`.

   Example location: `<OGG Monitor home>/Agents/OGGMonitorInstance/bin`

   In Unix:
   ```
   export JAVA_HOME=<JDK home>
   ./pw_agent_util.sh -jagentonly
   ```

   In Windows:
   ```
   set JAVA_HOME=<JDK home>
   pw_agent_util.bat -jagentonly
   ```

8. Enter the Oracle wallet password.

   This password has to be entered as the password for the JAGENT while running the installer (for target gg), and while running the source configuration (for source gg).

   Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is required in subsequent installation.

9. Create a folder with the Context_code name in `<GG Home>/dirdat`.

   For example: If WAM2 is created for the WAM source, then create a folder with name “WAM2” within the `<GG Home>/dirdat/` folder.


    Replace COMMAND java with COMMAND `<JDK Home>/bin/java`.

    This ensures that the correct version of java (1.8) is used while starting JAgent.

11. Navigate to OGG_Home directory and run the following command at the Oracle GoldenGate prompt:

    `ggsci`

12. Start the JAgent process using the following command:

    `start jagent`

    The logs for JAgent are created at the following (example) location.

    `<OGG Monitor home>/Agents/OGGMonitorInstance/logs`
## Copying and Decompressing Install Media

To download and decompress the install media:

1. Download the Oracle Utilities Analytics version 2.7.0 Multiplatform part (Oracle Utilities Analytics V2.7.0 Multiplatform.zip) from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Multiplatform.zip to <TEMPDIR>.

   **Note:** Rename the model codes in ODI if any of the below model codes are being used in customization.

   - CM_FACT
   - CM_REPLICATION
   - CM_STAGING
   - CM_DIMENSION

## Starting the Installer

For an AIX Operating System, set the following environment variable before starting the Oracle Utilities Analytics installation:

```bash
export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m -XX:MaxPermSize=3200m"
```

To start the Oracle Data Integrator Based ELT component:

1. Go to the temporary folder containing the installer.
2. Run the following command from this folder:

   ```bash
   java -jar <TEMPDIR>/OUA_2.7.0.0.0_generic.jar -logLevel finest
   ```

   **Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

   The **Welcome** page appears.

3. Review this information before you begin the installation. Click **Next** to continue with the installation.

4. Complete the tasks on the navigation pane.

   Each item in the navigation pane represents a specific installer screen that prompts you for information required to install the software.

   - If you select **Oracle Data Integrator Based ETL** as an **Installation Type**, define the following:
     - Database and Java Home Details
     - Target Database Connection Details
     - Oracle Data Integrator Home and Schema Details
     - Oracle Data Integrator Agent and Repository Details
     - Target GoldenGate Details
     - Target JAgent Details
Upgrade Steps
To install Oracle Data Integrator Based ETL:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears.
   Review the information on the Welcome page before you begin the installation.

2. Click Next to continue with the installation.

3. On the Installation Location page define an installation location/directory and click Next.

4. On the Select Installation Type page, select ODI Based ETL. Click Next.
   Note that the options on the left navigation pane change based on the selected installation type.

5. Select Oracle Data Integrator Based ETL as the Installation Type.

6. Define the following and click Next.
   - Database and Java Home Details
   - Target Database Connection Details
   - Oracle Data Integrator Home and Schema Details
   - Oracle Data Integrator Agent and Repository Details
   - Target GoldenGate Details

7. On the Database and Java Home Details page, enter the following in the respective fields. Click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>The database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>The JDK home location.</td>
<td>Provide location of JDK 1.8.</td>
</tr>
</tbody>
</table>
<pre><code>                             |                                    | Example: /u01/jdk_1.8.0_77                  |
</code></pre>

8. On the Target Database Connection Details page, enter the following in the respective fields. Click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database.</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
</tbody>
</table>
9. On the **ODI Home and Schema Details** page, enter the following in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

10. On the **ODI Agent and Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Agent Host</td>
<td>The host on which Oracle Data Integrator WebLogic domain is created.</td>
<td>Oracle Data Integrator server host name.</td>
</tr>
</tbody>
</table>
11. On the **Target GoldenGate Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host on the Oracle GoldenGate Manager.</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Target Database Home</td>
<td>The database home installed location on the target database server.</td>
<td>In case Oracle GoldenGate for target is not installed on the OUA database server, provide oracle client home location on the server on which Oracle GoldenGate is installed.</td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the Oracle GoldenGate host.</td>
<td>The default value is 7830</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>The algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>The Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>The shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: encrypt password &lt;password of MDA DM user&gt;, encryptkey DEFAULT Provide the result as the value.</td>
</tr>
</tbody>
</table>
12. On the **Target JAgent Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Host</td>
<td>The host of Oracle GoldenGate Monitor JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>The Oracle GoldenGate installed location where</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
<tr>
<td></td>
<td>Oracle GoldenGate Monitor JAgent is running.</td>
<td></td>
</tr>
<tr>
<td>JAgent Port</td>
<td>Use the JAgent RMI port which is defined in the config properties file.</td>
<td></td>
</tr>
<tr>
<td>JAgent User</td>
<td>The OS user used to configure JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent Wallet Password</td>
<td>The JAgent Wallet password.</td>
<td></td>
</tr>
<tr>
<td>Confirm JAgent Wallet Password</td>
<td>Re-enter JAgent Wallet password to confirm.</td>
<td></td>
</tr>
</tbody>
</table>

13. On the **Installation Summary** page, verify the installation options you selected.

14. Click **Install** to begin the installation.

To change any configurations before starting the installation, use the navigation pane and select the topic to edit.

The **Installation Progress** page appears displaying the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The detailed logs of the installation are also available in the logs/system directory under the installation location.

To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

15. On the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

---

**Creating WebLogic Domain for Oracle Data Integrator Agent**

Create the WebLogic Domain to bring up the WebLogic Agent (ODI Agent) to complete the steps. In this product release, ODI Domain creation is automated, and creation of both clustered and non-clustered domain is supported.

- Creating a Non-Clustered Domain
- Creating a Clustered Domain

**Note:** The following procedures assume that the pre-requisite Java 8/bin is in the PATH variable.
Creating a Non-Clustered Domain

To create a non-clustered domain:

**Note:** The password fields' values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the `<OUA Environment>/etc` directory and provide the following properties in the `ODI_CONFIG.properties` file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mandatory fields</strong></td>
<td></td>
</tr>
<tr>
<td>DOMAIN_PATH</td>
<td>In Windows environment, replace “\” with “/” in the domain path. For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI_DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td>ODI_DOMAIN_HOSTNAME</td>
<td>Host name on which the ODI domain is created</td>
</tr>
<tr>
<td><strong>Optional fields</strong></td>
<td></td>
</tr>
<tr>
<td>NONSSL_PORT</td>
<td>If not specified, default port 7001 will be assigned.</td>
</tr>
<tr>
<td>MANAGED_SERVER_PORT</td>
<td>If not specified, default port 15101 will be assigned.</td>
</tr>
</tbody>
</table>

2. Navigate to the `<OUA Environment>/bin` directory and invoke the `createDomain.sh/cmd` script.

Refer to the sections Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) to start the admin server and managed server.
Creating a Clustered Domain

To create a clustered domain:

Note: The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in the ODI_CONFIG.properties file:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory fields</td>
<td></td>
</tr>
<tr>
<td><strong>DOMAIN_PATH</strong></td>
<td>In Windows environment, replace “\” with “/” in the domain path.</td>
</tr>
<tr>
<td></td>
<td>For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td><strong>RCUPREFIX</strong></td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td><strong>RCUSCHEMAPWD</strong></td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td><strong>WEBLOGIC_USERNAME</strong></td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td><strong>WEBLOGIC_PASSWORD</strong></td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td><strong>ODI_DBSERVER</strong></td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td><strong>ODI_DBPORT</strong></td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td><strong>ODI_DBNAME</strong></td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td><strong>ADMIN_PORT</strong></td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td><strong>ODI_DOMAIN_HOSTNAME</strong></td>
<td>Host name on which the ODI domain is created</td>
</tr>
<tr>
<td><strong>CLUSTER_NAME</strong></td>
<td>Additional mandatory field for clustered domain</td>
</tr>
</tbody>
</table>

2. Navigate to the <OUA Environment>/bin directory and invoke the createDomain.sh/cmd script.

This creates an ODI domain with an Admin server and a Managed server (as ‘ODI_server1’) and assigned to the cluster.

Refer to the Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) sections to start the Admin server and Managed server.

To create another managed server and add it to the cluster:

1. Bring up the Admin server.

2. Navigate to the <OUA Environment>/etc directory and provide the following mandatory properties in the ODI_CONFIG.properties file:
3. Provide the following optional properties in the ODI_CONFIG.properties file:
   • MACHINE_NAME
   • MACHINE_PORT


   A new managed server is created with the specified name and assigned to the cluster.

   Refer to the sections Starting the WebLogic Admin Server and Starting the Managed Server (ODI_server1) to start the Admin server and Managed server.

Starting the WebLogic Admin Server

To start the WebLogic Admin Server:
1. In the command shell, change the directory to the directory of the WLS Home.
   <MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin

2. Execute the startweblogic command for UNIX and Windows:
   In Unix:
   nohup ./startWebLogic.sh > startWebLogic.log &
   In Windows:
   startWebLogic.cmd

Starting the Managed Server (ODI_server1)

To start the odi_server1 managed server:

2. Create the boot.properties file. Enter the username and password in the respective fields in the file. Save the file.

   Below is an example of the boot.properties file:
   username=<weblogic username>
   password=<weblogic password>

3. Change the directory to WLS Home to start odi_server1:
   In Unix:
   <MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
   In Windows:
   StartManagedWeblogic.cmd odi_server1

4. In the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent.

5. Right-click OracleDIAgent and click Test to test the connectivity of the configured Oracle Data Integrator Java EE agent.
Executing Post-Upgrade Script
To execute the post-upgrade script:
1. Execute B1_MDFIX_ODM_270 in global context.
2. Login to ODI Client and navigate to Designer > Load Plans and Scenario folders.
4. Right-click B1_MDFIX_ODM_270, click Run, and then select the context as Global.
5. Click OK.

Creating a Database Directory
Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each source database. This directory is used for logging the export import task used during the initial ELT load.

The following sample SQL creates a database directory pointing to the file system path /scratch/file_data:

CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';

Configuring Source Applications
This section describes the instructions to be followed to configure source applications.

- Prerequisites
- Configuration Steps
- Post-configuration Steps

Bring down the source application server, and ensure the source applications are stopped but source databases are up and accessible.

Prerequisites
Before running the source configuration tool, ensure to do the following:

- Apply patch 26384944.
- Create the Oracle Data Integrator domain.
- Check if admin and managed servers are running and accessible.

Configuration Steps
To configure the source applications:

1. Register a source application.

   For instructions to register a source, refer to the Registering a Source section in Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

2. Ensure to use the same context_codes to configure the existing sources during the upgrade.

3. After running config.sh GUI utility, run B1_SYNC_CONTEXT as follows.
   a. Login to Oracle Data Integrator Studio.
   b. Navigate to Designer > Load Plans and Scenarios > Framework.
c. Right-click **B1_SYNC_CONTEXT** and select **Run**.

![Diagram](image)

4. Select the context related to the source application, **<no agent>** as logical agent, and then click **OK**.

5. Run the **B1Inicial_SETUP_PKG** package.
   
   **Note:** It is recommended to run **B1Inicial_SETUP_PKG** only once (after all the sources have been configured or after at least one source is configured).
   
   a. Login to Oracle Data Integrator Studio.
   b. Navigate to **Designer > Load Plans and Scenarios > Framework**.
   c. Right-click **B1Inicial_SETUP_PKG**, select **GLOBAL** context code, and then select **Run**.

6. Start all Oracle GoldenGate processes on source and target:
   
   a. Login to each source application GoldenGate server.
   b. Go to the respective Oracle GoldenGate Home directory.
   c. Start manager, JAgent, and all respective context extract processes.
   d. Login to the target (Oracle Utilities Analytics) GoldenGate server.
   e. Go to the Oracle GoldenGate Home directory.
   f. Start manager, jagent and all respective context extract processes.

**Post-configuration Steps**

Follow these post-configuration steps:

1. Drop all the materialized views from the DWADM schema.
   
   a. Connect to the MDADM schema.
   b. Execute the query below to find the materialized views to be dropped for Oracle Utilities Network Management System.
SQL> select MVIEW_NAME from all_mviews where owner='DWADM' and mview_name IN ( select distinct entity_name from MDADM.B1_CONFIG_VW where PROD_FLG='NMS' and ENTITY_TYPE_FLG = 'M-VW');

c. In addition to the above materialized views, drop B1_WO_MON_MV3 for Oracle Utilities Work and Asset Management.

2. Drop the error table from the DWSTAGE schema.
   a. Connect to the DWSTAGE schema.
   b. Execute the below SQL statement to get the list of error tables:

   SQL> select TABLE_NAME from user_tables where TABLE_NAME like 'ERR_%';

c. Drop all the objects from above query result.

   For example:
   drop table <table_name> purge;

Upgrading Oracle Utilities Analytics Administration Tool Component

Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based configuration tool used to configure Oracle Utilities Analytics.

This section describes how to install the tool to configure Oracle Utilities Analytics and change the default password of the Admin user.

• Installation Steps

• Changing Default Password of Admin User

   Note: Install Oracle Utilities Analytics Administration component on the Oracle Utilities Analytics database server.

Installation Steps

To install the Oracle Utilities Analytics Administration Tool:

1. Download Apex 5.0.4. Copy it to the server where you want to set it up under the /scratch/bi_oradata_01/Softwares/apex_5.0.4 directory.

2. Connect to the Oracle Utilities Analytics database as the sys user and execute the following commands:

   EXEC DBMS_XDB.SETHTTPPORT(0);
   SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

   This query should result in zero(0).

3. Navigate to the Apex unzipped path and execute the following scripts. Connect to Oracle Utilities Analytics database as a sys user.

   @apexins.sql <Tablespace name> <Tablespace name> <Temp Tablespace name> /i/  (for example: @apexins.sql CISTS_01 CISTS_01 TEMP /i/)
   @apxchpwd.sql
   ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
   ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
   @apex_rest_config.sql
Ensure to note the password for these two users: APEX Listener user and APEX_REST_PUBLIC_USER.

4. Download Oracle Rest Data service. Copy it to the server where you want to set it up under the /scratch/bi_oradata_01/Softwares/apex_listner directory.

5. Navigate to the scratch/bi_oradata_01/Softwares/apex_listner directory. Unzip the ords.3.0.6.176.08.46.zip file.

6. Create a directory on the server to configure Apex.
   For example: mkdir/scratch/bi_oradata_01/apex_configuration

7. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory.
   cd /scratch/bi_oradata_01/Softwares/apex_listner

8. Execute the following command:
   java -jar ords.war install advanced

   **Note:** Use JDK1.8 or later to execute this command.

Provide the required inputs as shown below.
9. Navigate to the `/scratch/bi_oradata_01/Softwares/apex_listener` directory:
   ```bash
cd /scratch/bi_oradata_01/Softwares/apex_listener
   ```

10. Execute the following command:
    ```bash
    java -jar ords.war static <apex5.0.4 unzipped path>/apex/images
    
    For example: java -jar ords.war static /scratch/bi_oradata_01/Softwares/apex_5.0.4/apex/images
    
    Note: The command creates the i.war file.
    ```

11. Install WebLogic 12.2.1 with jdk 1.8.0+.

12. Create the WebLogic domain.
    a. Go to `<12.2.1_weblogic_home>oracle_common/common/bin` directory.
    b. Execute the following command:
       ```bash
       ./config.sh
       
       The Fusion Middleware Configuration Wizard window appears.
       ```
    a. On the Create Domain tab, select Create a new domain. Click Next. Do not change the domain location.
b. On the **Template** tab, select the template category as shown. Click **Next**.

c. On the **Administrator Account** tab, provide the WebLogic username and password. Ensure to note the same. Then, click **Next**.
d. On the **Domain Mode and JDK** tab select **jdk1.8** and click **Next**.

e. On the **Advanced Configuration** tab, select **Administration Server** and **Managed Servers, Clusters and Coherence** options. Then, click **Next**.

f. On the **Administration Server** tab, provide the available port as **Listen Port**. Click
g. On the **Managed Servers** tab, click **Add** and provide values as shown below. Click **Next**.

h. Click **Next** on the **Clusters** and **Machines** tabs respectively. There are no changes to these pages.
i. On the **Configuration Summary** tab, click **Create** to create the **boot.properties** file.

13. Start the Admin and Managed server.
14. Login to WebLogic console and click **Lock & Edit**.
15. Click **Install**.
16. Enter the following path and then select the **ords.war** file.

    /scratch/bi_oradata_01/Softwares/apex_listener
Click **Next**.

17. Select the **Apex server** check box and click **Next**.

18. Select the options as shown below:
19. Select the options as shown below:

![Install Application Assistant](image)

20. Click **Activate Changes**.

![View changes and restarts](image)

21. Repeat the steps 14 to 20 to deploy the **i.war** file.

22. Login to the WebLogic console and navigate to **Deployment > Monitoring**.

23. Select **i** and **ords**. Then, click **Start > Servicing All Requests**.
24. Click Yes.

25. Restart the Admin and Managed servers.

26. Go to the following URL to access the Administration Tool:

   http://<hostname>:<managed server port no>/ords/?p=104

   The credentials to access the tool are:

   User ID: Admin
   Password: Admin_123

### Changing Default Password of Admin User

This section describes the APEX API used to change the password of the admin user. The script should be run after connecting to the database as user SYSTEM.

Replace the string 'New password' with the new password for the admin account before running the script.

```sql
begin
  wnv_flow_api.set_security_group_id(p_security_group_id=>nvl(ww_flow_application_install.get_workspace_id(2090514487849294))); end;

begin
  apex_util.edit_user(
    p_user_id => '2090514487849294',
    p_user_name => 'ADMIN',
    p_web_password => 'New password',
    p_new_password => 'New password'
  );
  end;
  commit;

  Note: It is strongly recommended to change the default password after logging in.
```
Upgrading Oracle Utilities Analytics Dashboards Component

Ensure that the same Operating System (OS) user used to install the prerequisite software is used to install the Oracle Utilities Analytics Dashboards component as well.

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics application server.

This section describes how to install the dashboards component of Oracle Utilities Analytics.

- Prerequisites
- Copying and Decompressing Install Media
- Starting the Installer
- Upgrade Steps
- Deploying Web Catalog
- Deploying Repository (RPD) File
- Configuring and Deploying the MapViewer
- Enabling WriteBack
- Enabling Auto Complete Feature in OBIEE

Prerequisites

Oracle Utilities Analytics Dashboard component v2.7.0 requires Oracle Business Intelligence Enterprise Edition version 12.2.1.

Note: OBIEE 11.1.1.x.x should be upgraded to 12.2.1 before proceeding with Oracle Utilities Analytics Dashboard component upgrade.

Refer to OBIEE documentation for details about the upgrade from 11.1.1.x.x to 12.2.1.

To upgrade OBIEE from 11.1.1.x.x to 12.2.1 follow these steps:

1. Stop the OBIEE admin, managed, node managers, and opmn services.
2. Backup the OBIEE middleware home folder.
3. Install Fusion Middleware Infrastructure 12.2.1 for OBIEE.
4. Download and install OBIEE 12.2.1 using Fusion Middleware 12.2.1 Home.
5. Run RCU to create the necessary schemas.
   a. Navigate to `<FMW infrastructure home>/oracle_common/bin`.
      Example location: cd /u01/12.2.1.9_Infrastructure/oracle_common/bin
   b. Run the command below and follow the instructions in the wizard:

      ./rcu

Select AS Common Schemas and Oracle Business Intelligence components on the Select Components panel.
6. Run the OBIEE configuration assistant to create an OBIEE domain.

7. Navigate to `<FMW infrastructure home>/bi/bin`.

Example location: `cd /u01/12.2.1_Infrastructure/bi/bin`

8. Run the command below and follow the instructions in the wizard:
   ```
   ./config.sh/cmd
   ```
   a. On the Database Details tab, select **Use existing schemas** and provide the connection details.
   b. On the Initial Application panel, select **Oracle sample application** (SampleAppLite).
   c. Ensure to note the BI domain path, and WebLogic username and password, so they can be provided as inputs when the Oracle Utilities Analytics Dashboards component installer is run.

9. After the creating the OBIEE domain successfully, start the OBIEE admin server.

10. Login to admin console.
   a. Expand the **Environment** tab and navigate to **Coherence Clusters** that displays all coherence clusters.
   b. Click **defaultCoherenceCluster** and select **Configuration**.

   Ensure the port in the **Cluster Listen Port** field is not in use. If needed, change it to another port that is not in use.
   c. Click **Save** to save the port changes (if any).

11. Start the OBIEE managed server.

12. After starting the OBIEE domain services successfully, navigate to the `<OBIEE domain>/config/fmwconfig` directory.

13. Open `jps-config.xml`.

14. Under the `<serviceInstance name="idstore.ldap" provider="idstore.ldap.provider">` element, add the following property element.

   ```
   <property name="oracle.security.jps.ldap.policystore.refresh.interval" value="6000000"/>
   ```

15. Migrate the metadata from Oracle BI 11g to 12c using the steps below:
   a. Locate the BI Migration Script available at the following location

   ```
   <12c_OBIEE_HOME>/user_projects/domains/bi/bitools/bin/migration-tool.sh
   ```

   b. Execute the migration-tool.sh package (as shown below) from

   ```
   <12c_OBIEE_HOME>/user_projects/domains/bi/bitools/bin/
   ```

   to create the BI migration tool jar file.

   c. Replace ORACLE_HOME with the actual path to the 12c Oracle Home you created while installing 12c.
d. Copy the bi-migration-tool.jar file from `<12c_OBIEE_HOME>/user_projects/domains/bi/bitools/bin` to Oracle 11g home.

For example:
```
cp bi-migration-tool.jar /scratch/bi_oradata_01/OBIEE_11.1.1.7.1_Home/Oracle_BII/
```

e. Export ORACLE_HOME to 11g OBIEE home. Execute the migration script to create an export bundle by running the following command:

```
java -jar $ORACLE_HOME/bi-migration-tool.jar out <11g_obiee_home> <11g_obiee_domain_home> /tmp/test_export.jar
```

For example:
```
java -jar $ORACLE_HOME/bi-migration-tool.jar out /scratch/bi_oradata_01/11g_obiee_home /scratch/bi_oradata_01/11g_obiee_domain_home /tmp/test_export.jar
```

The export should succeed without any errors.

f. Stop the OBIEE 12c services (if they are running) and export ORACLE_HOME pointing to 12c OBIEE home.

g. Run the following command to import 11g data in to the 12c system.

Provide the WebLogic user and password whenever prompted for.

```
./<12c_OBIEE_HOME>/user_projects/domains/bi/bitools/bin/migration-tool.sh in <export bundle> <service instance name>
```

For example:
```
./scratch/bi_oradata_01/12.2.1_FMW_infrastructure_OBI/user_projects/domains/obiee_domain/bitools/bin/migration-tool.sh in /scratch/migration-tool-test/test_export.jar ssi
```

If the migration is successful, the output is as follows:

For more detailed information about OBIEE data migration from 11g to 12c, refer to https://docs.oracle.com/middleware/1221/core/BIMIG/GUID-D0867450-1AEF-43DE-8144-7816F7105CB1.htm#BIMIG-GUID-D0867450-1AEF-43DE-8144-7816F7105CB1
Upgrading Oracle Utilities Analytics Dashboards Component

Copying and Decompressing Install Media

To download and decompress the install media:

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0 (Oracle Utilities Analytics V2.7.0 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to <TEMPDIR> below).

   This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Multiplatform.zip to <TEMPDIR>.

Starting the Installer

For an AIX Operating System, set the following environment variable before starting the Oracle Utilities Analytics installation:

export IBM_JAVA_OPTIONS="-Xmx2g  -XX:PermSize=64m -XX:MaxPermSize=3200m"

To start the installer:

1. Navigate to the temporary folder where you downloaded the install. Run the following command from the folder:

   java -jar <TEMPDIR>/OUA_2.7.0.0_generic.jar -logLevel finest

   Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

2. On the Welcome page, review the information before you begin the installation.

3. Click Next to continue with the installation.

4. Complete the installation by following the tasks on the navigation pane.

   Each item in the navigation pane represents a specific installer screen that prompts you for the information required to install the software.

Upgrade Steps

To install the Dashboards component:

1. Run the Oracle Utilities Analytics Installer.

2. On the Welcome page, review the available information before you begin the installation.

3. Click Next to continue with the installation. The Installation Location page appears.

4. Define the Installation Location here and click Next. The Select Installation Type page appears.

   Note: The specified Oracle home directory must be an empty directory or a directory where the OUA ODI ETL 2.7.0.0.0 component was installed successfully.

5. On the Select Installation Type page, select Dashboards and click Next. Enter the following details in the respective fields and click Next.

   Note: Based on the selected installation type, the options on the left navigation panel change. When you select Dashboard as an Installation Type, you need
to define Database and Java Home Details, Target Database Connection Details and OBIEE Home Details.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>Database client home location</td>
<td>Example: /u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>JDK home location</td>
<td>JDK 1.8 location</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
<td>/u01/jdk_1.8.0_77</td>
</tr>
</tbody>
</table>

The Target Database Connection Details page appears.

6. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

The OBIEE Home Details page appears.

7. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Home</td>
<td>The location on the disk where OBIEE is installed.</td>
<td>Example: /u01/Middleware/Oracle_BI1</td>
</tr>
<tr>
<td>BI Domain Home</td>
<td>The domain Home location under the directory where OBIEE is installed.</td>
<td>Example: /u01/Middleware/user_projects/domains/bifoundation_domain</td>
</tr>
</tbody>
</table>
Upgrading Oracle Utilities Analytics Dashboards Component

Upgrading Oracle Utilities Analytics from v2.6.0.0.2

Oracle Utilities Analytics Installation Guide

Note: You will be prompted for the Weblogic user’s password after installation.

The Installation Summary page appears.

8. Verify the installation options and click Install to begin the installation.

For any changes to the configuration before starting the installation, use the navigation pane and select the topic to edit.

9. The Installation Progress page appears allowing you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click Cancel will remain on your system, and it needs to be deleted manually.

10. On the Installation Completed page, click Finish to close the installer.

The Dashboards component is installed successfully.

Deploying Web Catalog

Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the location of the catalog.

To deploy the web catalogs:

1. Go to the <DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/root/shared directory.

2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities Analytics in the previous release.

   Ensure any custom catalog related files in this directory are backed up in a separate location before running deployBar.sh/cmd.

   If Oracle Utilities Network Management System BI Publisher reports were deployed, they should be retained.

3. Login to the Enterprise Manager.
4. Navigate to **Coreapplication > Deployment > Repository** for viewing the catalog location.

5. Go to the `<Catalog location>/root/system` directory and remove the `spatialmetadata` directory and `spatialmetadata.atr` file.

6. Follow the steps as below for UNIX and Windows respectively:
   - In Unix:
     a. Navigate to `<Install_Dir>/bin` directory.
     
     ```
     cd <Install_Dir>/bin
     ```
     
     b. Add Java 8 to the path variable as shown in example below:
     
     ```
     export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
     ```
     
     c. Run `ksh ./deployBAR.sh`.
   - In Windows:
     a. Navigate to `<Install_Dir>/bin` directory.
     
     ```
     cd <Install_Dir>\bin
     ```
     
     b. Add Java 8 to the path variable as shown in example below:
     
     ```
     set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
     ```
     
     c. Run `deployBAR.cmd`.

   The Web catalog is successfully deployed.

   **Note:** If there are any customizations on rpd, ensure to backup the rpd before executing `deployBAR.sh`/`deployBAR.cmd` to deploy the catalog. After deploying the catalog follow the instructions in Deploying Repository (RPD) File section to deploy RPD files.

For an AIX operating system, after the `deployBAR.sh/deployBAR.cmd` is completed successfully, execute the following command:

```bash
cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/service_instances/ssi/metadata/content/msgdb/l_en/customMessages
```

### Deploying Repository (RPD) File

If no changes are made to the deployed RPD, then take the RPD file from the following location, where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory:

```bash
<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd
```

If it was merged, then take the merged RPD and make the required database changes. Copy this RPD file to the Windows machine on which OBIEE 12.2.1 is installed.

To deploy the RPD file, follow these steps:

1. Ensure OBIEE 12.2.1 is installed on the Windows machine before proceeding.
2. Click **Start > Programs > Oracle Business Intelligence > Administration.**
3. Click **File > Open > Offline...** to open the RPD in offline mode.
4. Provide the RPD password. The default password is “oracle123”.
5. Double-click the **Connection Pools** to edit them.

- In the **Init Block Connection Pool** group, enter the following:
  
  Datasource name = BI Database name  
  User name = DWREAD  
  Password = DWREAD User password  

- In the **Init Block Pool - MDM** group, provide the following (only for Oracle Utilities Meter Data Management):
  
  Datasource name = MDM database name  
  User name = CISUSER  
  Password = CISUSER User password  

- In the **Init Block Pool - NMS Replication** group, provide the following (only for Oracle Utilities Network Management System):
  
  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

- In the **Materialized Views Connection** group, enter the following:
  
  Datasource name = BI Database name  
  User name = DWREAD  
  Password = DWREAD User password  

- In the **MDM Database Connection** group, provide the following (only for Oracle Utilities Meter Data Management):
  
  Datasource name = MDM database name  
  User name = CISUSER  
  Password = CISUSER User password
• In the **NMS Replication Tables** group, provide the following (only for Oracle Utilities Network Management System):
  
  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

  **Note**: The default schema name is NMS1REP. If the replication schema name is different, then rename it.

• In the **ODIDEV Connection Pool** group, provide the following:
  
  Datasource name = BI database name  
  User name = DWUSER  
  Password = DWUSER User password  

• In the **OUBI Database Connection** group, provide the following:
  
  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

6. Click **Save**.  

  **Note**: Click **Yes** when you see the prompt 'Do you wish to check global consistency?' and ignore any warnings that appear after consistency check is complete.

7. Copy the modified RPD back to the `<install dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd` where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory.
8. Login to the server where OBIEE Enterprise Manager is installed.
10. Run the following command to deploy the RPD:

   In Windows:
   
   data-model-cmd.cmd uploadrpd -I <OUA home>/Reports/rpd/UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -P <Weblogic password of OBIEE domain> -SI ssi

   In Unix:
   
   data-model-cmd.sh uploadrpd -I <OUA home>/Reports/rpd/UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -P <Weblogic password of OBIEE domain> -SI ssi

11. Run the following commands from <OBIEE DOMAIN>/bitools/bin directory to stop and start the OBIEE domain services respectively.

   stop.sh/cmd
   start.sh/cmd

### Configuring and Deploying the MapViewer

Configuring and deploying the MapViewer involves the following tasks:

- Configuring the MapViewer
- Modifying instanceconfig.xml
- Deploying Custom MapViewer
- Post-deploying Custom MapViewer

#### Configuring the MapViewer

To configure the Mapviewer, follow these steps:

1. Login to the WebLogic console.
2. Create the 'MAP_DS' datasource.
3. Lock and edit it.
4. Navigate to Services > Data Sources.
5. Select New > Generic Data Source and provide the following:

   Name = MAP_DS
   JNDI Name = MAP_DS
   Database Type = oracle

6. Click Next.
7. Enter the following:
   Database Driver = "Oracle's Driver (Thin) for Service connections; "Versions:Any"

8. Click Next.
9. On the next page, do not change any values. Click Next.
10. Enter the following connection properties:
• Database Name: BI Database Name
• Host Name: Database host
• Port: Database port
• Database User Name: dwadm
• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration. After the successful test, click Next again.

13. On the Select Target page, select AdminServer under Servers and bi_cluster under Clusters. Click Finish.

14. Click Activate Changes.

15. Update the mapViewerConfig file with the tags mentioned below:

   File location: <Install Dir>/user_projects/domains/<obiee_domain>/config/fmwconfig/mapviewer/conf
   File: mapViewerConfig.xml

16. If there is a proxy used, insert the list of host names for all the third-party service providers in the security_config node.

   <proxy_enabled_hosts>
   elocation.oracle.com
   </proxy_enabled_hosts>

17. Add the following ns_data_provider node:

   <ns_data_provider id="obieeNsdp"
   class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

18. Add the current map_tile_server with the following map_tile_server node:

   <map_tile_server>
   <tile_storage default_root_path="/mytilecache/"/>
   </map_tile_server>

Modifying instanceconfig.xml

Ensure you take a backup before updating the instanceconfig.xml file. Run the following commands in UNIX and Windows respectively to go to the directory containing the instanceconfig.xml file.

In Unix:

   <OBIEE_INSTALL_DIR>/user_projects/domains/<obiee_domain>/config/fmwconfig/biconfig/OBIPS

In Windows:

   <OBIEE_INSTALL_DIR>user_projects\domains\<obiee_domain>\config\fmwconfig\biconfig\OBIPS

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add the following code before </Serverinstance>:

   <Security>
   <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
   <HttpOnlyCookies>false</HttpOnlyCookies>
   <CookieDomain />

   </Security>
2. Update the following `<ServerInstance>` element:
   `<LightWriteback>true</LightWriteback>`

3. Add the following code between the `<ServerInstance>` `<ServerInstance>` tags.
   `<Prompts>
   `<MaxDropDownValues>256</MaxDropDownValues>
   `<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
   `<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
   `<AutoCompletePromptDropDowns>`
   `<SupportAutoComplete>true</SupportAutoComplete>
   `<CaseInsensitive>true</CaseInsensitive>
   `<MatchingLevel>MatchAll</MatchingLevel>
   `<ResultsLimit>50</ResultsLimit`
   `<AutoCompletePromptDropDowns>`
   </Prompts`
   `<SpatialMaps>`
   `<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>`
   </SpatialMaps`

### Deploying Custom MapViewer

The custom MapViewer is required to integrate weather information in Outage Analytics.

To deploy the custom MapViewer, follow these steps:

- **For Unix:**
  1. Navigate to the `<Install_Dir>/bin` directory.
     `cd <Install_Dir>/bin`
  2. Add Java 8 to the path variable (as shown in example below).
     `export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH`
  3. Run ksh `./deploymapviewer.sh`.
  4. Enter the WebLogic domain console password. For example: `weblogic123`

- **For Windows:**
  1. Navigate to the `<Install_Dir>/bin` directory.
     `cd <Install_Dir>/bin`
  2. Add Java 8 to the path variable (as shown in example below).
     `set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%`
  3. Run `deploymapviewer.cmd`.
  4. Enter the WebLogic domain console password. For example: `weblogic123`

### Post-deploying Custom MapViewer

Perform the following steps after deploying the custom MapViewer:

2. Update the MapViewer configuration.
   Navigate to **MapViewer > Administration > Configuration**.
Login to the Mapviewer at this location: http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the content below in the mapViewerConfig.xml file with appropriate values:

   <map_data_source name="mapconn" jdbc_host="<DB server name>
   jdbc_sid="/<DB Service name>" jdbc_port="1521" jdbc_user="DWADM"
   jdbc_password="!<DWADM user password>" jdbc_mode="thin"
   number_of_mappers="32" allow_jdbc_theme_based_foi="true"
   />

   **Note:** The exclamatory mark in the front of the password ensures that the
   password is encrypted.

4. Click **Save** and then restart.

   **Note:** The above step has to be performed each time after running the
deploymapviewer command.

### Enabling WriteBack

To enable the Write Back, perform the following steps:

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack >
   Write Back to Database.

2. Click **Denied:Authenticated User** and select the **Granted** permission.

### Enabling Auto Complete Feature in OBIEE

To enable the auto complete feature on OBIEE, perform the following steps:

1. Restart the OBIEE Admin server, Managed server, and opmn services.

   **Note:** Refer to OBIEE documentation for detailed instructions on how to start
   and stop admin server, managed server, and opmn services.

2. Login to Analytics.

   http://<Server>:<port>/analytics

3. Click **WebLogic User** (top-most-right section of the page).

4. From the drop-down menu, select **My Account**.

5. On the **Preferences** tab, set **Prompt Auto Complete** to **ON**.

6. Click **OK**.
Chapter 7

Upgrading Oracle Utilities Analytics from v2.5.0.0.5

The Oracle Utilities Analytics v2.7.0 release supports the following direct upgrade paths:

- v2.6.0.0.2 to v2.7.0
- v2.5.0.0.5 to v2.7.0

This chapter is applicable only to customers upgrading from Oracle Utilities Analytics v2.5.0.0.5 to v2.7.0.

Note: To upgrade from Oracle Utilities Analytics v2.6.0.0.2, refer to Chapter 6: Upgrading Oracle Utilities Analytics from v2.6.0.0.2 for instructions and details.

To upgrade to Oracle Utilities Analytics v2.7.0, you must first upgrade to Oracle Utilities Analytics v2.5.0.0.5 if on an earlier version. Ensure all pre-requisites (JDK, ODI, and ODI patch 23629220) are followed before beginning the upgrade process.

This chapter describes the procedure to upgrade to Oracle Utilities Analytics v2.7.0, including:

- Upgrading Oracle Data Integrator Based Oracle Utilities Analytics
- Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics
- Upgrading Oracle Utilities Analytics Administration Tool Component
- Upgrading Oracle Utilities Analytics Dashboards Component
Upgrading Oracle Data Integrator Based Oracle Utilities Analytics

This section explains the steps to upgrade Oracle Data Integrator based source applications (Oracle Utilities Customer Care and Billing and Oracle Utilities Operational Device Management). It includes the following:

- Prerequisites
- Upgrading Oracle Utilities Analytics Database Component
- Upgrading Oracle Utilities Analytics Based ELT Component
- Upgrading Source Applications to be Compatible with v2.7.0

Prerequisites

Ensure the required JDK 1.8.0(77) and Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI) are installed on Oracle Data Integrator server. Also, the target OBIEE applications should be down.

Follow the steps below as part of pre-requisites:

1. Login to the Oracle Utilities Analytics ODI server and start the ODI client.
   ```
   cd $ODI_HOME/odi/studio./odi.sh
   ```

2. Stop BI_RUN_ALL by following these steps:
   a. Login to Oracle Database Integrator Studio.
   b. Double click Global/WLS_AGENT and select Inactive.
   c. Save the changes.

3. On the Studio, navigate to the **Topology** tab.

4. Right-click **OracleDIAgent** and select **Update Schedule**.

5. Connect to the Oracle Utilities Analytics database.

   Run the query below to check that all jobs are completed.

   ```sql
   ```
SELECT *
FROM mdadm.b1_jobs_vw
WHERE status_flg NOT IN ('D', 'E', 'RP');

Note: No rows should be returned from the above query. If returned, the jobs are not yet complete. You must wait until all the jobs are completed.

6. Stop the Oracle Data Integrator admin and managed servers.
7. Stop the source application servers.
   Ensure the source applications are stopped, but the source databases are up and accessible.
8. Sync all the Oracle GoldenGate processes:
   a. Connect to the MDADM schema in Oracle Utilities Analytics database.
   b. Run the following SQL to get the context codes.
      Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';
   c. For each context returned by the query, perform the following steps:
      Note: Do not delete the extract, replicate GoldenGate processes. Configure the existing sources with same context during the upgrade.
      a. Connect to the source database corresponding to context code as sys user and execute the following command:
         alter system switch logfile
         select SEQUENCE# from v$Log where STATUS='CURRENT';
      b. Note down the result of the query.
      c. Connect to the MDADM schema in Oracle Utilities Analytics database and execute the SQL mentioned below:
         Select DB_HOST,GG_HOME from b1_gg_cfg where GG_CFG_CD='<Context_code>' to get source GoldenGate server and Oracle GoldenGate home on source server.
      d. Connect to the source GoldenGate server.
      e. Login to the source Oracle GoldenGate prompt.
         cd <GG_Home>
         ./ggsci
      f. Execute the following command:
         info extract <Context_codeXXX>,showch
         For example: info extract CCB1AAX,showch
         In the Recovery Checkpoint section, sequence should be = or > 1 returned by the query below:
         select SEQUENCE# from v$Log where STATUS='CURRENT'
      g. Repeat the check mentioned in the step f for each extract process.
      h. Ensure that the pump processes transfer all the changes to the target server. Lag at the Chkpt and Time Since Chkpt should be zero.
i. On the Oracle Utilities Analytics database server, ensure the replicat processes apply all changes for the context code.

- Connect to the MDADM schema in Oracle Utilities Analytics database and execute the query below to get the target server and GoldenGate Home details on the target server.

```
select DB_HOST, DB_SID, GG_HOST, GG_HOME from bl_gg_cfg
where GG_CFG_CD='B1';
```

- Connect to the target server and login to the GoldenGate prompt. Execute the following commands:

```
cd <GG_Home>
./ggsci
dblogin userid MDADM, password <MDADM user password> Send replicat <Context_codeXX>, status
```

The current status will be at EOF.

j. Check this for each ‘replicat’ process of the context code.

k. Ensure all extracts and replicates of all sources are in sync.

l. On the source database server, stop all the GoldenGate processes as below:

```
cd <GG_Home>
./ggsci
```

Execute the following commands:

```
dblogin userid < GoldenGate Owner >, password < GoldenGate Owner password>
stop <Context_code>* For example:
stop CCB1*
```

Stop the manager processes after all extract processes are stopped.

```
Stop mgr
```

Note: Note the source Oracle GoldenGate extracts context_codes of each source and source GoldenGate Owner info. This information is used while configuring the existing sources with same context during the upgrade.

m. Rename or backup the existing source GoldenGate Home on the source server.

Remember to note the GoldenGate manager port number and source GoldenGate home before renaming it.

For example:

```
mv <GG_Home> <GG_Home>.bkp
```

n. On the Oracle Utilities Analytics database server, ensure the replicate processes apply all changes for the context code. After checking the current status and each replicate process for the context code, execute the following commands:

```
Stop <Context_code>*
```

For example: stop CCB1*

o. After all source applications changes are in sync in the Oracle Utilities Analytics database, run the following command.
Ensure to run the command after connecting to the target GoldenGate Home prompt.

```
./ggsci
Stop mgr
```

p. Rename the existing target GoldenGate Home directory.

Note the GoldenGate manager port number and target GoldenGate home before renaming it.

It is recommended to take consistent backup of source and target databases after the source is synchronized with target.

9. Upgrade Oracle Utilities Analytics database to version 12.1.0.2.0.

10. Install Oracle GoldenGate 12.2.0.1.1 on Oracle Utilities Analytics database server. Start the manager process.

Note the GoldenGate home and manager port number. This is applicable only if the source application is using Oracle Data Integrator based ELT.

Install new Oracle Data Integrator 12.2.1 (both infrastructure and ODI softwares) and apply ODI 23629220 patch on Oracle Data Integrator server. The patch is available on My Oracle Support (http://support.oracle.com).

To summarize, a successful Oracle Data Integrator installation involves installing the following:

- JDK1.8.0(77)+
- Oracle Fusion Middleware Infrastructure 12.2.1
- ODI 12.2.1
- ODI patch 23629220

### Upgrading Oracle Utilities Analytics Database Component

This section describes the steps included to upgrade the Oracle Utilities Analytics database component:

- **Copying and Decompressing Install Media**
- **Creating Users and Tablespaces**
- **Installing RELADM Schema**
- **Installing MDADM Schema**
- **Installing DWADM Schema**

Before proceeding with upgrading the Oracle Utilities Analytics Database component, ensure the following are complete:

- Upgrading Oracle Utilities Analytics database to version 12.1.0.2.0.
- Installing Oracle GoldenGate 12.2.0.1.1 on Oracle Utilities Analytics database server.

### Copying and Decompressing Install Media

To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics v2.7.0 Oracle Database part (Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip) from Oracle Software Delivery Cloud (https://edelivery.oracle.com).
2. Create a temporary directory (such as c:\OUA\temp for a Windows machine or /OUA/ temp for a Linux machine).

   This directory (referred to as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.

Creating Users and Tablespaces

To create users and tablespaces follow these steps:

1. Ensure to create users in the database with the following names without giving specific roles (if these do not exist already):
   - DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

2. Connect as sys user and revoke the DBA privilege from the following users (if the DBA privilege has been granted to them):
   - DWADM, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

3. Ensure to create roles with the following names (if these do not exist already).
   - DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE

4. Connect as sys user and execute the Usersgrants.sql in /Scripts/Usersgrants.sql.
   
   This SQL provides the required grants to the created users.

5. Copy the DuplicateRecordCheck.sql file from the BI270\DWADM\Pre-Installation directory to the database server under ../<Temp> directory.

6. Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

   Note: If the system displays that no rows are selected, then proceed. If the system displays some data, then contact Oracle Support team and do not proceed with the installation. It is recommended to wait until you get the data fix script.

Installing RELADM Schema

The RELADM schema is a metadata schema that consists of the database objects used for storing the product version and component installation information.

This section describes the RELADM schema initial installation, including:

- Reviewing Storage.xml file
- Installation Steps
- Generating Database Statistics

Reviewing Storage.xml file

The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI270/ RELADM/Install- Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.

If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.
**Note:** If database does not have CISTS_01 tablespace or the RELADM user does not have quota on CISTS_01 tablespace, edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

**Installation Steps**

**Note:** Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows:

1. Add Java 8 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI270\RELADM\Jarfiles\*
   ```
3. Run OraDBI.jar as shown below:
   ```
   <ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,RELADM –j
   <JDK Home> -f <TEMPDIR>\BI270\RELADM\Jarfiles -v 1 -e true
   ```

In Unix:

1. Add Java 8 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI270/RELADM/Jarfiles/*
   ```
3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI \
   -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT> /<ORACLE
   SERVICE NAME>,
   RELADM,<Password of RELADM user>,,,,,RELADM \
   -j <JDK Home> -f <TEMPDIR>/BI270/RELADM/Jarfiles -v 1 -e true
   ```

The utility creates the RELADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect as sys user and execute the following command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
```

**Installing MDADM Schema**

The MDADM schema is a metadata schema that consists of the database objects used for storing the metadata of Oracle Utilities Analytics.

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes the MDADM schema initial installation, including:
Upgrading Oracle Data Integrator Based Oracle Utilities Analytics

- Reviewing Storage.xml File
- Installation Steps
- Generating Database Statistics

Reviewing Storage.xml File
The storage.xml file (comes with the product and is in location \<TEMPDIR>/BI270/MDADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or the MDADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which MDADM has quota.

Installation Steps
To install the MDADM schema, follow these steps:

**Note:** The process prompts you for the MDADM user password. Ensure to run the OraDBI.jar (in the step below) using JDK 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

- **In Windows:**
  1. Add Java 8 to the path variable as shown in the example below:
     ```
     set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     set CLASSPATH=\<TEMPDIR>\BI270\MDADM\Jarfiles\*
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI -d jdbc:oracle:thin:@\<DATABASE SERVER>:\<DATABASE PORT>\/<ORACLE SERVICE NAME>,MDADM,\<Password of MDADM user>,,,,,MDADM -j\<JDK Home> -f \<TEMPDIR>\BI270\MDADM\Jarfiles -v 1 -e true
     ```

- **In Unix:**
  1. Add Java 8 to the path variable as shown in example below:
     ```
     export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     export CLASSPATH=\<TEMPDIR>\BI270\MDADM\Jarfiles\*
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI \
     -d jdbc:oracle:thin:@\<DATABASE SERVER>:\<DATABASE PORT>\/<ORACLE SERVICE NAME>,MDADM,\<Password of MDADM user>,,,,,MDADM \n     -j \<JDK Home> -f \<TEMPDIR>\BI270\MDADM\Jarfiles -v 1 -e true
     ```
The utility creates the MDADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect as **sys user** and execute the following command:
`execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');`

Installing DWADM Schema
The DWADM schema contains star schema objects (such as facts and dimensions) that include entire data in the data warehouse.

This section describes the DWADM schema installation, including:
- Executing Pre-Installation SQL
- Reviewing Storage.xml File
- Installation Steps
- Generating Database Statistics
- Post-Installation Steps

Executing Pre-Installation SQL
To execute specific SQL scripts before proceeding with the installation, follow these steps:

1. Copy the following scripts to the database server under ../<Temp> directory.
   - …\Pre-Installation\PreInstallAddColumns.sql
   - …\Pre-Installation\PreIndexCreation.sql
2. Change the current directory to ../<Temp>.
3. Connect to the DWADM schema and execute PreInstallAddColumns.sql.
4. Connect to the DWADM schema and execute PreIndexCreation.sql.
5. Copy the following from BI270/DWADM/Pre-Installation/ to the database server under ../<Temp> directory. Execute them while connecting to the schema.
   - CF_BILLED_USAGE.sql
   - CF_CREW_TASK.sql
   - CF_CUST_RECENT_OUTG.sql
   - CF_CUST_RST_OUTG.sql
6. Copy refresh_mvs_where_mv_logs_outofsync.sql script from BI270/DWADM/Pre-Installation/ to the database server under ../<Temp> directory. Execute it while connecting to the schema.
7. Copy drop_out_of_sync_mv_logs.sql script from BI270/DWADM/Pre-Installation/ to the database server under ../<Temp> directory. Execute it while connecting to the schema.

Reviewing Storage.xml File
The storage.xml file (comes with the product and is in location <TEMPDIR>/BI270/DWADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate tables or indexes outside of the default tablespace, then this has to be...
reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or the DWADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which DWADM has quota.

**Installation Steps**

To install the DWADM schema, follow these steps:

**Note:** The process prompts you for the DWADM user password. Ensure to run the OraDBI.jar (in the step below) using JDK 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

- **In Windows:**
  1. Add Java 8 to the path variable as shown in the example below:
     ```
     set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     set CLASSPATH=<TEMPDIR>\BI270\DWADM\Jarfiles* 
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI -d nghiệp:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/ <ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM -j <JDK Home> -f <TEMPDIR>\BI270\DWADM\Jarfiles -v 1 -e true 
     ```

- **In Unix:**
  1. Add Java 8 to the path variable as shown in example below:
     ```
     export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     export CLASSPATH=<TEMPDIR>/BI270/DWADM/Jarfiles/*
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI \
     -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE NAME>,\n     DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM \
     -j <JDK Home> -f <TEMPDIR>/BI270/DWADM/Jarfiles -v 1 -e true
     ```

The utility creates the DWADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.
Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect as **sys user** and execute the command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

Post-Installation Steps
Perform these steps to complete the installation:

1. Connect to the Oracle Utilities Analytics database and execute the following:
   ```sql
   .../BI270/DWADM/Post-Upgrade\ControlZoneUpdate.sql
   ```
2. Connect to the Oracle Utilities Analytics database with the system user and execute the script mentioned below:
   ```sql
   .../BI270/DWADM/Post-Upgrade\DataCorrection2511.sql
   ```

Upgrading Oracle Utilities Analytics Based ELT Component
This section describes the steps included to upgrade the Oracle Utilities Analytics based ELT component:

- Configuring Oracle Data Integrator Repository Creation Utility (RCU)
- Setting up Oracle GoldenGate
- Copying and Decompressing Install Media
- Starting the Installer
- Upgrade Steps
- Creating WebLogic Domain for Oracle Data Integrator Agent
- Configuring Source Applications

Before proceeding with upgrading the Oracle Utilities Analytics based ELT component, ensure the following are complete:

- Installing JDK1.8.0(77)+
- Installing Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI)
- Applying Oracle Data Integrator patch 23629220

Configuring Oracle Data Integrator Repository Creation Utility (RCU)
To configure the Oracle Data Integrator Repository Creation Utility (RCU), follow these steps:

1. Ensure RCU for ODI is running and the required schemas are created in the target database.
   
   ODI_ORACLE_HOME is an Oracle Home path used as Oracle Home while installing FMW Infrastructure and Oracle Data Integrator.
   
2. Set or export JAVA_HOME variable to the 1.8.0_77+ installed directory.
3. Go to `$/ODI_ORACLE_HOME/oracle_common/bin`.
4. Run the RCU utility.
   
   For example:
   ```
   export JAVA_HOME=/scratch/bi_oradata_01/jdk1.8.0_77
cd/scratch/bi_oradata_01/12.2.1_FMW_infrastructure/oracle_common/bin
./rcu
   ```
5. On the **Select Components** wizard in RCU, navigate to the **Create Repository** tab and select **System Load and Product Load**. Click **Next**.

6. On the **Database Connection Details** tab, provide the database connection details. Click **Next**.

7. On the **Select Components** tab, select the options as shown in the screen below.

   ![Select Components Screen](image.png)

   Unselect the Oracle Data Integrator component. Click **Next**.

8. On the **Schema Passwords** tab, note the passwords given as they are required while creating the Oracle Data Integrator domain.

9. Navigate to the **Complete Summary** tab and click **Finish**.

   It is not required to create the Oracle Data Integrator domain at this stage. Create it after running the Oracle Utilities Analytics installer and before running the source configuration tool.

### Setting up Oracle GoldenGate

This section describes the following:

- **Setting up Oracle GoldenGate on Source Database Server**
- **Setting up Oracle GoldenGate on Target Database Server**
- **Setting Up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers**

#### Setting up Oracle GoldenGate on Source Database Server

**Note**: Before proceeding, start the source database and ensure it is accessible.

Bring down the source application server.

To set up each source instance, follow these steps:

1. Create a directory on the source database server. (For example: `../GoldenGate Home`). and install Oracle GoldenGate in that directory. It is Oracle GoldenGate home (OGG_Home) on the source database server.

   **Note**: Note this directory location; it is used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate.

3. Provide the Oracle GoldenGate Home location as the directory location created in the step 1.

4. Open a command terminal or window, and set the source ORACLE_SID and ORACLE_HOME variables.

5. Set the LD_LIBRARY_PATH as follows:
   - In Unix:
     ```
     export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
     ```
   - In Windows:
     ```
     set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%
     ```

6. In the Command window, change directory to the Oracle GoldenGate home directory, and execute the following command:
   - In Unix:
     ```
     ./ggsci
     ```
   - In Windows:
     ```
     ggsci
     ```
     The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order listed:
   - create SUBDIRS
   - start mgr - Starts the Oracle GoldenGate manager process.
   - info all - Verifies if the manager process is running.
   - exit - Exits Oracle GoldenGate.

8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as sys user and execute the following statements:
   ```
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. In the Command window, navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. Open the GOBALS file in the directory and add the below command:
    ```
    EnableMonitoring
    ```

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

13. Connect to the database as sys user using SQL*Plus.
    ```
    Ensure OGG_Home to be the current directory while invoking SQL*Plus.
    ```

14. Create a new user.
    ```
    For example: ODM01SRC
    ```
This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is not assigned to any other user.

**Note:** Ensure to note down the Oracle GoldenGate Owner Username. It is used in the Oracle Utilities Analytics installation.

15. Connect to the source database as **sys user**.

16. Execute the following commands:

   **Note:** Ensure to modify the GoldenGate owner placeholder with actual name of the database user created in step 14.

   ```sql
   grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
   grant unlimited tablespace to <GoldenGate owner> with admin option;
   EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>','capture');
   grant unlimited tablespace to <GoldenGate Owner> with admin option;
   grant create any view to <GoldenGate Owner>;
   grant select any dictionary to <GoldenGate Owner>;
   GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
   GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;
   ```

17. Connect to the `<source application>`ADM schema (such as CISADM). Execute the following commands:

   For **Oracle Utilities Customer Care and Billing** source database, execute the following grants:

   - Grant select on F1_MST_CONFIG to `<GoldenGate owner user created in step 16>`
   - Grant select on F1_EXT_LOOKUP_VAL to `<GoldenGate owner user created in step 16>`
   - Grant select on F1_BKT_CONFIG to `<GoldenGate owner user created in step 16>`
   - Grant select on F1_BKT_CONFIG_VAL to `<GoldenGate owner user created in step 16>`

   For **Oracle Utilities Operational Device Management** source database, execute the following grants:

   - Grant select on F1_MST_CONFIG to `<GoldenGate owner user created in step 16>`
   - Grant select on F1_EXT_LOOKUP_VAL to `<GoldenGate owner user created in step 16>`

   For **Oracle Utilities Meter Data Management** source database, execute the following grants:

   - Grant select on `<application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>`
   - Grant select on `<application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>`

   For **Oracle Utilities Work and Asset Management** source database, execute the following grants:

   - Grant select on `<application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>`
   - Grant select on `<application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>`;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

**Note:** While executing SQL commands in steps 15, 16, and 17, provide the GoldenGate owner user (if prompted for).

All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the database as **sys user**.

18. Execute the following commands in the order listed below:
   - `@marker_setup.sql`
   - `@ddl_setup.sql`
   - `@role_setup.sql`


20. In the Command window, create a directory “diroby” in the OGG_Home directory.

21. Change directory to the Oracle GoldenGate Home directory, and execute the following:
   - a. Steps in **Configuring Encrypting Data Using ENCKEYS Method**.
   - b. Steps in **Generating Shared Secret Password**.

   **Note:** Execute these steps before running the Oracle Utilities Analytics installer. See [http://docs.oracle.com/goldengate/c1221/gg-winux/index.html](http://docs.oracle.com/goldengate/c1221/gg-winux/index.html) for more details.

**Configuring Encrypting Data Using ENCKEYS Method**

To configure for encrypting data using the ENCKEYS method, do the following:

1. Execute the following command:
   ```
   cd <OGG_HOME>
   KEYGEN key_length n
   ```
   The above command generates the key value based on the value specified in the parameter “n”. The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

3. Repeat the step above for each key values generated.

4. Save the file with name ENCKEYS (Upper case only) without any extension.

   Example:
   ```
   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035DD6893205A7BD6773FA8E670
   ```

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

6. Input the Logical name, space and key value generated.

   Sample content of file ENCKEYS:
   ```
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ```
7. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

**Note:** It is recommended to name Logical key name after `<context_code>KEY`.

For example: If context code is CCB1, it is recommended to name it as CCB1KEY.

**Generating Shared Secret Password**

To generate the shared secret password, follow these steps:

1. Execute the following command:
   ```
   cd <OGG_HOME>
   ggsci
   ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
   ```
   **Example:**
   ```
   cd $OGG_HOME
   ./ggsci
   GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
   Encrypted password:
   AADAAAABAAAIAAIAVGNHBFLGFCHBTVCVBFBFJFUEJGNCFAOAFE0FBALELSFOEIFWGRBZHCMMGYYBDA2H
   Algorithm used: AES128
   ```

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and the generated encrypted password.

**Setting up Oracle GoldenGate on Target Database Server**

To set up Oracle GoldenGate on the target database server, follow these steps:

1. Create a directory on the target database server.

   **For example:** `../GoldenGateHome`

   Oracle GoldenGate should be installed in this directory. It is Oracle GoldenGate home (OGG_Home) on the target Oracle Utilities Analytics database server.

   **Note:** Ensure to note the directory location; it will be used in the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.

   Set LD_LIBRARY_PATH using the following commands:

   **In Unix:**
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   **For Windows:**
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib;%LD_LIBRARY_PATH%
   ```

4. In the Command window, change the directory to the GoldenGate home directory and execute the below command:
For Unix:
./ggsci

For Windows:
ggsci

The Oracle GoldenGate prompt is shown.

5. At the prompt, execute the following commands in the order listed below:
   • create SUBDIRS
   • start mgr - Starts the Oracle GoldenGate manager process.
   • info all - Verifies if the manager process is running.
   • exit

6. Create a directory “diroby” in the OGG_Home directory.

7. Connect to the target database as sys user and execute the below query:
   alter system set enable_goldengate_replication=TRUE scope=both;

8. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.

9. Edit the GLOBA LS file in the <GG home> directory and add the following command:
   EnableMonitoring

10. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. If the ENCKEYS file does not exist, follow these steps:
   a. Create and open a new ASCII ENCKEYS file.
   b. Add the key value/values that are generated on the sources to the ENCKEYS file in target OGG home. This is done for the context codes for which source is configured.

   A sample ENCKEYS file in target OGG home is as below:
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

Setting Up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers
Set up Oracle GoldenGate Monitor (OGG) JAgent on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers. The OGG Monitor JAgent is used to automatically copy the generated OGG scripts to both source and target GoldenGate Home directories, and to start the extract and replicate processes on source and target.

To setup OGG Monitor JAgent on both target and source database servers, follow these steps:

1. Ensure Oracle GoldenGate is installed and manager is running.

2. Start the rmiregistry services using the following command:
   rmiregistry 5559 &
   Ensure to note down the port on which RMI server is started. The port number specified here is 5559. If it is not specified, the default port 1099 will be used.

3. Install Fusion Middleware Infrastructure.

4. Run the OGG Monitor 12.2.1 installer.
   a. Set Oracle Home to the location where Fusion Middleware Infrastructure was installed in step 2.
b. Choose installation type as OGG Monitor Agent.

5. Edit the Config.properties file in the <OGG Monitor home>/oggmon/ogg_agent/cfg_templates and add/modify the below parameters.

   <ACTUAL>   : jagent.host=localhost
   <CHANGE TO> : jagent.host=<actual hostname on which OGG is installed>>

   <ACTUAL>   : monitor.jmx.username=cmroot
   <CHANGE TO> : monitor.jmx.username=jmx_src

   <ACTUAL>   : jagent.username=root
   <CHANGE TO> : jagent.username=<OGG software installed OS user>>

   <ACTUAL>   : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started

   <ACTUAL>   : agent.type.enabled=OGGMON
   <CHANGE TO> : agent.type.enabled=OEM

   <ACTUAL>   : jagent.backward.compatibility=true
   <CHANGE TO> : jagent.backward.compatibility=false

6. Add the following parameter:

   jagent.ssl=false

7. Navigate to <OGG Monitor home>/oggmon/ogg_agent directory and run the below command:

   In Unix:
   export JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.sh

   In Windows:
   set JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.bat

   a. You will be prompted to enter:

   • Oracle GoldenGate Home directory.
   • Path to be used for Oracle GoldenGate Monitor Agent instance.

   It is recommended to provide a path (such as <OGG Monitor home>/Agents/OGGMonitorInstance).

   • A unique name to replace the timestamp in the name of the file used to start GG Monitor agent instance.

   Provide a unique name to be used for this Oracle GoldenGate Monitor instance.

   b. Execute the command below from <path used for OGG Monitor instance provided in the step above>/bin.

   Example location: <OGG Monitor home>/Agents/OGGMonitorInstance/bin

   In Unix:
   export JAVA_HOME=<JDK home>
   ./pw_agent_util.sh -jagentonly
In Windows:

```
set JAVA_HOME=<JDK home>
pw_agent_util.bat -jagentonly
```

8. Enter the Oracle wallet password.

This password has to be entered as the password for the JAGENT while running the installer (for target gg), and while running the source configuration (for source gg). Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is required in subsequent installation.

9. Create a folder with the Context_code name in <GG Home>/dirdat.

For example: If WAM2 is created for the WAM source, then create a folder with name “WAM2” within the <GG Home>/dirdat/ folder.


Replace COMMAND java with COMMAND <JDK Home>/bin/java.

This ensures that the correct version of java (1.8) is used while starting JAgent.

11. Navigate to OGG_Home directory and run the following command at the Oracle GoldenGate prompt:

```
ggsci
```

12. Start the jAgent process using the following command:

```
start jagent
```

The logs for JAgent are created at the following (example) location.

```
<OGG Monitor home>/Agents/OGGMonitorInstance/logs
```

### Copying and Decompressing Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.7.0 Multiplatform part ([Oracle Utilities Analytics V2.7.0 Multiplatform.zip](https://edelivery.oracle.com)) from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to `<TEMPDIR>` below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Multiplatform.zip to `<TEMPDIR>`.

### Starting the Installer

For an AIX Operating System, set the following environment variable before starting the Oracle Utilities Analytics installation:

```
export IBM_JAVA_OPTIONS="-Xmx2g  -XX:PermSize=64m -XX:MaxPermSize=3200m
```

To start the Oracle Data Integrator Based ELT component, follow these steps:

1. Go to the temporary folder containing the installer.

2. Run the following command from this folder:

```
java -jar <TEMPDIR>/OUA_2.7.0.0.0_generic.jar -logLevel finest
```
Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

The Welcome page appears.

3. Review this information before you begin the installation. Click Next to continue with the installation.

4. Complete the tasks on the navigation pane.

Each item in the navigation pane represents a specific installer screen that prompts you for information required to install the software.

- If you select Oracle Data Integrator Based ETL as an Installation Type, define the following:
  - Database and Java Home Details
  - Target Database Connection Details
  - Oracle Data Integrator Home and Schema Details
  - Oracle Data Integrator Agent and Repository Details
  - Target GoldenGate Details
  - Target JAgent Details

- If you select Dashboard as an Installation Type, define the following:
  - Database and Java Home Details
  - Target Database Connection Details
  - OBIEE Home Details

- If you select both Oracle Data Integrator Based ETL and Dashboard as an Installation Type, define the following:
  - Database and Java Home Details
  - Target Database Connection Details
  - Oracle Data Integrator Home and Schema Details
  - Oracle Data Integrator Agent and Repository Details
  - Target GoldenGate Details
  - Target JAgent Details
  - OBIEE Home Details

Upgrade Steps
To install Oracle Data Integrator Based ETL, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears.

   Review the information on the Welcome page before you begin the installation.

2. Click Next to continue with the installation.

3. On the Installation Location page define an installation location/directory and click Next.

4. On the Select Installation Type page, select ODI Based ETL. Click Next.

   Note that the options on the left navigation pane change based on the selected installation type.
5. Select **Oracle Data Integrator Based ETL** as the **Installation Type**.

6. Define the following and click **Next**.
   - Database and Java Home Details
   - Target Database Connection Details
   - Oracle Data Integrator Home and Schema Details
   - Oracle Data Integrator Agent and Repository Details
   - Target GoldenGate Details

7. On the **Database and Java Home Details** page, enter the following in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>The database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>The JDK home location.</td>
<td>Provide location of JDK 1.8.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.8.0_77</td>
</tr>
</tbody>
</table>

8. On the **Target Database Connection Details** page, enter the following in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database.</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>
9. On the **ODI Home and Schema Details** page, enter the following in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>The directory where Oracle Data Integrator (ODI) has been installed.</td>
<td>Example: <code>/u01/12.2.1_FMW_infrastructure_home</code></td>
</tr>
<tr>
<td>Supervisor User</td>
<td>The name of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>The password of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm the password of the Supervisor here.</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name.</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>The password of the master repository schema.</td>
<td>OUA_MASTER user's password</td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator master repository schema here.</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name.</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>The password of the work repository schema.</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator work repository schema here.</td>
<td></td>
</tr>
</tbody>
</table>

10. On the **ODI Agent and Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Agent Host</td>
<td>The host on which Oracle Data Integrator WebLogic domain is created.</td>
<td>Oracle Data Integrator server host name.</td>
</tr>
<tr>
<td>ODI Agent Port</td>
<td>The port on which Oracle Data Integrator WebLogic agent is configured to run. This is the port of Oracle Data Integrator WebLogic Managed Server Port.</td>
<td>Provide available port and ensure to use the same port while creating Oracle Data Integrator managed server.</td>
</tr>
</tbody>
</table>
11. On the **Target GoldenGate Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host on the Oracle GoldenGate Manager.</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
<tr>
<td>Target Database Home</td>
<td>The database home installed location on the target database server. In case Oracle GoldenGate for target is not installed on the OUA database server, provide oracle client home location on the server on which Oracle GoldenGate is installed.</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the Oracle GoldenGate host.</td>
<td>The default value is 7830</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>The algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>The Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>The shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT Provide the result as the value.</td>
</tr>
</tbody>
</table>

12. On the **Target JAgent Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Host</td>
<td>The host of Oracle GoldenGate Monitor JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>The Oracle GoldenGate installed location where Oracle GoldenGate Monitor JAgent is running.</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
</tbody>
</table>
13. On the Installation Summary page, verify the installation options you selected.

14. Click Install to begin the installation.

To change any configurations before starting the installation, use the navigation pane and select the topic to edit.

The Installation Progress page appears displaying the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The detailed logs of the installation are also available in the logs/system directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click Cancel will remain on your system, and you will have to remove it manually.

15. On the Installation Completed page, click Finish to close the installer.

The Oracle Data Integrator based ETL is now installed.

Creating WebLogic Domain for Oracle Data Integrator Agent

Create the WebLogic Domain to bring up the WebLogic Agent (ODI Agent) to complete the steps. In this product release, ODI Domain creation is automated, and creation of both clustered and non-clustered domain is supported.

- Creating a Non-Clustered Domain
- Creating a Clustered Domain

Note: The following procedures assume that the pre-requisite Java 8/bin is in the PATH variable.

Creating a Non-Clustered Domain

To create a non-clustered domain, follow these steps:

Note: The password fields’ values (RCUSCHEMAPWD,WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory fields</td>
<td></td>
</tr>
</tbody>
</table>
Upgrading Oracle Data Integrator Based Oracle Utilities Analytics

Upgrading Oracle Utilities Analytics from v2.5.0.0.5

Oracle Utilities Analytics Installation Guide

2. Navigate to the `<OUA Environment>/bin` directory and invoke the `createDomain.sh/cmd` script.

Refer to the sections `Starting WebLogic Admin Server` and `Starting Managed Server` to start the admin server and managed server.

Creating a Clustered Domain

To create a clustered domain, follow the steps below:

**Note:** The password fields’ values
(RCUSCHEMAPWD,WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the `<OUA Environment>/etc` directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN_PATH</td>
<td>In Windows environment, replace “\” with “/” in the domain path.</td>
</tr>
<tr>
<td></td>
<td>For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI_DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td>ODI_DOMAIN_HOSTNAME</td>
<td>Host name on which the ODI domain is created</td>
</tr>
<tr>
<td>NONSSL_PORT</td>
<td>If not specified, default port 7001 will be assigned.</td>
</tr>
<tr>
<td>MANAGED_SERVER_PORT</td>
<td>If not specified, default port 15101 will be assigned.</td>
</tr>
</tbody>
</table>

2. Navigate to the `<OUA Environment>/bin` directory and invoke the `createDomain.sh/cmd` script.

Refer to the sections `Starting WebLogic Admin Server` and `Starting Managed Server` to start the admin server and managed server.

Creating a Clustered Domain

To create a clustered domain, follow the steps below:

**Note:** The password fields’ values
(RCUSCHEMAPWD,WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the `<OUA Environment>/etc` directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory fields</td>
<td></td>
</tr>
</tbody>
</table>

Upgrading Oracle Utilities Analytics from v2.5.0.0.5 7-25
Oracle Utilities Analytics Installation Guide
2. Navigate to the <OUA Environment>/bin directory and invoke the `createDomain.sh/cmd` script.

   This creates an ODI domain with an Admin server and a Managed server (as ‘ODI_server1’) and assigned to the cluster.

   Refer to the Starting WebLogic Admin Server and Starting Managed Server sections to start the Admin server and Managed server.

To create another managed server and add it to the cluster, follow these steps:

1. Bring up the Admin server.

2. Navigate to the <OUA Environment>/etc directory and provide the following mandatory properties in the ODI_CONFIG.properties file:
   - MANAGED_SERVER_NAME
   - MANAGED_SERVER_PORT

3. Provide the following optional properties in the ODI_CONFIG.properties file:
   - MACHINE_NAME
   - MACHINE_PORT


   A new managed server is created with the specified name and assigned to the cluster.

---

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN_PATH</td>
<td>In Windows environment, replace “\” with “/” in the domain path.</td>
</tr>
<tr>
<td></td>
<td>For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5</td>
</tr>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring Oracle Data Integrator Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI_DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td>ODI_DOMAIN_HOSTNAME</td>
<td>Host name on which the ODI domain is created</td>
</tr>
<tr>
<td>CLUSTER_NAME</td>
<td>Additional mandatory field for clustered domain</td>
</tr>
</tbody>
</table>
Refer to the sections Starting WebLogic Admin Server and Starting Managed Server to start the Admin server and Managed server.

Starting WebLogic Admin Server
To start the WebLogic Admin server, perform the following steps:
1. In the command shell, change the directory to the directory of the WLS Home.
   \<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin
2. Execute the startweblogic command:
   In Unix:
   nohup ./startWebLogic.sh > startWebLogic.log &
   In Windows:
   startWebLogic.cmd

Starting Managed Server
To start the odi_server1 managed server, follow these steps:
1. Change the directory to WLS Home to start odi_server1:
   In Unix:
   \<MW_HOME>/user_projects/domains/odi_domain/bin
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
   In Windows:
   StartManagedWeblogic.cmd odi_server1
2. In the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent.
3. Right-click OracleDIAgent and click Test to test the connectivity of the configured Oracle Data Integrator Java EE agent.

Executing Post-Upgrade Script
To execute the post-upgrade script, follow these steps:
1. Execute B1_MDFIX_ODM_270 in global context.
2. Login to ODI Client and navigate to Designer > Load Plans and Scenario folders.
4. Right-click B1_MDFIX_ODM_270, click Run, and then select the context as Global.
5. Click OK.

Creating a Database Directory
Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each source database. This directory is used for logging the export import task used during the initial ELT load.

The following sample SQL creates a database directory pointing to the file system path /scratch/file_data:
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
Configuring Source Applications

This section describes the instructions to be followed to configure source applications.

- Prerequisites
- Configuration Steps

Bring down the source application server, and ensure the source applications are stopped but source databases are up and accessible.

Prerequisites

Before running the source configuration tool, ensure Oracle Data Integrator domain is created, and admin and managed servers are running and accessible.

Configuration Steps

To configure the source applications, perform the following steps:

1. Register a source application.

   For instructions to register a source, refer to the Registering a Source section in Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

2. Ensure to use the same context_codes to configure the existing sources during the upgrade.

3. After running config.sh GUI utility, run B1_SYNC_CONTEXT as follows.
   a. Login to Oracle Data Integrator Studio.
   b. Navigate to Designer > Load Plans and Scenarios > Framework.
   c. Right-click B1_SYNC_CONTEXT and select Run.

4. Select the context related to the source application, <no agent> as logical agent, and then click OK.

5. Run the B1_INITIAL_SETUP_PKG package.
Note: It is recommended to run B1_INITIAL_SETUP_PKG only once (after all the sources have been configured or after at least one source is configured).

a. Login to Oracle Data Integrator Studio.

b. Navigate to Designer > Load Plans and Scenarios > Framework.

c. Right-click B1_INITIAL_SETUP_PKG, select GLOBAL context code, and then select Run.

6. Start all Oracle GoldenGate processes on source and target:

   a. Login into each source application GoldenGate server.

   b. Go to the respective Oracle GoldenGate Home directory.

   c. Start manager, JAgent, and all respective context extract processes.

   d. Login to the target (Oracle Utilities Analytics) GoldenGate server.

   e. Go to the Oracle GoldenGate Home directory.

   f. Start manager, jagent and all respective context extract processes.

Upgrading Source Applications to be Compatible with v2.7.0

Before proceeding, ensure the source applications are compatible with Oracle Utilities Analytics v2.7.0. Refer to the Supported Source Application Versions section in Chapter 3: Planning the Installation for supported source applications’ versions.

Ensure the following:

- Source applications’ databases must be in archive log mode during their upgrade.
- Oracle GoldenGate processes should be up and running on both source and target during the source applications upgrade.
- Upgrade the Source application system as certified with OUA 2.7.0 but do not upgrade database software version.

After a successful source upgrade, do not release source applications for end users. Ensure the source applications are stopped, but source databases are up and accessible.

1. Login to the Oracle Utilities Analytics GoldenGate server.

2. Go to Oracle GoldenGate Home and run the shell script restart.sh from BI270/Scripts/restart.sh.

   This shell script starts the replicate processes that are stopped due to the DDL changes in source system. Once all the DDL changes are in sync with the replication schema, the shell script is automatically terminated.

   Monitor the restart.sh execution. Proceed with the next steps only when it is complete.

3. Validate that all columns are in sync.

4. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the below query.

   The query should not return any records.

   ```sql
   select TABLE_NAME, COLUMN_NAME
   from DBA_TAB_COLUMNS@<CONTEXT_CODE>_LINK DTC
   where OWNER = 'SOURCE_APPLICATION_SCHEMA'
   and exists (select 1
   from MDADM.B1_REPLICATION_CFG_VW a
   where a.TABLE_NAME = DTC.TABLE_NAME)
   ```
and CONTEXT_CD = '<CONTEXT_CODE>'
AND (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
MINUS
select TABLE_NAME, COLUMN_NAME
from DBA_TAB_COLUMNS
where OWNER = '<CONTEXTCODE>REP'
and COLUMN_NAME not like 'JRN%';

Following is an example query for ODM1 context.

select TABLE_NAME, COLUMN_NAME
from DBA_TAB_COLUMNS@ODM1_LINK DTC
where OWNER = 'CISADM'
and exists (select 1
from MDADM.B1_REPLICATION_CFG_VW a
where a.TABLE_NAME = DTC.TABLE_NAME
and CONTEXT_CD = 'ODM1'
AND (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
MINUS
select TABLE_NAME, COLUMN_NAME
from DBA_TAB_COLUMNS
where OWNER = 'ODM1REP'
and COLUMN_NAME not like 'JRN%';

5. If no source database software upgrade is required, it is not required to perform any kind of cleanup of Oracle GoldenGate processes.

In this case, do the following:

• Start all Oracle GoldenGate processes on source and target.
• Start the source app server and release the environment.

This indicates that the upgrade processes are complete.

Perform the following steps to cleanup the Oracle GoldenGate processes.

Note: The following procedure is only required when it is required to upgrade the source database software.

1. Connect to the MDADM schema in the Oracle Utilities Analytics database and execute the SQL mentioned below to get all the context codes.

   Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';

2. For each context returned by the query, perform the following steps:

   a. Execute the SQL mentioned below to get source Oracle GoldenGate database server, SID, and Oracle GoldenGate host, home on source server:

      Select DB_HOST, DB_SID, GG_HOST, GG_HOME, GG_CFG_CD from b1_gg_cfg
where GG_CFG_CD='<Context_code>'

   b. Connect to the source database corresponding to context code as sys user and execute the following command:

      alter system switch logfile
select SEQUENCE# from v$Log where STATUS='CURRENT';

   c. Note the result of the query mentioned above.

   d. Connect to the source Oracle GoldenGate server and log into the source Oracle GoldenGate prompt.

      cd <GG_Home>
      ./ggsci
e. Execute the following command:
   
   info extract <Context_codeXXX>,showch
   For example, info extract CCB1AAX,showch

f. In the **Recovery Checkpoint** section, sequence should be $\geq 1$ returned by the following query:
   
   ```sql
   select SEQUENCE# from v$Log where STATUS='CURRENT'
   ```

   Repeat the check mentioned in the step e for each extract process.

f. Ensure that the pump processes transfer all the changes to the target server. Lag at the **Chkpt** and **Time Since Chkpt** should be 0.

h. On the source database server, drop all the Oracle GoldenGate processes by following these steps:

   a. Execute the following query to get the Oracle GoldenGate Owner name in the source database:
      
      ```sql
      select SCHEMA_NAME
      from MDADM.B1_CONTEXT_CFG_VW
      where LSCHEMA_NAME = 'Journal'
      and CONTEXT_CD = '<Context_code>';  
      ```

   b. Login to the source Oracle GoldenGate prompt.
      
      cd <GG_Home>
      ./ggsci

   c. Execute the following commands:
      
      ```sql
      dblogin userid <GoldenGate Owner >,PASSWORD <GoldenGate Owner password>
      stop <Context_code>*
      ```

      For example:
      
      ```sql
      stop CCB1*
      delete <Context_code>*
      ```

      For example:
      
      ```sql
      delete CCB1*
      ```

   d. Stop JAgent and stop manager:
      
      Stop jagent
      Stop mgr

   **Note**: Note the source Oracle GoldenGate extracts context_codes of each source and source Oracle GoldenGate Owner info. The existing sources will be configured with same context during the upgrade.

   h. Connect as a **sys user** of the source database server and execute the following command:
      
      ```sql
      <GG_Home>/ddl_disable.sql
      ```

   i. Rename the existing source Oracle GoldenGate Home on the source server.

   ```plaintext
   Note: Rename the existing source Oracle GoldenGate Home on the source server.
   ```

   Note the Oracle GoldenGate manager port number and source Oracle GoldenGate home before renaming it.

   ```plaintext
   For example: mv <GG_Home> <GG_Home>.bkp
   ```
j. On the Oracle Utilities Analytics database server, ensure the replicate processes apply all changes for the context code.

- Connect to the MDADM schema in Oracle Utilities Analytics database. Run the following query to get the target server and Oracle GoldenGate Home details on the target server.

```sql
select DB_HOST, DB_SID, GG_HOST, GG_HOME from b1_gg_cfg where GG_CFG_CD='B1';
```

- Connect to the target server and log in to the Oracle GoldenGate prompt.

- Execute the following:

```bash
cd <GG_Home>
./ggsci
Dblogin userid MDADM, password <MDADM user password>
Send replicat <Context_codeXX>,status
```

The current status will be at EOF.

- Check this for each replicate process for the context code and ensure the replicate processes completed writing all the changes.

- After checking the current status and after changes are in sync, for each replicate process for the context code, execute the following:

```bash
Stop <Context_code>*
For example: stop CCB1*
Delete <Context_code>*
For example: delete CCB1*
```

3. After all source application’s changes are in sync in the Oracle Utilities Analytics database, execute the following command after connecting to the target GoldenGate Home prompt.

```bash
./ggsci
start mgr
start jagent
```

4. Upgrade source application databases.

- If the source database version is prior to 11.2.0.4, then upgrade to 11.2.0.4 or a later version.
- If the source database version is on 12c version, then 12.1.0.2 is mandatory.

5. Set up Oracle GoldenGate with the newly upgraded database software Oracle Home directory on source.

a. Create a directory on the source database server.

For example: ../GoldenGate Home.

Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home (OGG_Home)** on the source database server.

Ensure to note this directory location; it will be used during the Oracle Utilities Analytics installation.

b. Install Oracle GoldenGate and provide the Home location as the directory location created in the step a.

c. Open a command terminal or window, and set the source ORACLE_SID and ORACLE_HOME variables.
Set LD_LIBRARY_PATH using the following commands:

In Unix:
```
export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
```

In Windows:
```
set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%
```

d. In the Command window, change the directory to the Oracle GoldenGate Home directory, and execute the command:

In Unix:
```
./ggsci
```

In Windows:
```
ggsci
```

This opens the Oracle GoldenGate prompt.

a. On the Oracle GoldenGate prompt, execute the following commands:

```
create SUBDIRS
start mgr
info all
Exit
```

b. Ensure that the source database is in the archivelog mode.

c. Connect to the source database as sys user and execute the below statements:

```
alter database add supplemental log data (primary key) columns;
alter system set enable_goldengate_replication=TRUE scope=both;
```

e. Go to the Oracle GoldenGate home (OGG_Home) directory. Connect as sys user and execute the following commands.

**Note:** While executing the SQL commands in the steps l, m and n, provide the Oracle GoldenGate owner user if prompted for. All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting as sys user.

```
@marker_setup.sql
@ddl_setup.sql
@role_setup.sql
```

f. Exit the SQL*Plus login and create a directory ‘diroby’ inside OGG_Home directory.

g. Change the directory to the Oracle GoldenGate Home directory, and execute the next steps.

6. Configure the encrypting data with the ENCKEYS method.

a. Execute the following command:

```
cd <OGG_HOME>
KEYGEN key_length n
```

The above command generates the key value based on the value specified in the parameter “n”. The key value has to be copied to ENCKEYS file against a logical name.
b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values).

   Enter the logical name space and then key value in the ENCKEYS file.

c. Repeat the step above for each key values generated.

d. Save the file with name ENCKEYS (Upper case only) without any extension.

   Example:
   
   ```bash
cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670
```

e. Open a new ASCII ENCKEYS file, if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

f. Input the logical name, space and key value generated.

   Example contents of file ENCKEYS:

   ```plaintext
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ``

g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

   Note: It is recommended to name Logical key name after `<context_code>KEY`. For example: if context code is CCB1, it is recommended to name CCB1KEY.

7. Generate the shared secret password.

   a. Run the following commands:

   ```bash
cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
```

   Example:

   ```bash
cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
Encrypted password:
AADAAAADAAAAATTAVGNHBFLGCHBFTBVBFJHEUJGNCFAOAE0FBALELISFOEIFW
GRBZHCMMGYGBDAZK
Algorithm used: AES128
```

   b. Note down the above generated ENCKEYS file logical name/key value, algorithm name used, and the generated encrypted password.

8. Set up Oracle GoldenGate Monitor JAgent on the source database servers. Proceed with the steps below.

   Oracle GoldenGate Monitor JAgent should be setup on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers. The OGG Monitor JAgent will be used to automatically copy generated Oracle GoldenGate scripts to both source and target GoldenGate homes and to start the extract and replicat processes on source and target.

   After the Oracle GoldenGate software is installed and the manager is running, configure the Oracle GoldenGate Monitor JAgent.
Follow these steps to setup GoldenGate Monitor JAgent on both target and source servers:

1. Start the rmiregistry services.
   
   Note the port on which RMI server is started. Use the following command:
   
   rmiregistry 5559 &
   
   Here, port number specified is 5559. If the port number is not specified, the default port 1099 is used.

2. Install Fusion Middleware Infrastructure.

3. Run the Oracle GoldenGate Monitor 12.2.1 installer.
   
   a. Set Oracle Home to the location where Fusion Middleware Infrastructure was installed.
   
   b. Choose the installation type as Oracle GoldenGate Monitor Agent.
   
   c. Edit the Config.properties file in the `<OGG Monitor home>/oggmon/ogg_agent/ cfg_templates` and add or modify the below parameters.
   
   `<ACTUAL>`: jagent.host=localhost
   `<CHANGE TO>`: jagent.host=<<actual hostname on which OGG is installed>>
   
   `<ACTUAL>`: monitor.jmx.username=cmroot
   `<CHANGE TO>`: monitor.jmx.username=jmx_src
   
   `<ACTUAL>`: jagent.username=root
   `<CHANGE TO>`: jagent.username=<<OGG software installed OS user>>
   
   `<ACTUAL>`: jagent.rmi.port=5559
   `<CHANGE TO>`: jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started
   
   `<ACTUAL>`: agent.type.enabled=OGGMON
   `<CHANGE TO>`: agent.type.enabled=OEM
   
   `<ACTUAL>`: jagent.backward.compatibility=true
   `<CHANGE TO>`: jagent.backward.compatibility=false
   
   d. Add the following parameter:
   
   jagent.ssl=false
   
   e. Navigate to `<OGG Monitor home>/oggmon/ogg_agent` directory and run the below command:
   
   For Unix:
   
   export JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.sh
   
   For Windows:
   
   set JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.bat
   
   f. Enter the following:
   
   - OGG home directory
   - Path to be used for OGG Monitor Agent instance. It is recommended to provide a path, such as `<OGG Monitor home>/Agents/OGGMonitorInstance.`
Upgrading Oracle Data Integrator Based Oracle Utilities Analytics

- A unique name to replace the timestamp in the name of the file used to start GG Monitor agent instance.
- A unique name used for this OGG Monitor instance.

4. Execute the following command from the <path used for OGG Monitor instance provided in the step above>/bin:

Example location <OGG Monitor home>/Agents/OGGMonitorInstance/bin

In Unix:

```bash
export JAVA_HOME=<JDK home>
./pw_agent_util.sh -jagentonly
```

In Windows:

```cmd
set JAVA_HOME=<JDK home> pw_agent_util.bat -jagentonly
```

5. Enter the Oracle wallet password.

This password has to be entered as the password for the JAGENT while running the installer (for target GG) and while running source configuration (for source GG).

Note the password and jagent.rmi.port value (JAgent Port). This information is required in subsequent installation.

6. Create a folder with the Context_code name in <GG Home>/dirdat.

For example: If WAM2 is the context being created for the WAM source then create a folder with name “WAM2” within the <GG Home>/dirdat/ folder.

7. Create a folder with name ‘<GG Home>/diroby’.

8. Navigate to <GG Home>/dirprm and edit the jagent.prm file.

9. Replace COMMAND java with COMMAND <JDK Home>/bin/java.

This ensures that the correct version of Java (1.8) is used while starting JAgent.

10. Navigate to OGG_Home directory > GoldenGate prompt:

    ```
    ggsci
    ```

11. Start the jAgent process using the following command:

    ```
    start jagent
    ```

    The logs for JAgent are created at the following (example) location:
    <OGG Monitor home>/Agents/OGGMonitorInstance/logs

12. Configure the source applications.

    - Bring down the source application server.
    - Ensure the source applications are stopped, but the source databases are up and accessible.
    - Ensure that manager and Jagent processes are running on all the sources and target database systems before executing config.sh.
    - Ensure Oracle Data Integrator (ODI) domain is created, and Admin and managed servers are running before running the source configuration tool.
Perform the steps below to configure the applications:

a. To register a source, follow the instructions described in the Registering a Source section in Chapter 5: Configuring Oracle Utilities Analytics in the Oracle Utilities Analytics Administration Guide.

b. Use the same context_codes to configure the existing sources during the upgrade.

c. After executing config.sh GUI utility, start all the OGG processes on source and target:
   a. Login to each source application GoldenGate server.
   b. Go to the respective Oracle GoldenGate Home directory.
   c. Start manager, JAgent, and all the respective context extract processes.
   d. Login to the target Oracle Utilities Analytics GoldenGate server.
   e. Go to the Oracle GoldenGate Home directory.
   f. Start manager, Jagent, and all the respective context extract processes.

d. Start the source application server and release the source system environment.

The upgrade process is complete.

Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics

This section explains the steps to upgrade Oracle Warehouse Builder based source applications (Oracle Utilities Mobile Workforce Management and Oracle Utilities Meter Data Management). It includes the following:

• Prerequisites
• Upgrading Oracle Utilities Analytics Database Component
• Installing RELADM Schema
• Installing MDADM Schema
• Installing DWADM Schema

Prerequisites

Bring down the Oracle Warehouse Builder based source application(s) (Oracle Utilities Mobile Workforce Management, Oracle Utilities Meter Data Management, or Oracle Utilities Network Management System) to ensure that users are not accessing them.

To upgrade Oracle Warehouse Builder based source application, follow these steps:

1. Bring down the target applications (OBIEE).
2. Confirm that the source applications and database are not accessible. Proceed with next steps only after confirmation.
3. Generate the final extract from the source application and upload to the warehouse database.
4. Note the time after the final extract files are loaded in the Oracle Utilities Analytics warehouse database in DD-MON-YYYY HH24:MI:SS format.
5. Stop the FPD (File Processor Daemon).
6. Set the Oracle Warehouse Builder environment. Follow the steps below:
   a. Connect to RELADM schema and execute the following query to get the server and Oracle Warehouse Builder environment directory details where it is set up.
select server_name, env_dir from B1_INSTALL_COMPONENTS
where comp_cd='BI_OWB';
cd <OWB environment directory>/etc and open the ENVIRON.INI file.
value of SPLENVIRON variable is the OWB environment name.

b. Note the Oracle Warehouse Builder environment name and ensure it is the correct
environment you are trying to upgrade.
cd <OWB environment directory>/bin and execute ksh ./
splenviron.sh -e <OWB environment name>

    cd $SPLEBASE/bin
    ksh ./stopFileprocessordaemon.sh.
    Please wait for file processor to stop.

c. Verify it by executing the following command:
    ps -ef|grep File

7. Bring down the source application(s) and database.
   It is recommended to take sound consistent source and target databases backup.

8. Upgrade the Oracle Utilities Analytics database to 12.1.0.2.0 database version.

9. Install Oracle GoldenGate 12.2.0.1.1 on the Oracle Utilities Analytics database server and
   start the manager process.
   Note the GoldenGate Home and manager port number. This is applicable only if the source
   application is using Oracle Data Integrator based ELT.

10. Install new Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI) and apply patch
    23629220 on the Oracle Data Integrator server.
    The patch on 12.2.1.0.0 is available on My Oracle Support (http://support.oracle.com).

11. Installing ODI 12.2.1.0.0 with Enterprise edition installation requires JDK1.8.0_77 and
    Oracle Fusion Middleware infrastructure 12.2.1.0.0 as prerequisite.

To summarize, a successful Oracle Warehouse Builder installation involves installing the following:

- JDK1.8.0(77)
- Oracle Fusion Middleware Infrastructure 12.2.1.0.0
- ODI 12.2.1.0.0
- ODI patch 23629220

**Upgrading Oracle Utilities Analytics Database Component**

This section describes the steps included to upgrade the Oracle Utilities Analytics database component:

- Copying and Decompressing Install Media
- Creating Users and Tablespaces

Before proceeding with upgrading the Oracle Utilities Analytics Database component, ensure the
following are complete:

- Upgrading Oracle Utilities Analytics database to version 12.1.0.2.0
- Installing Oracle GoldenGate 12.2.0.1.1 on Oracle Utilities Analytics database server

**Copying and Decompressing Install Media**

To copy and decompress the install media, perform these steps:
1. Download Oracle Utilities Analytics version 2.7.0 Oracle Database part (Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory (such as c:\OUA\temp for a Windows machine or /OUA/ temp for a Linux machine).

   This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.

Creating Users and Tablespaces

To create users and tablespaces:

1. Ensure to create users in the database with the following names without giving specific roles (if these do not exist already):
   DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

2. Connect as sys user and revoke the DBA privilege from the following users (if the DBA privilege has been granted to them):
   DWADM, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

3. Ensure to create roles with the following names (if these do not exist already):
   DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE

4. Connect as sys user and execute the Usersgrants.sql in /Scripts/Usersgrants.sql.

   This SQL provides the required grants to the created users.

5. Copy the DuplicateRecordCheck.sql file from the BI270\DWADM\Pre-Installation directory to the database server under ../<Temp> directory.

6. Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

   Note: If the system displays that no rows are selected, then proceed. If the system displays some data, then contact Oracle Support team and do not proceed with the installation. It is recommended to wait until you get the data fix script.

Installing RELADM Schema

The RELADM schema is a metadata schema that consists of the database objects used for storing the product version and component installation information.

This section describes the RELADM schema initial installation, including:

- Reviewing Storage.xml file
- Installation Steps
- Generating Database Statistics

Reviewing Storage.xml file

The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI270/RELADM/Install- Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.
If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the `storage.xml` file by changing the tablespace name from the default value to a custom value.

**Note:** If database does not have CISTS_01 tablespace or the RELADM user does not have quota on CISTS_01 tablespace, edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

### Installation Steps

**Note:** Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

**In Windows** environment, do the following:

1. Add Java 8 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI270\RELADM\Jarfiles/*
   ```
3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT> /<ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,RELADM -j <JDK Home> -f <TEMPDIR>\BI270\RELADM\Jarfiles -v 1 -e true
   ```

**In Unix** environment, do the following:

1. Add Java 8 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI270/RELADM/Jarfiles/*
   ```
3. Run OraDBI.jar as shown below:
   ```
   ```

The utility creates the RELADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

### Generating Database Statistics

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect as `sys user` and execute the following command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
```

### Installing MDADM Schema

The MDADM schema is a metadata schema that consists of the database objects used for storing the metadata of Oracle Utilities Analytics.
For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes the MDADM schema initial installation, including:

• Reviewing Storage.xml file
• Installation Steps
• Generating Database Statistics

Reviewing Storage.xml File
The storage.xml file (comes with the product and is in location <TEMPDIR>/BI270/MDADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

Note: If the database does not have CISTS_01 tablespace or the MDADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which MDADM has quota.

Installation Steps
To install the MDADM schema, follow these steps:

Note: The process prompts you for the MDADM user password. Ensure to run the OraDBI.jar (in the step below) using JDK 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

• In Windows:
  1. Add Java 8 to the path variable as shown in example below:
     ```
     set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     set CLASSPATH= <TEMPDIR>/BI270/MDADM/Jarfiles/*
     ```
  3. Run OraDBI.jar as shown below:
     ```
     ```

• In Unix:
  1. Add Java 8 to the path variable as shown in example below:
     ```
     export PATH=${scratch/softwares/jdk1.8.0_77/bin:$PATH
     ```
  2. Set classpath pointing to OraDBI.jar and all dependency jars.
     ```
     export CLASSPATH= <TEMPDIR>/BI270/MDADM/Jarfiles/*
     ```
  3. Run OraDBI.jar as shown below:
     ```
     java com.oracle.ouaf.oem.install.OraDBI \
     -d jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/ <ORACLE SERVICE NAME> ,
     ```
The utility creates the MDADM schema and system data definitions.
If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect as **sys user** and execute the following command:
```
execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
```

**Installing DWADM Schema**
The DWADM schema contains star schema objects (such as facts and dimensions) that include entire data in the data warehouse.

This section describes the DWADM schema initial installation, including:

- Executing Pre-Installation SQL
- Reviewing Storage.xml File
- Installation Steps
- Generating Database Statistics
- Post-Installation Steps

**Executing Pre-Installation SQL**
To execute specific SQL scripts before proceeding with the installation, follow these steps:

1. Copy the following scripts to the database server under `../<Temp>` directory.
   - `\Pre-Installation\PreInstallAddColumns.sql`
   - `\Pre-Installation\PreIndexCreation.sql`
2. Change the current directory to `../<Temp>`.
3. Connect to the DWADM schema and execute `PreInstallAddColumns.sql`.
4. Connect to the DWADM schema and execute `PreIndexCreation.sql`.
5. In the DWADM schema execute the folloowing anonymous block.
   ```
   set serveroutput on;
   set timing on;
   BEGIN
   -- Drop All Staging External Tables FOR i IN (SELECT uet.table_name
   FROM USER_EXTERNAL_TABLES uet where uet.table_name
   like 'STG%_EXT')
   LOOP
   EXECUTE IMMEDIATE 'drop table '|| i.table_name ||' CASCADE
   CONSTRAINTS ';
   END LOOP;
   /
   ```
6. Copy the following from `BI270/DWADM/Pre-Installation/` to the database server under `../<Temp>` directory. Execute them while connecting to the schema.
   - `CF_BILLED_USAGE.sql`
   - `CF_CREW_TASK.sql`
• CF_CUST_RECENT_OUTG.sql
• CF_CUST_RST_OUTG.sql

7. Copy refresh_mvs_where_mv_logs_outofsynchron.sql script from BI270/DWADM/ Pre-Installation/ to the database server under ../<Temp> directory. Execute it while connecting to the schema.

8. Copy drop_out_of_sync_mv_logs.sql script from BI270/DWADM/ Pre-Installation/ to the database server under ../<Temp> directory. Execute it while connecting to the schema.

**Reviewing Storage.xml File**

The storage.xml file (comes with the product and is in location <TEMPDIR>/BI270/DWADM/ Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or the DWADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which DWADM has quota.

**Installation Steps**

To install the DWADM schema, follow these steps:

**Note:** The process prompts you for the DWADM user password. Ensure to run the OraDBI.jar (in the step below) using JDK 8.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

• In Windows:

  1. Add Java 8 to the path variable as shown in the example below:

```
set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
```

  2. Set classpath pointing to OraDBI.jar and all dependency jars.

```
set CLASSPATH=<TEMPDIR>/BI270\DWADM\Jarfiles/*
```

  3. Run OraDBI.jar as shown below:

```
java com.oracle.ouaf.oem.install.OraDBI -d
dbca:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
<ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,,,,,,DWADM -j
<JDK Home> -f <TEMPDIR>/BI270\DWADM\Jarfiles -v 1 -e true
```

• In Unix:

  1. Add Java 8 to the path variable as shown in example below:

```
export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
```

  2. Set classpath pointing to OraDBI.jar and all dependency jars.

```
export CLASSPATH=<TEMPDIR>/BI270/DWADM/Jarfiles/*
```

  3. Run OraDBI.jar as shown below:

```
java com.oracle.ouaf.oem.install.OraDBI \
```

Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics

Oracle Utilities Analytics Installation Guide
Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics

Upgrading Oracle Utilities Analytics from v2.5.0.0.5

7-44

Oracle Utilities Analytics Installation Guide

-d jdbc:oracle:thin:@<DATABASE_SERVER>:<DATABASE_PORT>/<ORACLE
SERVICE NAME>,\
RELADM,<Password of RELADM user>,,,,,RELADM  
-j <JDK Home> -f <TEMPDIR>/BI270/RELADM/Jarfiles -v 1 -e true

The utility creates the DWADM schema and system data definitions.
If an error occurs while executing an SQL or another utility, it logs and displays the error message
and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before
using the database, generate the statistics for these new objects.
Connect as sys user and execute the command:
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Post-Installation Steps
Perform these steps to complete the installation:
1. Connect to the Oracle Utilities Analytics database and execute the following:
   ...\BI270\DWADM\Post-Upgrade\ControlZoneUpdate.sql
2. Connect to the Oracle Utilities Analytics database with the system user and execute the script
   mentioned below:
   .../BI270\DWADM\Post-Upgrade\DataCorrection2511.sql

Upgrading Oracle Utilities Analytics Based ELT Component

This section describes the steps included to upgrade the Oracle Utilities Analytics based ELT
component:
• Configuring ODI Repository Creation Utility (RCU)
• Setting up Oracle GoldenGate
• Copying and Decompressing Install Media
• Starting the Installer
• Upgrade Steps
Before proceeding with upgrading the Oracle Utilities Analytics based ELT component, ensure
the following are complete:
• Installing JDK1.8.0_7
• Installing Oracle Data Integrator 12.2.1.0.0 (both infrastructure and ODI)
• Applying Oracle Data Integrator patch 23629220

Configuring ODI Repository Creation Utility (RCU)
To configure the Oracle Data Integrator Repository Creation Utility (RCU), follow these steps:
1. Ensure RCU for Oracle Data Integrator is running and the required schemas are created
   in the target database.
   ODI_ORACLE_HOME is an Oracle Home path which was used as Oracle Home while
   installing ODI Infrastructure installation and Oracle Data Integrator (ODI) installation.
2. Set or export JAVA_HOME variable to the 1.8.0_77+ installed directory.
3. Go to $ODI_ORACLE_HOME/oracle_common/bin.
4. Run the RCU utility.
   For example:
   ```
   export JAVA_HOME=/scratch/bi_oradata_01/jdk1.8.0_77
   cd/scratch/bi_oradata_01/12.2.1_FMW_infrastructure/oracle_common/bin
   ./rcu
   ```

5. On the **Select Components** wizard in RCU, navigate to the **Create Repository** tab and select **System Load and Product Load**. Click **Next**.

6. On the **Database Connection Details** tab, provide the database connection details. Click **Next**.

7. On the **Select Components** tab, select the options as shown in the screen below. Unselect the Oracle Data Integrator component. Click **Next**.

![Select Components Screen](image)

8. On the **Schema Passwords** tab, note the passwords given as they are required while creating the Oracle Data Integrator domain.

9. Navigate to the **Complete Summary** tab and click **Finish**.

   It is not required to create the Oracle Data Integrator domain at this stage. Create it after running the Oracle Utilities Analytics installer and before running the source configuration tool.

### Setting up Oracle GoldenGate

This section describes the following:

- Setting up Oracle GoldenGate on Source Database Server
- Setting up Oracle GoldenGate on Target Database Server
- Setting Up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

#### Setting up Oracle GoldenGate on Source Database Server

**Note**: Before proceeding, start the source database and ensure it is accessible. Bring down the source application server.

To set up each source instance, follow these steps:
1. Create a directory on the source database server (For example: ../GoldenGate Home) and install Oracle GoldenGate in that directory. It is Oracle GoldenGate home (OGG_Home) on the source database server.

   **Note:** Note this directory location; it is used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate.

   Download Oracle GoldenGate 12.2.0.1.1 from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

   For installation instructions, refer to the respective installation documentation at http://docs.oracle.com/goldengate/1212/gg-winux/index.html.

3. Provide the Oracle GoldenGate Home location as the directory location created in the step 1.

4. Open a command terminal or window, and set the source ORACLE_SID and ORACLE_HOME variables.

5. Set the LD_LIBRARY_PATH as follows:

   In Unix:
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   In Windows:
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%
   ```

6. In the Command window, change directory to the Oracle GoldenGate home directory, and execute the following command:

   In Unix:
   ```
   ./ggsci
   ```

   In Windows:
   ```
   ggsci
   ```

   The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order listed:

   - `create SUBDIRS`
   - `start mgr` - Starts the Oracle GoldenGate manager process.
   - `info all` - Verifies if the manager process is running.
   - `exit` - Exits Oracle GoldenGate.

8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as sys user and execute the following statements:

   ```
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. In the Command window, navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. Open the GOBALS file in the directory and add the below command:

    ```
    EnableMonitoring
    ```

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory.
13. Connect to the database as **sys user** using SQL*Plus.

   Ensure OGG_Home to be the current directory while invoking SQL*Plus.

14. Create a new user.

   For example: ODM01SRC

   This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is not assigned to any other user.

   **Note:** Ensure to note down the Oracle GoldenGate Owner Username. It is used in the Oracle Utilities Analytics installation.

15. Connect to the source database as **sys user**.

16. Execute the following commands:

   **Note:** Ensure to modify the GoldenGate owner placeholder with actual name of the database user created in step 14.

   ```sql
   grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
   grant unlimited tablespace to <GoldenGate owner> with admin option;
   EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>','capture');
   grant unlimited tablespace to <GoldenGate Owner> with admin option;
   Revoke dba from <GoldenGate Owner>;
   grant create any view to <GoldenGate Owner>; grant select any dictionary to <GoldenGate Owner>; GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>; GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>
   GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>; GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>
   ```

17. Connect to the `<source application>` ADM schema (such as CISADM). Execute the following commands:

   **For Oracle Utilities Customer Care and Billing** source database, execute the following grants:

   Grant select on F1_MST_CONFIG to <GoldenGate owner user created in step 16>
   Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in step 16>
   Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in step 16>
   Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created in step 16>

   **For Oracle Utilities Operational Device Management** source database, execute the following grants:

   Grant select on F1_MST_CONFIG to <GoldenGate owner user created in step 16>
   Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in step 16>

   **For Oracle Utilities Meter Data Management** source database, execute the following grants:

   Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>
   Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>

For Oracle Utilities Work and Asset Management source database, execute the following grants:

Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

Note: While executing SQL commands in steps 15, 16, and 17, provide the GoldenGate owner user (if prompted for).

All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the database as sys user.

18. Execute the following commands in the order listed below:
   
   @marker_setup.sql
   @ddl_setup.sql
   @role_setup.sql


20. In the Command window, create a directory “diroby” in the OGG_Home directory.

21. Change directory to the Oracle GoldenGate Home directory, and execute the following:
   
   b. Steps in Generating Shared Secret Password.

   Note: Execute these steps before running the Oracle Utilities Analytics installer. See http://docs.oracle.com/goldengate/c1221/gg-winux/index.html for more details.

**Configuration for Encrypting Data Using ENCKEYS Method**

To configure for encrypting data using the ENCKEYS method, follow these steps:

a. Execute the following command:

   cd $OGG_HOME
   KEYGEN key_length n

   The above command generates the key value based on the value specified in the parameter “n”. The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

c. Repeat the step ‘b’ for each key values generated.

d. Save the file with name ENCKEYS (Upper case only) without any extension.

Example:

   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035DD6893205A7BD6773FA8E670
e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

f. Input the Logical name, space and key value generated.

Example contents of file ENCKEYS:
CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

Note: It is recommended to name Logical key name after <context_code>KEY. For example: if context code is CCB1, it is recommended to name CCB1KEY.

Generating Shared Secret Password
To generate the shared secret password, follow these steps:

1. Execute the following command:

   cd $OGG_HOME
   ./ggsci
   ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>

   Example:
   cd $OGG_HOME
   ./ggsci
   GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
   Encrypted password: AADAAAABBBBEEFGHJKLMMONPQRSTVWXYZ
   Algorithm used: AES128

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and the generated encrypted password.

Setting up Oracle GoldenGate on Target Database Server
To set up Oracle GoldenGate on the target database server, follow these steps:

1. Create a directory on the target database server.

   For example: ../GoldenGateHome

   Oracle GoldenGate should be installed in this directory. It is Oracle GoldenGate home (OGG_Home) on the target Oracle Utilities Analytics database server.

   Note: Ensure to note the directory location; it will be used in the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.

   Set LD_LIBRARY_PATH using the following commands:

   In Unix:
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

   In Windows:
set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

4. In the Command window, change the directory to the **GoldenGate home** directory and execute the below command:
   
   In Unix:
   
   ./ggsci
   
   In Windows:
   
   ggsci

   The Oracle GoldenGate prompt is shown.

5. At the prompt, execute the following commands in the order listed below:
   
   • create SUBDIRS
   • start mgr - Starts the Oracle GoldenGate manager process.
   • info all - Verifies if the manager process is running.
   • exit

6. Create a directory “diroby” in the OGG_Home directory.

7. Connect to the target database as **sys user** and execute the below query:

   ```sql
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

8. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) directory.

9. Edit the GLOBALS file in the `<GG home>` directory and add the following command:
   
   ```
   EnableMonitoring
   ```

10. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. If the ENCKEYS file does not exist, follow these steps:
   
   a. Create and open a new ASCII ENCKEYS file.
   
   b. Add the key value/values that are generated on the sources to the ENCKEYS file in target OGG home. This is done for the context codes for which source is configured.

   A sample ENCKEYS file in target OGG home is as below:

   ```
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ```

### Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

Set up Oracle GoldenGate Monitor JAgent on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers.

The Oracle GoldenGate Monitor JAgent is used to automatically copy the generated Oracle GoldenGate scripts to both source and target GoldenGate Home directories, and to start the extract and replicate processes on source and target.

To setup Oracle GoldenGate Monitor JAgent on both target and source database servers, follow these steps:

1. Ensure Oracle GoldenGate is installed and manager is running.

2. Start the rmiregistry services using the following command:

   ```
   rmiregistry 5559 &
   ```

   Ensure to note down the port on which RMI server is started. The port number specified here is 5559. If it is not specified, the default port 1099 will be used.
3. Install Fusion Middleware Infrastructure.

4. Run the OGG Monitor 12.2.1 installer.
   a. Set Oracle Home to the location where Fusion Middleware Infrastructure was installed in step 2.
   b. Choose installation type as OGG Monitor Agent.

5. Edit the Config.properties file in the `<OGG Monitor home>/oggmon/ogg_agent/ cfg_templates` and add/modify the below parameters.

   - `<ACTUAL>` : `jagent.host=localhost`
   - `<CHANGE TO>` : `jagent.host=<(<actual hostname on which OGG is installed>>)`

   - `<ACTUAL>` : `monitor.jmx.username=cmroot`
   - `<CHANGE TO>` : `monitor.jmx.username=jmx_src`

   - `<ACTUAL>` : `jagent.username=root`
   - `<CHANGE TO>` : `jagent.username=<(<OGG software installed OS user>>)`

   - `<ACTUAL>` : `jagent.rmi.port=5559`
   - `<CHANGE TO>` : `jagent.rmi.port=5557` or any free port other than the one on which the rmiregistry is started

   - `<ACTUAL>` : `agent.type.enabled=OGGMON`
   - `<CHANGE TO>` : `agent.type.enabled=OEM`

   - `<ACTUAL>` : `jagent.backward.compatibility=true`
   - `<CHANGE TO>` : `jagent.backward.compatibility=false`

6. Add the following parameter:

   `jagent.ssl=false`

7. Navigate to `<OGG Monitor home>/oggmon/ogg_agent` directory and run the below command:

   **In Unix:**
   ```
   export JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.sh
   ```

   **In Windows:**
   ```
   set JAVA_HOME=<JDK home>
   ./createMonitorAgentInstance.bat
   ```

   a. Enter the following:
      - Oracle GoldenGate Home directory.
      - Path to be used for Oracle GoldenGate Monitor Agent instance.

      It is recommended to provide a path (such as `<OGG Monitor home>/Agents/ OGGMonitorInstance`).

      - A unique name to replace the timestamp in the name of the file used to start GG Monitor agent instance.

      Provide a unique name to be used for this Oracle GoldenGate Monitor instance.

   b. Execute the command below from `<path used for OGG Monitor instance provided in the step above>/bin`. 
Example location: <OGG Monitor home>/Agents/OGGMonitorInstance/bin

In Unix:

export JAVA_HOME=<JDK home>
./pw_agent_util.sh -jagentonly

In Windows:

set JAVA_HOME=<JDK home>
pw_agent_util.bat -jagentonly

8. Enter the Oracle wallet password.

This password has to be entered as the password for the JAGENT while running the installer (for target GoldenGate), and while running the source configuration (for source GoldenGate).

Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is required in subsequent installation.

9. Create a folder with the Context_code name in <GG Home>/dirdat.

For example: If WAM2 is created for the WAM source, then create a folder with name “WAM2” within the <GG Home>/dirdat/ folder.


Replace COMMAND java with COMMAND <JDK Home>/bin/java.

This ensures that the correct version of java (1.8) is used while starting JAgent.

11. Navigate to OGG_Home directory and run the following command at the Oracle GoldenGate prompt:

ggsci

12. Start the JAgent process using the following command:

start jagent

The logs for JAgent are created at the following (example) location.

<OGG Monitor home>/Agents/OGGMonitorInstance/logs

Copying and Decompressing Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.7.0 Multiplatform part (Oracle Utilities Analytics V2.7.0 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to <TEMPDIR> below).

This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
For an AIX Operating System, set the following environment variable before starting the Oracle Utilities Analytics installation:

```bash
export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m -XX:MaxPermSize=3200m"
```

To start the Oracle Data Integrator Based ELT component, follow these steps:

1. Go to the temporary folder containing the installer.
2. Run the following command from this folder:

   ```bash
   java -jar <TEMPDIR>/OUA_2.7.0.0.0_generic.jar -logLevel finest
   ```

   **Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

   The **Welcome** page appears.

3. Review the information before you begin the installation. Click **Next** to continue with the installation.

4. Complete the tasks on the navigation pane.

   Each item in the navigation pane represents a specific installer screen that prompts you for information required to install the software.

   **Note:** If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:\spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

**Upgrade Steps**

To install Oracle Data Integrator Based ETL, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The **Welcome** page appears.

   Review the information on the Welcome page before you begin the installation.

2. Click **Next** to continue with the installation.

3. On the **Installation Location** page define an installation location/directory and click **Next**.

4. On the **Select Installation Type** page, select **ODI Based ETL**. Click **Next**.

   Note that the options on the left navigation pane change based on the selected installation type.

5. Select **Oracle Data Integrator Based ETL** as the **Installation Type**.

6. Define the following and click **Next**.
   - Database and Java Home Details
   - Target Database Connection Details
   - Oracle Data Integrator Home and Schema Details
   - Oracle Data Integrator Agent and Repository Details
   - Target GoldenGate Details
7. On the **Database and Java Home Details** page, enter the following in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>The database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>The JDK home location.</td>
<td>Provide location of JDK 1.8.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.8.0_77</td>
</tr>
</tbody>
</table>

8. On the **Target Database Connection Details** page, enter the following in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database.</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

9. On the **ODI Home and Schema Details** page, enter the following in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>The directory where Oracle Data Integrator (ODI) has been installed.</td>
<td>Example: /u01/12.2.1_FMW_infrastructure_home</td>
</tr>
<tr>
<td>Supervisor User</td>
<td>The name of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>The password of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm the password of the Supervisor here.</td>
<td></td>
</tr>
</tbody>
</table>
### 10. On the **ODI Agent and Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name.</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>The password of the master repository schema.</td>
<td>OUA_MASTER user's password</td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator master repository schema here.</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name.</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>The password of the work repository schema.</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator work repository schema here.</td>
<td></td>
</tr>
</tbody>
</table>

### 11. On the **Target GoldenGate Details** page, enter the following details in the respective fields. Click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host on the Oracle GoldenGate Manager.</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
</tbody>
</table>
12. On the **Target JAgent Details** page, enter the following details in the respective fields. Click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Database Home</td>
<td>The database home installed location on the target database server.</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td></td>
<td>In case Oracle GoldenGate for target is not installed on the OUA database server, provide oracle client home location on the server on which Oracle GoldenGate is installed.</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the Oracle GoldenGate host.</td>
<td>The default value is 7830.</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>The algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>The Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>The shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT Provide the result as the value.</td>
</tr>
<tr>
<td>JAgent Host</td>
<td>The host of Oracle GoldenGate Monitor JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>The Oracle GoldenGate installed location where Oracle GoldenGate Monitor JAgent is running.</td>
<td>Example: /opt/local/ggs_12.2.0.1.1</td>
</tr>
<tr>
<td>JAgent Port</td>
<td>Use the JAgent RMI port which is defined in the config properties file.</td>
<td></td>
</tr>
<tr>
<td>JAgent User</td>
<td>The OS user used to configure JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent Wallet Password</td>
<td>The JAgent Wallet password.</td>
<td></td>
</tr>
</tbody>
</table>
13. On the **Installation Summary** page, verify the installation options you selected.

14. Click **Install** to begin the installation.
   
   To change any configurations before starting the installation, use the navigation pane and select the topic to edit.

   The **Installation Progress** page appears displaying the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The detailed logs of the installation are also available in the logs/system directory under the installation location.

   To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

15. On the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

### Creating WebLogic Domain for Oracle Data Integrator Agent

Create the WebLogic Domain to bring up the WebLogic Agent (ODI Agent) to complete the steps. In this product release, ODI Domain creation is automated, and creation of both clustered and non-clustered domain is supported.

- Creating a Non-Clustered Domain
- Creating a Clustered Domain

**Note**: The following procedures assume that the pre-requisite Java 8/bin is in the PATH variable.

### Creating a Non-Clustered Domain

To create a non-clustered domain, follow these steps:

**Note**: The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the `<OUA Environment>/etc` directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm JAgent Wallet Password</td>
<td>Re-enter JAgent Wallet password to confirm.</td>
<td></td>
</tr>
</tbody>
</table>

For example:

```
C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5
```
2. Navigate to the <OUA Environment>/bin directory and invoke the createDomain.sh/cmd script. Refer to the sections Starting WebLogic Admin Server and Starting Managed Server to start the admin server and managed server.

Creating a Clustered Domain

To create a clustered domain, follow the steps below:

Note: The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCUPREFIX</td>
<td>Repository prefix created in the Configuring ODI Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>RCUSCHEMAPWD</td>
<td>Repository schema password provided in the Configuring ODI Repository Creation Utility (RCU) section.</td>
</tr>
<tr>
<td>WEBLOGIC_USERNAME</td>
<td>WebLogic user name for ODI domain</td>
</tr>
<tr>
<td>WEBLOGIC_PASSWORD</td>
<td>WebLogic password for ODI domain</td>
</tr>
<tr>
<td>ODI_DBSERVER</td>
<td>ODI database server name (target database server)</td>
</tr>
<tr>
<td>ODI_DBPORT</td>
<td>ODI database port (target database port)</td>
</tr>
<tr>
<td>ODI_DBNAME</td>
<td>ODI database name (target database name)</td>
</tr>
<tr>
<td>ADMIN_PORT</td>
<td>ODI domain admin port</td>
</tr>
<tr>
<td>ODI_DOMAIN_HOSTNAME</td>
<td>Host name on which the ODI domain is created</td>
</tr>
</tbody>
</table>

Optional fields

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONSSL_PORT</td>
<td>If not specified, default port 7001 will be assigned.</td>
</tr>
<tr>
<td>MANAGED_SERVER_PORT</td>
<td>If not specified, default port 15101 will be assigned.</td>
</tr>
</tbody>
</table>

Creating a Clustered Domain

To create a clustered domain, follow the steps below:

Note: The password fields’ values (RCUSCHEMAPWD, WEBLOGIC_PASSWORD) will be cleared from ODI_CONFIG.properties after executing createDomain.sh or createMachine.sh. Ensure these fields are updated for each invocation of createDomain.sh or createMachine.sh.

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in the ODI_CONFIG.properties file.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN_PATH</td>
<td>In Windows environment, replace “\” with “/” in the domain path. For example: C:/odi12.2.1/odi12.2.1_home/user_projects/domains/odi_domain5</td>
</tr>
</tbody>
</table>
2. Navigate to the `<OUA Environment>/bin` directory and invoke the `createDomain.sh/cmd` script.

   This creates an ODI domain with an Admin server and a Managed server (as 'ODI_server1') and assigned to the cluster.

   Refer to the `Starting WebLogic Admin Server` and `Starting Managed Server (odi_server1)` sections to start the Admin server and Managed server.

To create another managed server and add it to the cluster, follow these steps:

1. Bring up the Admin server.
2. Navigate to the `<OUA Environment>/etc` directory and provide the following mandatory properties in the `ODI_CONFIG.properties` file:
   - `MANAGED_SERVER_NAME`
   - `MANAGED_SERVER_PORT`
3. Provide the following optional properties in the `ODI_CONFIG.properties` file:
   - `MACHINE_NAME`
   - `MACHINE_PORT`

   A new managed server is created with the specified name and assigned to the cluster.

   Refer to the sections `Starting WebLogic Admin Server` and `Starting Managed Server (odi_server1)` to start the Admin server and Managed server.

**Starting WebLogic Admin Server**
To start the WebLogic Admin server, perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home.
   
   `<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin`

2. Execute the `startweblogic` command:
   
   In Unix:
   
   `nohup ./startWebLogic.sh > startWebLogic.log &`

   In Windows:
   
   `startWebLogic.cmd`

**Starting Managed Server (odi_server1)**

To start the odi_server1 managed server, follow these steps:

1. Change the directory to WLS Home to start odi_server1:
   
   In Unix:
   
   `<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin`

   `nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &`

   In Windows:
   
   `StartManagedWeblogic.cmd odi_server1`

2. In the Oracle Data Integrator Studio, navigate to **Topology > Agents > OracleDIAgent**.

3. Right-click **OracleDIAgent** and click **Test** to test the connectivity of the configured Oracle Data Integrator Java EE agent.

**Executing Post-Upgrade Script**

To execute the post-upgrade script, follow these steps:

1. Execute `B1_MDFIX_ODM_270` in global context.

2. Login to ODI Client and navigate to **Designer > Load Plans and Scenario** folders.

3. Expand **Framework > Data Fix > B1_MDFIX_ODM_270**.

4. Right-click **B1_MDFIX_ODM_270**, click **Run**, and then select the context as **Global**.

5. Click **OK**.

**Creating a Database Directory**

Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each source database. This directory is used for logging the export import task used during the initial ELT load.

The following sample SQL creates a database directory pointing to the file system path `/scratch/file_data`:

```
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
```

**Configuring Source Applications**

This section describes the instructions to be followed to configure source applications.

- **Prerequisites**
- **Configuration Steps**
Bring down the source application server, and ensure the source applications are stopped but source databases are up and accessible.

Prerequisites
Before running the source configuration tool, ensure Oracle Data Integrator domain is created, and admin and managed servers are running and accessible.

Configuration Steps
To configure the source applications, perform the following steps:

1. Register a source application.

   For instructions to register a source, refer to the Registering a Source section in Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

2. Ensure to use the same context_codes to configure the existing sources during the upgrade.

3. After running config.sh GUI utility, run B1_SYNC_CONTEXT as follows.

   a. Login to Oracle Data Integrator Studio.
   b. Navigate to Designer > Load Plans and Scenarios > Framework.
   c. Right-click B1_SYNC_CONTEXT and select Run.

4. Select the context related to the source application, <no agent> as logical agent, and then click OK.

5. Run the B1_INITIAL_SETUP_PKG package.

   Note: It is recommended to run B1_INITIAL_SETUP_PKG only once (after all the sources have been configured or after at least one source is configured).

   a. Login to Oracle Data Integrator Studio.
   b. Navigate to Designer > Load Plans and Scenarios > Framework.
c. Right-click **B1_INITIAL_SETUP_PKG**, select **GLOBAL** context code, and then select **Run**.

6. Execute data fix B1_DATAFIX_270 in Global context.
   a. Login to Oracle Data Integrator Studio.
   b. Go to Designer, and navigate to **Load Plans and Scenarios > Framework > Data Fix**.
   c. Run B1_DATAFIX_270 in Global context.

7. Start all Oracle GoldenGate processes on source and target:
   a. Login into each source application GoldenGate server.
   b. Go to the respective Oracle GoldenGate Home directory.
   c. Start manager, JAgent, and all respective context extract processes.
   d. Login to the target (Oracle Utilities Analytics) GoldenGate server.
   e. Go to the Oracle GoldenGate Home directory.
   f. Start manager, jagent and all respective context extract processes.

8. Start the source application server.
   a. Login to each source application.
   b. Start the application and ensure it is up and accessible.

9. Update the slice_start_dttm in B1_JOB_CONFIG table for the product based on the time noted in Step 3.
   
   That time is when the final extract from the source application is generated and uploaded to the warehouse database.

   Refer to the **Upgrading Oracle Utilities Analytics** chapter in *Oracle Utilities Analytics Administration Guide* for upgrade statement and for a specific source application.

---

**Upgrading Oracle Utilities Analytics Administration Tool Component**

The procedure to upgrade the Oracle Utilities Analytics Administration Tool component from v2.5.0.0.5 is same as that of the upgrade from v2.6.0.0.2.

For instructions, refer to **Upgrading Oracle Utilities Analytics Administration Tool Component** section in Chapter 6: Upgrading Oracle Utilities Analytics from v2.5.0.0.5.

**Upgrading Oracle Utilities Analytics Dashboards Component**

The procedure to upgrade the Oracle Utilities Analytics Dashboards component from v2.5.0.0.5 is same as that of the upgrade from v2.6.0.0.2.

For instructions, refer to **Upgrading Oracle Utilities Analytics Dashboards Component** section in Chapter 6: Upgrading Oracle Utilities Analytics from v2.5.0.0.5.
Chapter 8
Installing Demo Database

This chapter provides instructions to install the demo database.

Note: The demo installation does not support ETL functionality. The ETL Job Control dashboard accesses Oracle Data Integrator tables, and the demo dump does not have Oracle Data Integrator objects. Hence, the ETL dashboard is not supported in the demo installation.

- Installing Oracle Utilities Analytics Demo Database Component
- Installing Oracle Utilities Analytics Dashboards Component

Installing Oracle Utilities Analytics Demo Database Component

This section describes how to install the demo database component of Oracle Utilities Analytics, including:

- Copying and Decompressing Install Media
- Creating Database and Importing the Dump File
- Configuring Security
- Configuring Spatial Data

Copying and Decompressing Install Media

To copy and decompress install media, follow these steps:

1. Download Oracle Utilities Analytics v2.7.0 Oracle Demo Data part from the Oracle Utilities Analytics v2.7.0 Demo Data.zip file.

   Download the zip from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory. For example:

   In Windows:
   \c:\OUA\temp

   In Linux:
   /OUA/temp

   This directory (referred as <TEMPDIR>) should be located outside any current working Oracle Utilities application environment. After a successful installation, delete all files in this directory that are part of the installation.
3. Unzip **Oracle Utilities Analytics V2.7.0 Demo Data.zip** to `<TEMPDIR>` using any zip utility.

The installation media is decompressed successfully. Proceed with creating the database.

### Creating Database and Importing the Dump File

This section describes how to create the demo database with AL32UTF8 character set using the database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for Windows). It includes the following:

- UNIX Database Creation Utility
- Windows Database Creation Utility
- Importing Demo Data Manually
- Post-Import Tasks

Ensure that Oracle Database Server Enterprise Edition 12.1.0.2.0 is already installed on the machine to create the database.

The UNIX and Windows database creation utilities create an empty database with AL32UTF8 character set, and at least one tablespace for storing the application objects before running the installation. The default name of the application tablespace is CISTS_01.

If the following error messages occur while importing the demo data; it is recommended to ignore them.

```
ORA-31684: Object type USER:"MDADM" already exists
ORA-31684: Object type USER:"RELADM" already exists
ORA-31684: Object type USER:"DWADM" already exists
ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT EXECUTE ON "MDADM"."B1_TEXT_ARRAY" TO "CCB1REP"
ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT SELECT ON "MDADM"."B1_PROD_INSTANCE" TO "CCB1REP"
Job "SYSTEM"."SYS_IMPORT_SCHEMA_01" completed with 5 error(s)
ORA-39083: Object type INDEX failed to create with error:
ORA-31625: Schema DWSTAGE is needed to import this object, but is unaccessible
ORA-01435: user does not exist
```

Ignore any errors related to spatial indexes.

### UNIX Database Creation Utility

The files are located in BI270/DatabaseCreation/Unix to create the database.

To create the database using UNIX database creating utility, follow these steps:

1. FTP the content of the **Database Creation** folder to a temporary directory on the UNIX server.

2. To create the database, set the `ORACLE_HOME` and the `ORACLE_BASE` variables.
   ```
   set PATH to include ORACLE_HOME/perl/bin
   set LD_LIBRARY_PATH to ORACLE_HOME/lib
   ```

3. Run the `cdxdba.plx` utility by executing the following command:
   ```
   perl cdxdba.plx
   ```
4. Provide the following parameter values when the script prompts:

   Instance name (DEMO): DEMO
   ORACLE_BASE: The directory where the setup files for the database will be created (/oraw/app/oracle):
   ORACLE_HOME: The folder where the current version of Oracle software is installed (/oraw/app/oracle/product/):
   ORACLE_DATA: The directory where the data files for the database will be created (/db05/ordata):
   Character set for the database (AL32UTF8):

5. Enter the values based on the settings of your database server. You can also accept the default values displayed if they match your database server settings. You will be prompted to confirm the settings and select Y or N to create the database.

   ORACLE_SID: DEMO
   ORACLE_HOME: /oraw/app/oracle/product/
   ORACLE_BASE: /oraw/app/oracle
   ORACLE_DATA: /db05/oradata
   Character Set: AL32UTF8
   Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

   Do you want to import a demo database dump into this database (Y/N)?
   Select Y to import the Demo Install data.
   For the demo installation use the dump file exp_demo.dmp.
   Do you want to import a demo database dump into this database (Y/N)? Y
   Enter the name of the dump file (exp_demo.dmp):
   Enter the name of the dump file directory (data_pump_dir):
   Enter the name of the log file (exp_demo.log):

   Note: The dump_dir must exist in the created database before continuing with the import. You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the exp_demo.dmp.gz file first to extract the exp_demo.dmp file. This file is in ..\BI270\Demo directory.
   Update the oratab file for the new database, and then check the connectivity to this database from another server and from your desktop after updating local tnsnames.ora file.

Windows Database Creation Utility

The files are located in ..\BI270\DatabaseCreation\Windows. You should be logged in as a user who is a member of local ORA_DBA group on that server. The ORA_DBA group should have “Administrator” privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from command prompt. The utility displays the following options:
   E - Export a schema from the database
   R - Refresh a schema with a database dump
   C - Create/Recreate a local database
   H - See help for the command line options
   Q - Quit
2. Select the option C to create an empty database on your machine and provide the below inputs:
   a. Provide the instance name (DEMO): <DB Name> For example, BIDEMO.
   b. Enter the character set of the database (AL32UTF8): AL32UTF8.
   c. Enter ORACLE_BASE: The directory where the setup files for the database will be created (c:\oracle) : <Oracle_Base>.
      For example: C:\app\oracle
   d. Enter ORACLE_HOME: The folder where the current version of Oracle software is installed (c:\oracle\product\11.1.0.6\Db_1):<Oracle_Home>.
      For example: c:\app\oracle\db_home
   e. Enter ORACLE_DATA: The directory where the data files for the database will be created (C:\app\oracle\oradata):<Directory where data files will be created>.

6. Once the database has been created, select the R - Refresh a schema option with a database dump file to load the demo install data.
   a. Select option: R
   b. Enter the instance name (DEMO): <DB name>
   c. Is it a LOCAL database (exists on the same machine) (Y/N): < provide Y or N>
   d. Enter the name of the Oracle account that owns that application schema (spladm): DWADM
   e. Enter the password for DWADM (spladm): DWADM
   f. Enter the character set of the database (AL32UTF8): AL32UTF8
   g. Enter the name of data pump directory (DATA_PUMP_DIR): DATA_PUMP_DIR
   h. Enter the name of the dump file (expDWADM.dmp):exp_demo.dmp
   i. Enter the name of the log file (impDWADM.log):exp_demo.log
   j. The option R causes the utility to drop all the objects from the schema and import the schema from a database dump file.

   For demo installation, use the exp_demo.dmp dump file.

   Note: The dump_dir must exist in the database created above before continuing with the import. You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the exp_demo.dmp.gz file to extract the exp_demo.dmp file. This file is in the ..\BI270\Demo directory.

   Check the connectivity to this database from another server and from your desktop after updating the local tnsnames.ora file.

**Importing Demo Data Manually**

The demo data can also be imported by following the steps below after successful database creation (using DBCA or cdxdba.plx).

If the database is created using DBCA, run the users.sql under BI270/DatabaseCreation/Unix directory after replacing tablespace name as required. Run this command from the database server.

Note: Ensure to change the tablespace_name to the tablespace name on which DWADM, RELADM, and MDADM have the quota. If DWADM, RELADM, and MDADM users have quota on cists_01 tablespace, then exclude whole remap_tablespace clause from the command.
1. Set the correct ORACLE_SID and ORACLE_HOME first, and then run below command to import demo dump.

    impdp directory= dump_dir dumpfile= exp_demo.dmp logfile= exp_demo.log schemas=DWADM,RELADM,MDADM remap_tablespace=cists_01:<tablespace_name>

2. Provide the system as the user and system user's password when prompted.

**Post-Import Tasks**

Connect to MDADM schema, and execute the following commands:

- create public synonym B1_TARGET_ENTITY for B1_TARGET_ENTITY;
- create public synonym B1_PROD_INSTANCE for B1_PROD_INSTANCE;
- create public synonym B1_JOB_CONFIG for B1_JOB_CONFIG;

    grant select on B1_TARGET_ENTITY to public;
    grant select on B1_PROD_INSTANCE to public;
    grant select on B1_JOB_CONFIG to public;

**Configuring Security**

The security scripts have to be executed after the initial load and the Materialized views are created for the given source product instance.

To configure the security, perform the following steps:

1. In the Oracle Utilities Analytics database component installation package, navigate to the ..\BI270\DWADM folder.
2. Run OraGenSec

   **In Windows environment:**
   a. Add Java 8 to path variable as shown in example below:

      ```
      set PATH= C:\Java\jdk1.8.0_121\bin;%PATH%
      ```
   b. Set classpath pointing to OraDBI.jar and all dependency jars.

      ```
      set CLASSPATH= <Path to BI270>\BI270\DWADM\Jarfiles/*
      ```
   c. Run OraGenSec as shown below:

      ```
      ```

   **In Unix environment:**
   a. Add Java 8 to path variable as shown in example below:

      ```
      export PATH=/scratch/softwares/jdk1.8.0_121/bin:$PATH
      ```
   b. Set classpath pointing to OraDBI.jar and all dependency jars.

      ```
      export CLASSPATH= <Path to BI270>/BI270/DWADM/Jarfiles/*
      ```
   c. Run OraGenSec as shown below:

      ```
      ```
Configuring Spatial Data

This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities Analytics.

Use the following procedure to load spatial metadata in the target database:

1. Create the dump dir directory in the database and copy the user_sdo.dmp file from ../BI270/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command:

   ```
   impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=impdp_user_sdo.log schemas=DWADM remap_tablespace=cists_01:<tablespace_name>
   ```

   **Note:** Run this command from database server. Ensure to change the tablespace_name to tablespace name on which DWADM has the quota. If DWADM user have quota on cists_01 tables, then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI270/Spatial-Metadata folder:

   - sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql
   - sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Installing Oracle Utilities Analytics Dashboards Component

**Note:** Ensure that the same Operating System (OS) user to install the prerequisite software is used to install the Oracle Utilities Analytics Dashboards component as well.

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics application server. This section describes how to install the dashboards component of Oracle Utilities Analytics.

- Creating and Configuring an OBIEE Domain
- Copying and Decompressing Install Media
- Starting the Installer
- Installation Steps
- Deploying Web Catalog
- Deploying the Repository (RPD) File
- Configuring and Deploying the MapViewer
- Updating MapViewer Configuration
- Enabling WriteBack
- Enabling Auto Complete Feature in OBIEE
Creating and Configuring an OBIEE Domain

To create and configure an OBIEE domain, follow the steps below. This is a prerequisite to install the Oracle Utilities Analytics Dashboards component.

1. Run RCU to create the necessary schemas.
   a. Navigate to `<FMW infrastructure home>/oracle_common/bin`. Example location:
      ```bash
cd /u01/12.2.1.9_Infrastructure/oracle_common/bin
```
   b. Run below command and follow the instructions in the wizard:
      ```bash
./rcu
```
      **Note:** Select AS Common Schemas and Oracle Business Intelligence components in the Select Components panel.

2. Run the OBIEE configuration assistant to create an OBIEE domain.
   a. Navigate to `<FMW infrastructure home>/bi/bin` Example location:
      ```bash
cd /u01/12.2.1_Infrastructure/bi/bin
```
   b. Run below command and follow the instructions in the wizard:
      ```bash
In Unix:
./config.sh
In Windows:
./config.cmd
```
   c. On the Database Details panel, choose “Use existing schemas” and provide connection details (prefix of the RCU run in step 1).
   d. On the Initial Application panel, select “Oracle sample application (SampleAppLite).
      **Note:** Ensure the BI domain path, WebLogic user name and password are noted down. They should be provided as inputs when the Oracle Utilities Analytics Dashboards component installer is run.

3. After the successful creation of OBIEE domain, start the OBIEE Admin server.
4. Login into the Admin console.
   a. On the Environment tab, navigate to the coherence clusters.
   b. Click defaultCoherenceCluster and then select the Configuration tab.
      Ensure the port mentioned in the Cluster Listen Port field is not in use. If needed, change it to another port that is not in use.
   c. Click Save to save the port changes (if any).
   d. Start the OBIEE Managed server.
5. After starting the OBIEE domain services successfully, navigate to the `<OBIEE domain>/config/fmwconfig` directory.
   a. Open jps-config.xml.
   b. Under the `<serviceInstance name="idstore.ldap" provider="idstore.ldap.provider">` element, add the property element as below:
The OBIEE domain is successfully created and configured.

**Copying and Decompressing Install Media**

To download and decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0 (Oracle Utilities Analytics V2.7.0 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to `<TEMPDIR>` below).

   This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0 Multiplatform.zip to `<TEMPDIR>`.

**Starting the Installer**

For an AIX Operating System, set the following environment variable before starting the Oracle Utilities Analytics installation:

```
export IBM_JAVA_OPTIONS="-Xmx2g -XX:PermSize=64m -XX:MaxPermSize=3200m"
```

To start the installer, do the following:

1. Navigate to the temporary folder where you downloaded the install. Run the following command from the folder:

   ```
   java -jar <TEMPDIR>/OUA_2.7.0.0.0_generic.jar -logLevel finest
   ```

   **Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.8.

2. On the **Welcome** page, review the information before you begin the installation.

3. Click **Next** to continue with the installation.

4. Complete the installation by following the tasks on the navigation pane.

   Each item in the navigation pane represents a specific installer screen that prompts you for the information required to install the software.

**Installation Steps**

To install the Dashboards component, follow these steps:

1. Run the Oracle Utilities Analytics Installer.

2. On the **Welcome** page, review the available information before you begin the installation.

3. Click **Next** to continue with the installation. The **Installation Location** page appears.

4. Define the **Installation Location** here and click **Next**. The **Select Installation Type** page appears.
5. In the **Select Installation Type** page, select **Dashboards** and click **Next**.

   **Note:** Based on the selected installation type, the options on the left navigation panel change. When you select **Dashboard** as an **Installation Type**, you need to define **Database and Java Home Details**, **Target Database Connection Details** and **OBIEE Home Details**.

   The **Database and Java Home Details** page appears.

6. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>Database client home location</td>
<td>Example: /u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>JDK home location</td>
<td>JDK 1.8 location</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.8.0.77</td>
</tr>
</tbody>
</table>

   The **Target Database Connection Details** page appears.

7. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td></td>
<td>the database resides.</td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the</td>
<td>Oracle Utilities Analytics Database Port.</td>
</tr>
<tr>
<td></td>
<td>database server used for connecting</td>
<td>The default value is 1521.</td>
</tr>
<tr>
<td></td>
<td>to the database.</td>
<td></td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema</td>
<td>Confirm the password for the target</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema</td>
<td>The password for the metadata schema</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>(MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata</td>
<td>Confirm the password for the</td>
<td></td>
</tr>
<tr>
<td>Schema Password</td>
<td>metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

   The **OBIEE Home Details** page appears.
8. Enter the following details in the respective fields and click **Next**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Home</td>
<td>The location on the disk where OBIEE is installed.</td>
<td>Example: /u01/Middleware/Oracle_Bi1</td>
</tr>
<tr>
<td>BI Domain Home</td>
<td>The domain Home location under the directory where OBIEE is installed.</td>
<td>Example: /u01/Middleware/user_projects/domains/bifoundation_domain</td>
</tr>
<tr>
<td>Weblogic Host</td>
<td>The hostname on which WebLogic server for OBIEE is running.</td>
<td></td>
</tr>
<tr>
<td>Weblogic Port Number</td>
<td>A unique port number within the system that is assigned to the HTTP port.</td>
<td>Example: 7001</td>
</tr>
<tr>
<td>Weblogic User</td>
<td>WebLogic domain login user name.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You will be prompted for the Weblogic user’s password after installation.

The **Installation Summary** page appears.

9. Verify the installation options and click **Install** to begin the installation.

For any changes to the configuration before starting the installation, use the navigation pane and select the topic to edit.

10. The **Installation Progress** page appears allowing you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.

    To quit before the installation is complete, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and it needs to be deleted manually.

11. On the **Installation Completed** page, click **Finish** to close the installer.

The Dashboards component is now installed successfully.

---

**Deploying Web Catalog**

Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the location of the catalog.

To deploy the web catalog, follow these steps:

1. Go to the `<DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/root/shared` directory.
2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities Analytics in the previous release.

Ensure any custom catalog related files in this directory are backed up in a separate location before running deployBar.sh/cmd.

If Oracle Utilities Network Management System BI Publisher reports were deployed they should be retained.

3. Follow the steps as below for UNIX and Windows respectively:

   - In Unix:
     a. Navigate to <Install_Dir>/bin directory.
        ```
        cd <Install_Dir>/bin
        ```
     b. Add Java 8 to the path variable as shown in example below:
        ```
        export PATH=/scratch/softwares/jdk1.8.0_77/bin:$PATH
        ```
     c. Run ksh ./deployBAR.sh.

   - In Windows:
     a. Navigate to <Install_Dir>/bin directory.
        ```
        cd <Install_Dir>\bin
        ```
     b. Add Java 8 to the path variable as shown in example below:
        ```
        set PATH= C:\Java\jdk1.8.0_77\bin;%PATH%
        ```
     c. Run deployBAR.cmd.

The Web catalog is successfully deployed.

For an AIX operating system, after the deployBAR.sh/deployBAR.cmd is completed successfully, execute the following command:

```
cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/service_instances/ssi/metadata/content/msgdb/l_en/customMessages
```

### Deploying the Repository (RPD) File

If no changes are made to the deployed RPD, then take the RPD file from the following location, where <install_dir> is the Oracle Utilities Analytics Dashboard Component installation directory:

```
<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd
```

If it was merged, then take the merged RPD and make the required database changes. Copy this RPD file to the Windows machine on which OBIEE 12.2.1 is installed.

To deploy the RPD file, follow these steps:

1. Ensure OBIEE 12.2.1 is installed on the Windows machine before proceeding.
2. Click Start > Programs > Oracle Business Intelligence > Administration.
3. Click File > Open > Offline... to open the RPD in offline mode.
4. Provide the RPD password. The default password is “oracle123”.
5. Double-click the **Connection Pools** to edit them.

![Diagram of connection pools](image)

- In the **Init Block Connection Pool** group, enter the following:
  
  Datasource name = BI Database name
  
  User name = DWREAD
  
  Password = DWREAD User password

- In the **Init Block Pool - MDM** group, provide the following (only for Oracle Utilities Meter Data Management):
  
  Datasource name = MDM database name
  
  User name = CISUSER
  
  Password = CISUSER User password

- In the **Init Block Pool - NMS Replication** group, provide the following (only for Oracle Utilities Network Management System):
  
  Datasource name = BI database name
  
  User name = DWREAD
  
  Password = DWREAD User password

**Note:** The schema name is NMS1REP by default. Rename it if the replication schema name is different.

- In the **Materialized Views Connection** group, enter the following:
  
  Datasource name = BI Database name
  
  User name = DWREAD
  
  Password = DWREAD User password

- In the **MDM Database Connection** group, provide the following (only for Oracle Utilities Meter Data Management):
  
  Datasource name = MDM database name
  
  User name = CISUSER
  
  Password = CISUSER User password
• In the **NMS Replication Tables** group, provide the following (only for Oracle Utilities Network Management System):

  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

  **Note:** The default schema name is NMS1REP. If the replication schema name is different, then rename.

• In the **ODIDEV Connection Pool** group, provide the following:

  Datasource name = BI database name  
  User name = DWUSER  
  Password = DWUSER User password  

• In the **OUBI Database Connection** group, provide the following:

  Datasource name = BI database name  
  User name = DWREAD  
  Password = DWREAD User password  

6. Click **Save**.

   **Note:** Click **Yes** when you see the prompt 'Do you wish to check global consistency?' and ignore any warnings that appear after consistency check is complete.

7. Copy the modified RPD back to the `<install dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd` where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory.
8. Login to the server where OBIEE Enterprise Manager is installed.


10. Run the following command to deploy the RPD:

In Windows:

```
data-model-cmd.cmd uploadrpd -I <OUA home>\Reports\rpd\UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -P <Weblogic password of OBIEE domain> -SI ssi
```

In Unix:

```
data-model-cmd.sh uploadrpd -I <OUA home>/Reports/rpd/UtilitiesBusinessAnalytics.rpd -W <rpd password, default password is oracle123> -U <Weblogic user name of OBIEE domain> -P <Weblogic password of OBIEE domain> -SI ssi
```

11. Run the following commands from <OBIEE DOMAIN>/bitools/bin directory to stop and start the OBIEE domain services respectively.

```
stop.sh/cmd
start.sh/cmd
```

**Configuring and Deploying the MapViewer**

Configuring and deploying the MapViewer involves the following tasks:

- Configuring the MapViewer
- Modifying instanceconfig.xml

**Configuring the MapViewer**

To configure the Mapviewer, follow these steps:

1. Login to the WebLogic console.
2. Create the 'MAP_DS' datasource.
3. Lock and edit it.
4. Navigate to Services > Data Sources.
5. Select New > Generic Data Source and provide the following:
   - Name = MAP_DS
   - JNDI Name = MAP_DS
   - Database Type = oracle
6. Click Next.
7. Enter the following:
   - Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions:Any
8. Click Next.
9. On the next page, do not change any values. Click Next.
10. Enter the following connection properties:
    - Database Name: BI Database Name
    - Host Name: Database host
• Port: Database port
• Database User Name: dwadm
• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration. After the successful test, click Next again.

13. On the Select Target page, select AdminServer under Servers and bi_cluster under Clusters. Click Finish.

14. Click Activate Changes.

15. Update the mapViewerConfig file with the tags mentioned below:
   File location: <Install Dir>
   /user_projects/domains/<obiee_domain>/config/fmwconfig/mapviewer/conf
   File: mapViewerConfig.xml

16. If there is a proxy used, insert the list of host names for all the third-party service providers in the security_config node.
   <proxy_enabled_hosts>
   elocation.oracle.com
   </proxy_enabled_hosts>

17. Add the following ns_data_provider node:
   <ns_data_provider id="obieeNsdp"
   class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

18. Add the current map_tile_server with the following map_tile_server node:
   <map_tile_server>
   <tile_storage default_root_path="/mytilecache/"/>
   </map_tile_server>

Modifying instanceconfig.xml
Ensure you take a backup before updating the instanceconfig.xml file. Run the following commands in UNIX and Windows respectively to go to the directory containing the instanceconfig.xml file.

In Unix:

<OBIEE_INSTALL_DIR>/user_projects/domains/<obiee_domain>/config/fmwconfig/biconfig/OBIPS

In Windows:

<OBIEE_INSTALL_DIR>user_projects\domains\<obiee_domain>\config\fmw\config\biconfig\OBIPS

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add the following code before </Serverinstance>:
   <Security>
   <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
   <HttpOnlyCookies>false</HttpOnlyCookies>
   </Security>
   </Security>
2. Update the following `<ServerInstance>` element:
   `<LightWriteback>true</LightWriteback>

3. Add the following code between the `<ServerInstance>` `<ServerInstance>` tags.
   `<Prompts>
   <MaxDropDownValues>256</MaxDropDownValues>
   <AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
   <AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
   <AutoCompletePromptDropDowns>
   <SupportAutoComplete>true</SupportAutoComplete>
   <CaseInsensitive>true</CaseInsensitive>
   <MatchingLevel>MatchAll</MatchingLevel>
   <ResultsLimit>50</ResultsLimit>
   </AutoCompletePromptDropDowns>
   </Prompts>
   `<SpatialMaps>
   <MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>
   </SpatialMaps>

**Updating MapViewer Configuration**

To update the MapViewer configuration, follow these steps:

1. Login to MapViewer.
   
   http://<Server>:<port>/mapviewer

2. To update the MapViewer configuration, navigate to MapViewer > Administration > Configuration. Login to the Mapviewer at this location:

   http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the below code in the mapViewerConfig.xml with the appropriate values:

   `<map_data_source name="mapconn"
   jdbc_host="<DB server name>"
   jdbc_sid="/<DB Service name>"
   jdbc_port="1521"
   jdbc_user="DWADM"
   jdbc_password="!<DWADM user password>"
   jdbc_mode="thin"
   number_of_mappers="32"
   allow_jdbc_theme_based_foi="true"
   />

4. Click **Save**, and then restart.

**Enabling WriteBack**

To enable the Write Back, perform the following steps:

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack > Write Back to Database.

2. Click **Denied:Authenticated User** and select the **Granted** permission.
Enabling Auto Complete Feature in OBIEE

To enable the auto complete feature in OBIEE:

1. Restart the OBIEE Admin server, Managed server, and opmn services.
   
   **Note:** Refer to OBIEE documentation for detailed instructions on how to start and stop admin server, managed server, and opmn services.

2. Login to Oracle Utilities Analytics.

   http://<Server>:<port>/analytics

3. Click **WebLogic User** (top-most-right section of the page).

4. From the drop-down menu, select **My Account**.

5. On the **Preferences** tab, set **Prompt Auto Complete** to **ON**.

4. Click **OK**.
This chapter contains information on how to setup spatial data for the Oracle Business Intelligence Enterprise Edition dashboards in Oracle Utilities Analytics and how to set up the spatial data. The mapping between the spatial columns and the dimensional columns, such as City, State from the Address dimension is defined in the spatial metadata catalog, which is available as a part of the Web Catalog component in Oracle Utilities Analytics. Using the spatial data and the map metadata, users can view the star schema data in on the map reports delivered out-of-the-box as part of Oracle Utilities Analytics.

This chapter has the following sections:

- Acquiring the Spatial Data
- Installing Spatial Data
- Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables
- Loading the Oracle Utilities Specific Themes

**Acquiring the Spatial Data**

Oracle Utilities Analytics does not include any spatial data. The spatial data can be loaded from the various third party vendors. Some of the spatial data vendors who partner with Oracle can be found in the below Oracle Technology Network page:


Some of these vendors might require you to purchase a separate license for the spatial data. You need to get in touch with the vendor directly for the same. After this, you would be able to download a spatial data dump from the spatial data vendor.

**Installing Spatial Data**

The spatial data acquired from a third party vendor can be in various formats. Typical vendors provide shape files (.shp) or a database dump for download. The exact spatial data model varies from vendor to vendor and there is no generic format to this. Hence, the documentation that comes along with the spatial data is of utmost importance. This is required to identify what type of spatial data is available in which table.

The first task is to import the data in the shape file into the DWADM schema. A database dump can be imported by the standard oracle impdp command. A shape file can also contain the spatial data tables along with the data that can be imported by Oracle MapBuilder.
Follow the steps mentioned below for this:

1. Unzip or decompress the .zip file (Typically, the shape file is zipped for data compression) to a temp directory.
   
   For example: C:\Spatial

2. Download the standalone MapBuilder application from this site:

3. Start the MapBuilder. On windows, run this to start: java -jar mapbuilder.jar
   
   Note: Refer to the MapViewer documentation for detailed instructions on installing and running MapBuilder from this site: http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html

4. Create a connection to the DWADM schema in the Oracle Utilities Analytics Data Warehouse database by navigating to File > New Connection.

5. Navigate to Tools > Import Shapefile, and click Next.

6. Click the Shapefile.

7. Browse to the C:\Spatial directory, select the .shp file, and click Open.

8. Click Next.

9. Ensure the Create Predefined Theme box is unchecked, and click Next.

10. Review the summary information and click Finish. A sample screenshot is shown below.

   ![Import Shapefile - Completed](image)

---

**Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables**

Once the spatial data tables from a third party vendor have been imported into the DWADM schema, the next step is to import the spatial data needed by Oracle Utilities Analytics into certain specific tables. This step to import a certain subset of the data into a standardized set of Oracle Utilities Analytics tables is for decoupling. This decoupling helps the Oracle Business Intelligence Enterprise Edition map reports and other Oracle Business Intelligence Enterprise Edition map...
configuration to remain oblivious to the variations in the spatial data schema coming from various vendors. This way you need not touch any of the spatial metadata catalog or modify any of the map reports being delivered out-of-the-box.

Oracle Utilities Analytics needs the administrative boundary type of spatial data at four levels - State, City, County and Postal Code. All map reports in Oracle Utilities Analytics are using one of these levels. Since the spatial data model varies from vendor to vendor, further details provided in this section is based on a sample spatial data from a specific vendor.

The following sections describe how the import the data based on a sample spatial data dump provided by HERE maps (formerly NAVTEQ). This sample data set contains administrative boundary data for the OHIO city in the US country. The sample data set from the Oracle partner can be downloaded from the Oracle Utilities Analytic's OTN (Oracle Technology Network) page: http://www.oracle.com/technetwork/database/options/spatialandgraph/downloads/spatial-partners-data-087203.html

However, the steps can be used with a little variation to setup the spatial data for Oracle Utilities Analytics for any city from any country. The extent of the changes need to be done varies based on the vendor used to purchase the spatial data. Read through the documentation of the spatial data model provided by the vendor to understand what type of data lies in what table.

Below table provides a simple mapping based on the HERE maps sample data.

<table>
<thead>
<tr>
<th>Spatial Data Level</th>
<th>Table in Navteq Sample Data</th>
<th>Additional Filters</th>
<th>Oracle Utilities Analytics Spatial Data Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>WOM_AREA</td>
<td>Feature Type = 90996 ISO Country Code = 'USA'</td>
<td>Q1_STATES54004</td>
</tr>
<tr>
<td>City</td>
<td>PL39_d00</td>
<td>Q1_CITY54004</td>
<td>Isad_trans = 'city', 'village'</td>
</tr>
<tr>
<td>County</td>
<td>CO39_D00</td>
<td>Q1_COUNTY54004</td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td>ZT39_D00</td>
<td>Q1_USZIP54004</td>
<td></td>
</tr>
</tbody>
</table>

Apart from these four levels, there are also some standard themes and styles that need to be imported.

Below sub-sections contain the SQL statements to create and populate the various spatial data tables for Oracle Utilities Analytics. The prerequisite is that spatial data has been purchased by you and the spatial data dump has been imported into the DWADM schema. It is assumed that the eLocation website is being used as the base map in the Oracle Business Intelligence Enterprise Edition mapviewer setup, for which the SRID (Spatial Reference System Identifier) is 54004. The SRID is a unique value used to identify the coordinate system used in a Geographic Information System (GIS) application. If some other base map is used, then the transform parameter in the insert statements should specify the SRID of the base map being used.

**Importing Theme Related Spatial Data into Oracle Utilities Analytics**

The sdo_ tables are standard tables expected to be present in the spatial data from any vendor.

```
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;
```
Importing State Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_STATES54004 is used to store the state related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

```
CREATE TABLE Q1_STATES54004
(
    feature_id     NUMBER,
    feature_name   VARCHAR2(255),
    area_id        NUMBER,
    name_langcode  VARCHAR2(35),
    feature_type   VARCHAR2(30),
    country_code_3 VARCHAR2(5),
    geometry SDO_GEOMETRY,
    carto_id NUMBER(10,0)
);
```

```
INSERT INTO Q1_STATES54004_SDX
SELECT NULL, name, NULL, lang_code, feature_type,
ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), carto_id
FROM WOM_AREA WHERE feature_type = 909996 AND iso_country_code = 'ISO';
```

**Note:** Customize the table name WOM_AREA, the feature type value and the ISO country code as per the spatial data model obtained by you. The below insert statement is to define the Q1_ table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.

```
INSERT INTO user_sdo_geom_metadata VALUES
('Q1_STATES54004', 'GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',-
50000000,19000000,0.0005)), 54004);
```

```
CREATE INDEX Q1_STATES54004_SDX ON Q1_STATES54004 (geometry)
indextype IS MDSYS.SPATIAL_INDEX;
```

Importing City Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_CITY54004 is used to store the city related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

```
CREATE TABLE Q1_CITY54004 AS
SELECT upper(name) FEATURE_NAME, sdo_cs.transform(geometry, 54004) geometry, 'OHIO' state
FROM pl39_d00 WHERE lsad_trans IN ('city', 'village');
```

**Note:** Customize the table name pl39_d00 and additional filters as per the spatial data model obtained by you. Map the state name dynamically for the current city record in the spatial data. The below insert statement is to define the Q1_ table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.
Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables

INSERT INTO user_sdo_geom_metadata VALUES ('Q1_CITY54004', 'GEOMETRY', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005), MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004);

CREATE INDEX Q1_CITY54004_sdx ON Q1_CITY54004 (geometry) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_CITY54004 SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing County Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_COUNTY54004 is used to store the county related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_COUNTY54004 AS
SELECT name FEATURE_NAME, sdo_cs.transform(geometry, 54004) geometry, 'OHIO' state FROM CO39_D00;

Note: Customize the table name CO39_D00 as per the available spatial data model. The below insert statement is to define the Q1_ table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES ('Q1_COUNTY54004', 'GEOMETRY', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005), MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004);

CREATE INDEX Q1_COUNTY54004_sdx ON q1_county54004 (geometry) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_COUNTY54004 SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing Postal Code Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_USZIP54004 is used to store the county related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_USZIP54004 AS
SELECT zcta ZCTA5CE, sdo_cs.transform(geometry, 54004) geom. FROM ZT39_D00;

Note: Customize the table name ZT39_D00 as per the available spatial data model. The below insert statement is to define the Q1_ table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES ('Q1_USZIP54004', 'GEOMETRY', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005), MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004);

CREATE INDEX Q1_USZIP54004_sdx ON q1_uszip54004 (geometry) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_USZIP54004 SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);
INSERT INTO user_sdo_geom_metadata VALUES ('Q1_USZIP54004', 'GEOM', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004 );

CREATE INDEX Q1_USZIP54004_SDX ON Q1_USZIP54004 (geom) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_USZIP54004 SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);

Improving Performance by Prefetching the Map Tiles

Rendering map tiles dynamically can affect system performance. To avoid this, you may consider prefetching tiles by issuing an admin request to MapViewer on a non-production server or when the server is not under load. When MapViewer receives a prefetching request, it issues many concurrent map tile requests to itself, which are basically XML map requests, and stores them in the cache. This improves the system’s performance as the images are readily available.

Follow the following procedure to prefetch map tiles. These instructions are for MapViewer 11.1.1.9.1 version. If you are using a different version, refer to the MapViewer documentation for instructions.

1. In the MapViewer console, click Admin in the top-right corner of the page and log into the Admin Console page.
2. In the Admin Console page, click Management > Manage Map Tile Layers.
3. Select the required online map tile and click View map/Manage Tiles.

   The Prefetching wizard opens:

   ![Prefetching wizard](image)

4. Enter the X, Y coordinates of the center of the map, the SRID and zoom level, and click Show Map.

   To prefetch map images, enter the latitude and longitude values. You need to know the latitude and longitude values of the center of the location in interest. The SRID is a unique value used to identify the coordinate system used in a GIS application.
The X and Y axis used in the following example is for Ohio:

<table>
<thead>
<tr>
<th>Center X</th>
<th>Center Y</th>
<th>SRD</th>
<th>Zoom Level</th>
<th>Show Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>-9216578.5</td>
<td>4887077.75</td>
<td>54034</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

5. When you see the map, turn on the **Area Selection** tool and select the area on the map for which you want to prefetch the tiles.

6. Select one or more zoom-levels for which you want to prefetch the tiles.

---

## Loading the Oracle Utilities Specific Themes

This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities Analytics.

Use the following procedure to load spatial metadata in the target database:

1. Create the `dump_dir` directory in the database and copy the `user_sdo.dmp` file from `../BI270/Spatial-Metadata` folder to that location.

2. Import the released spatial tables to the target database using the following command:

   ```
   impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=impdp_user_sdo.log schemas=DWADM remap_tablespace=cists_01:<tablespace_name>
   ```

   **Note:** Run this command from database server.

   **Note:** Make sure to change the `tablespace_name` to the name on which DWADM has the quota. If DWADM user have quota on `cists_01` tablespace, then exclude the `remap_tablespace` clause from command.

3. Review the `impdp_user_sdo.log` file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the `../BI270/Spatial-Metadata` folder:

   ```
   sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql
   sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql
   ```

5. Review the log files.

---

## Additional Setup for Oracle Utilities Outage Analytics

The Outage Analytics product within Oracle Utilities Analytics needs some additional spatial data setup. The reason is that Outage Analytics alone uses point information from spatial data for plotting outage event related information on maps. This section should be skipped if NMS is not one of the source systems for Oracle Utilities Analytics.

The very first step is to replicate the `DIAGRAM_OBJECTS` table into the Oracle Utilities Analytics database. However, a suitable mechanism needs to be built to refresh this table with the latest data from Oracle Utilities Network Management System whenever there are changes in the source system.

Once this is done, then after replicating the `DIAGRAM_OBJECTS` table, the following steps set the Oracle Utilities Analytics dashboards up to use the data in this replicated table.

1. Create the required spatial metadata:

   ```
   INSERT INTO user_sdo_geom_metadata
   VALUES ('DIAGRAM_OBJECTS','LL_GEOMETRY',
   MDSYS.SDO_DIM_ARRAY (SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05),
   ```

   ```
   SELECT CENTER_X, CENTER_Y, SRD, ZOOM_LEVEL FROM DIAGRAM_OBJECTS
   ```
2. Ensure that the spatial index is created on the LL_GEOMETRY column. The LL_GEOMETRY column by default stores spatial data using SRID 54004, so this works without changes with the eLocation base map:

```
create index Q1_DIAGRAM_OBJECTS_SDX
on diagram_objects (ll_geometry)
indextype is mdsys.spatial_index;
```

Once DIAGRAM_OBJECTS table is replicated to the Oracle Utilities Analytics database, follow the below steps to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to the DWADM schema of Oracle Utilities Analytics database and execute the following:

```
CREATE TABLE Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;
```

2. INSERT INTO user_sdo_geom_metadata:

```
VALUES ('Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY',
MDSYS.SDO_DIM_ARRAY (
    SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05),
    SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)
), 54004);
```

3. CREATE INDEX Q1_DIAGRAM_OBJECTS_SDX_54004 on Q1_DIAGRAM_OBJECTS_54004 (ll_geometry) indextype is mdsys.spatial_index;

4. Under Tile Operations, click on Prefetch Tiles. Here is a snapshot of the area selection and the tile operation.

This process takes some time, depending upon the hardware configuration of the system and the amount of data to be prefetched. To check the current status of the operation, click Refresh under the Operation Status. The status will change to “Finished” when the operation is done.
Chapter 10

Installing NMS BI Publisher Reports

This section describes the steps to be performed while installing the Oracle Utilities Analytics NMS IEEE outage reports:

1. Unzip the IEEE outage reports contained in **OUA NMS BI Publisher reports.zip** from the installation media to a temporary directory (ex. TEMPDIR) on the server where Oracle BI Publisher is installed.

2. Log into Oracle BI Publisher (http://<BI Publisher server name>:9704/xmlpserver/) as the Administrator from a browser that has access to the TEMPDIR folder from the step 1.

3. Set up a database connection as follows:
   a. Navigate to **Oracle BI Publisher Administration > Data Sources > JDBC Connection**.
   b. Click **Add Data Source**.
   c. In the **Data Source Name** field, enter **NMS BI Publisher** or a name of your choice.
   d. Set the **Driver Type** to Oracle 12c.
   e. Set the **Database Driver Class** to oracle.jdbc.OracleDriver.
   f. Set the **Connection string** to:jdbc:oracle:thin:@<yourmachine>:<Port>:<ORACLE_SID>

   **Note**: The database connection referring to OUA have to be setup here.

   g. Set the **username** and **password** to match your Oracle Utilities Analytics database login values.

   **Note**: The username should be “MDADM” and the password corresponding to this user.

   h. Click **Test Connection** and verify that it is properly configured.

   i. Click **Apply**.

4. From the **BI Publisher Catalog** page, select **Shared Folders** from the folders tree.

5. On top of the folders section, click the **New** drop-down list and select **Folder** from the list.

6. Enter **NMS IEEE** Reports as the folder name (or a name of your choice), then click **Create**. The new folder is added. You may have to click **Refresh** button to update the Folders list.

7. Select the **NMS IEEE** Reports folder in the folder list.
   Under the **NMS IEEE Reports** folder, create another new folder named **NMS IEEE Data Models**.
8. Select the **NMS IEEE Data Models** directory, and then click **Upload** in the **Tasks** section on the bottom left.
   a. Browse to the directory where the NMS IEEE BI Publisher reports exist (TEMPDIR from step 1).
   b. Locate all of the data model files and upload them to the **NMS IEEE Data Models** directory. These files contain an extension of .xdmz and include the following files:
      - CELID DataModel.xdmz
      - CEMI Data Model.xdmz
      - DailyTroubleReport.xdmz
      - DeviceOutageHistory.xdmz
      - Feeder Impact on System Metrics.xdmz
      - IEEE Benchmarking Model.xdmz
      - IEEE_TMED_Calculations.xdmz
      - IEEEIndiceCalculations.xdmz
      - RecurringDeviceOutages.xdmz

9. Select the **NMS IEEE Reports** directory, and then click **Upload** in the **Tasks** section on the bottom left.
   a. Browse to the directory where the OUA NMS IEEE BI Publisher reports exist (TEMPDIR from step 1).
   b. Locate all of the report files and upload them to the **NMS IEEE Reports** directory. These files contain an extension of .xdoz and include the following files:
      - CELID DataModel.xdoz
      - CEMI Data Model.xdoz
      - DailyTroubleReport.xdoz
      - DeviceOutageHistory.xdoz
      - Feeder Impact on System Metrics.xdoz
      - IEEE Benchmarking Model.xdoz
      - IEEE_TMED_Calculations.xdoz
      - IEEEIndiceCalculations.xdoz
      - RecurringDeviceOutages.xdoz

10. Assign the appropriate JDBC connection to the imported data models.
    a. Click **Catalog**.
    b. Select the **NMS IEEE Data Models** directory, and then select the CriticalCustomerOutages.xdmz data model.
    c. Click **Data Model** on the top left.
    d. In the **Properties** frame on the right, make sure that **Default Data Source** points to the data source you created earlier. This defaults to **NMS BI Publisher**.
    e. You must perform this step for all of the data models under the NMS IEEE Data Models directory.

11. Assign the appropriate data model to all the NMS IEEE Reports.
    a. Click **Catalog**.
b. Select the NMS IEEE Reports directory. Click Edit for the CriticalCustomerOutages report.

c. At the top-left of the page, click Search.

d. Browse and select the appropriate data model file (will match the name of the report with an extension of .xdmx).

e. Save the current report by clicking Save on the top-right of the page.

You should now be able view the standard IEEE indices reports from BI Publisher by simply selecting the desired report from the NMS IEEE Reports directory under the Catalog.